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Safety precautions

Follow at all times the precautions and warnings below to use the printer safely. Do not carry out any
operations or procedures other than as described in this document, because doing so may result in death,
serious personal injuries, or fire.

Mains connection

e  Use the power supply voltage specified on the label. Avoid overloading the printer’s electrical outlet
with multiple devices. Doing so can cause a fire or an electric shock hazard.

e  Ensure that the printer is well grounded. Failure to ground the printer may result in electrical shock, fire,
and susceptibility to electromagnetic interference.

e  Use only the power cord supplied by HP with the printer. Do not damage, cut, or repair the power cord. A
damaged power cord can cause fire and electric shock. Replace a damaged power cord with an HP-
approved power cord.

e Insert the power cord securely and completely into the wall socket and printer inlet. A poor connection
can cause a fire or an electric shock hazard.

e Never handle the power cord with wet hands. Doing so may cause electric shock hazard.

e  Observe all warnings and instructions marked on the printer.

Printer operation

e Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the
printer. Doing so may cause fire, electric shock, or other serious hazards.

e  Neverinsert your hand into the printer while it is printing. Moving parts inside the printer may cause
injuries.

e  Keep the ventilation system in the room turned on when printing.

e  Unplug the printer from the wall before cleaning.

Printer servicing

e  There are no operator-serviceable parts inside the printer. Refer servicing to qualified service
personnel. Contact your local HP Support (see Contact HP Support on page 242).

e Do not disassemble or repair the printer yourself. There are hazardous voltages inside the printer that
can cause a fire or electric shock hazard.

e Internal fan blades are hazardous moving parts. Disconnect the printer before servicing.

Caution
Turn off the printer and unplug the power cord from the power outlet in any of the following cases:

e If thereis smoke or an unusual smell coming from the printer

If the printer is making an unusual noise not heard during normal operation

If a piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of
the printer

e  During a thunderstorm

e  During a power failure

The power cord or plug is damaged
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e  The printer has been dropped

e  The printer is not operating normally

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and
documentation.

Using this guide

This guide can be downloaded from the HP Support Center (see HP Support Center on page 240).

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance

These chapters help you carry out normal printer procedures and include the following topics.

Installing the software on page 15

° Setting up the printer on page 21

° Network configuration on page 35

° Personalizing the printer on page 44

° Paper handling on page 50

° Working with two rolls on page 66

° Printing on page 68

° Web-connected printing on page 90

° Job queue management on page 103

° Color management on page 110

° Practical printing examples on page 121

° Retrieving printer usage information on page 136

° Handling ink cartridges and printhead on page 140

° Printer maintenance on page 151

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.

e  Troubleshooting paper issues on page 172

° Troubleshooting print-quality issues on page 182

e  Troubleshooting ink cartridge and printhead issues on page 226

° Troubleshooting general printer issues on page 230

° Front-panel error messages on page 236
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Accessories, support and specifications

These chapters, Supplies and accessories on page 166, HP Customer Care on page 239 and Printer
specifications on page 243, contain reference information, including customer care, the printer
specifications and part numbers for paper types, ink supplies and accessories.

Glossary

The Glossary on page 247 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the
printer from being damaged. Follow the instructions marked with these symbols.

A WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury
or death.

A CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the printer.

Printer models

This guide covers the following printer models, normally referring to them by their short names for brevity.

Full name Short name
HP Designjet T2500 eMultifunction T2500
HP Designjet T2500 PostScript eMultifunction T2500 PS
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The printer’s main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 914 mm (36 in)
wide, with an integrated color scanner capable of scanning images up to 914 mm (36 in) wide and 7 m (23 ft)
long. Some major features of the printer are shown below:

ENWW

Built-in stacker for paper sizes from A4/A portrait to AO/E, with up to 50 A1/D-size capacity

Roll and single-sheet loading from the front of the printer

Two rolls with automatic switching, enabling long runs of unattended printing

Six-ink system

Integrated printhead, 9/8 in (28 mm) wide, with duplicated black nozzles improving speed and quality
Capacitive touch-sensitive front panel in color, with an intuitive graphical user interface

Print resolution of up to 2400 x 1200 optimized dpi, from a 1200 x 1200 dpi input

Scan resolution of up to 600 dpi, in RGB color with 24 bits per pixel, or grayscale with 8 bits per pixel, or
black and white with 1 bit per pixel

Economode for printing economically

Can be controlled from the built-in front panel, or from a remote computer using the Embedded Web
Server or the HP Utility

Includes Web-connected features such as automatic firmware updates, HP Designjet ePrint & Share,
and HP ePrint

Driverless printing using AirPrint

Paper flexibility and automatic easy load, see Paper handling on page 50, with information and
presets accessible from the front panel

Accurate and consistent color reproduction with automatic color calibration

Color emulations, see Printer emulation on page 113

Manual printing with the stacker open, for improved handling of special jobs on photographic paper
High-productivity features such as job previewing and nesting using the printer's Embedded Web Server

Ink and paper usage information available from the Embedded Web Server, see Access the Embedded
Web Server on page 45

Access to online support

The printer’s main features
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The printer’s main components

The following front and rear views of the printer illustrate the main components.

Front view

1. Scanner
2. Printhead
3. Stacker

4. Front panel

5. Inkcartridges
6. Basket

7. Lowerroll cover

8. Upperroll cover
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Rear view

1. Power switch

2. Power socket

Communication ports
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1.  Gigabit Ethernet port, to connect to a network
2. Diagnostic LEDs, to be used by service engineers

3. Hi-Speed USB host port, intended for connecting a USB flash drive

The front panel

The front panel is located on the front right of the printer. It gives you complete control of your printer: from
the front panel, you can print, view information about the printer, change printer settings, perform
calibrations and tests, and so on. The front panel also displays alerts (warning and error messages) when
necessary. Information about specific uses of the front panel can be found throughout this guide.

1.  AHi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be
printed or a destination for scanned files. When a USB flash drive is inserted, a USB icon |l is
displayed on the front panel's home screen.

2. The front panel itself: a touch-sensitive screen with a graphical user interface.
3. Loudspeakers.

4. The Power key, with which you can turn the printer on or off. The key is illuminated when the printer is
on. It flashes when the printer is in sleep mode.
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The front panel has a large central area to display dynamic information and icons. On the left and right sides
you can see up to six fixed icons at different times. Normally they are not all displayed at the same time.

Left and right fixed icons

Press @to return to the home screen.

Press P4 to view help about the current screen.
Press []to go to the previous item.
Press [Jto go to the next item.

Press to go back to the previous screen. This does not discard any changes made in the current
screen.

Press Jjg to cancel the current process.

Home screen dynamic icons

The following items are displayed only on the home screen.

ENWwW

Press . to reach the information screen, where you can view information about printer and scan
status, change printer settings, or initiate actions such as loading paper or replacing ink supplies.

Press E to release the paper from the scanner. If there is no paper in the scanner, this button is not
displayed.

To the right of the above button is a message showing the printer status or the most important current
alert.

Press to print a file. See Printing on page 68.

The front panel
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Press to scan a sheet of paper and store the image in a file, either in a network folder or in a USB

flash drive. See Scanning on page 84.

Press E to copy a sheet of paper (scan and print). See Copying on page 88.

Press to view and manage the print and scan job queues. A smaller warning icon appears if there

are jobs on hold. See Job queue management on page 103.

e Press [ to view information about the USB flash drive. This icon appears only when a USB flash
drive is inserted.

Press E to access available applications. See http://www.hp.com/go/designjeteprinters. This icon

appears only when one or more applications are installed.

Information screen

To reach the information screen, press . on the home screen.

Paper information

EELY REELY Ready Not loaded

_ S =

v v
Stacker Roll 1 Roll 2 Sheet

{mmm}
| o

Information screen dynamic icons

®  Press - for information about the paper status.

®  Press - for information about the ink cartridge status.
®  Press - for information about the printhead status.

®  Press - for information about the network status.

®  Press - for a list of alerts.

®  Press - for information about the printer.

®  Press - to view and change printer or scan settings.

Sleep mode

10

Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off the front-panel
display to save energy. Printer features can be enabled from this mode, and the printer maintains network
connectivity, waking up only as necessary. The printer can be woken from sleep mode by the Power button,
by sending a print job, or by lifting the scanner, opening a roll cover, or opening the stacker cover. The printer
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wakes up in several seconds, more quickly than if it is completely turned off. While in sleep mode, the Power

button blinks.

To change the time that elapses before sleep mode, press [[&Fg¥, then n then Setup > Front panel
options > Sleep mode wait time. You can set a time between 1 and 240 minutes; the default time is 30

minutes.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with the HP Utility and Web
JetAdmin continue to be available during sleep mode. Some remote management tasks offer the option of
remotely waking up the printer if needed to perform the task.

Printer software

The following software is provided with your printer:

The HP-GL/2 driver for Windows

The HP PCL3GUI raster driver for Mac 0S X (non-PostScript printers)

PostScript drivers for Windows and Mac 0S X (PostScript printers)

HP Designjet HP-GL/2 Driver Preview with HP Designjet ePrint & Share

The Embedded Web Server and (alternatively) the HP Utility allow you to:

o

o

Manage the printer from a remote computer (the Embedded Web Server is recommended for this
purpose)

View the status of the ink cartridges, the printhead, and the paper

Update the printer's firmware, see Update the firmware on page 153

Perform calibrations and troubleshooting
Submit print jobs

Manage the job queue, see Job queue management on page 103

View job accounting information, see Retrieving printer usage information on page 136

Change various printer settings

Manage e-mail notifications

Change permissions and security settings
Set network destinations for scan

Scan accounting

See Access the Embedded Web Server on page 45 and Access the HP Utility on page 45.

E”%NOTE: The HP Utility under Mac 0S X and the HP Designjet Utility under Windows have similar functions and

are sometimes referred to collectively as the HP Utility in this guide.

E’%NOTE: New versions of all printer software can be expected to appear from time to time. In some cases,
when you receive your printer there may already be later versions available on HP's website of some of the
software provided with it.

Web Services

Your printer can be connected to the Internet, providing various benefits:
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e  Automatic firmware updates (see Update the firmware on page 153)

e  Print to your HP Designjet ePrinter from anywhere you have an Internet connection
e  Useyour tablet, smartphone, laptop, or printer touchscreen to print where and when you need
To take advantage of these benefits, your printer must be connected to the Internet.

For the latest information, see http://www.hp.com/go/designjeteprinters.

= NOTE: Requires an HP Designjet ePrint & Share account, Internet connection to the printer, and connected
Internet-capable device. When using the HP Designjet ePrint & Share mobile app, a compatible Apple®i0S or
Android™ device and Internet connection are required. Data or connection charges may apply. Print times
may vary.

HP Designjet ePrint & Share

With HP Designjet ePrint & Share you can print from a conference room, job site, or even home. This free Web
service makes it easy to access and print large-format documents using your tablet, smartphone, laptop, or
printer's touchscreen.

For further information, go to http://www.hp.com/go/eprintandshare.

Print from virtually anywhere

Use your tablet, smartphone, laptop, or HP Designjet ePrinter's touchscreen to print where and when you
need.

e  Plot to print seamlessly from AutoCAD® 360.

e  Send files to print by email to your HP Designjet ePrinter.

Save your files online in the cloud

Every time you print or scan using HP Designjet ePrint & Share, a copy of your file is saved in your HP
Designjet ePrint & Share account, so finding files for reprints becomes a breeze.

e  Access files saved to the cloud using your online print history.
e  Keep your projects safeguarded with trusted HP security features.

e  Scanto the cloud by using the scan to HP Designjet ePrint & Share application.

Collaborate with ease

Whether your files are stored in your HP Designjet ePrint & Share account or an FTP site, HP Designjet ePrint
& Share makes it easy to view, share, and print files.

e  Share files using an automatically generated hyperlink.

e  Access all your FTP sites in one place.

Turn the printer on and off

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to use
the Power key on the front panel.

However, if you plan to store the printer for a long period or the Power key does not seem to work, you are
recommended to turn it off using the power switch at the rear.
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To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about 3 minutes to initialize and check and prepare the

printhead. Preparing the printhead takes about 75 seconds. However, if the printer has been off for 2 weeks

or more, preparing the printhead could take up to 7 minutes, plus 13 minutes if it needs a printhead recovery.

See also Sleep mode on page 10 and Change the auto-off setting on page 46.

The printer’s internal prints

The internal prints give various kinds of information about your printer. They can be requested from the front

ENWwW

panel.

Before requesting any internal print, check that the printer and the paper are ready for printing.

e Theloaded paper should be at least A3 landscape—420 mm (16.53in) wide—otherwise the print may

be clipped.

e  The front panel should be displaying the Ready message.

To print any internal print, press . then - then scroll down to Internal prints and press it, then
select the internal print you want. The following internal prints are available.

e  Demo prints show some of the capabilities of the printer
° Print drawing demo
° Print rendering demo
° Print GIS map

° User information prints

° Usage report shows estimates of the total number of prints, number of prints by paper type,

number of prints by print-quality option, counting of scans, and total amount of ink used per color

(the accuracy of these estimates is not guaranteed)
° HP-GL/2 palette shows the color or grayscale definitions in the currently selected color palette
° PostScript font list shows PostScript fonts available (PostScript printers only)
e  Service information prints
° Print current information
° Print usage information
° Print event logs

° Print calibration status

The printer’s internal prints

13



° Print connectivity configuration

° Print all pages (prints all the above reports)
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Installing the software

° Connect the printer to your network

e  Connect a computer to the printer by network (Windows)

e  Uninstall the printer software (Windows)

° Connect a computer to the printer by network (Mac 0S X)

e  Uninstall the printer software (Mac 0S X)
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Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in
the same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front

panel: press , then .

Network configuration

For more details about the current network configuration, go to the front panel and press , then n

then Connectivity > Network connectivity > Gigabit Ethernet > Modify configuration. From here it is
possible, though not normally necessary, to change the settings manually; this can also be done remotely
using the Embedded Web Server.

_‘{}: TIP:  You may find it helpful to print out the full printer network configuration on paper. This can be done
° from the front panel: press kel then n then Internal prints > Service information prints > Print

connectivity configuration. If you do not print out the full network configuration, consider making a note of
the printer's IP address and network name.

If you accidentally misconfigure the printer’s network settings, you can restore the network settings to their
factory values from the front panel: press , then n then Connectivity > Network connectivity >

Advanced > Restore factory settings. Then you must restart the printer. This automatically provides a
working network configuration for most networks. The printer’s other settings remain unchanged.

Using IPv6

Your printer supports almost all network connectivity features using IPv6, just as it does using IPv4. To make
full use of IPv6, you may need to connect your printer to an IPv6 network in which there are IPv6 routers and
servers.

In most IPv6 networks, the printer will configure itself automatically as follows, and no user configuration is
necessary:

1.  The printer assigns itself a link-local IPv6 address (which starts with “fe80::").
2. The printer assigns itself stateless IPv6 addresses as indicated to it by any IPv6 routers on the network.

3. If nostateless IPv6 addresses can be assigned, the printer will try to obtain IPv6 addresses using
DHCPvé. It will also do so if the routers instruct it to do so.

The stateless and DHCPv6 IPv6 addresses can be used to access the printer, and in most IPv6 networks this
will be appropriate.

The link-local IPv6 address works only in the local subnet. Although it is possible to access the printer using
this address, it is not recommended.

Itis possible to assign a manual IPv6 address to the printer, using the front panel or the Embedded Web
Server. It is also possible to disable IPv6 completely in the printer. However, it is not possible to disable IPv4
in the printer, and therefore it is not possible to configure the printer as IPv6-only.

?‘ NOTE: Intypical IPv6 use, your printer will have multiple IPv6 addresses, although it has only one IPv4
address.

:{7’_ TIP:  You are recommended to give a name to the printer. You can do this from the front panel or (more
* easily) from the Embedded Web Server.

TIP:  You will generally find it easier to use IPv4 unless you have a specific need to use IPv6.
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Microsoft Windows Vista, Microsoft Windows Server 2008, later versions of Windows, and the new HP
Printing and Imaging devices have IPv6 enabled by default. For further information on IPv6, see
http://h20000.www?2.hp.com/bc/docs/support/SupportManual/c00840100/c00840100.pdf. This document
discusses how name resolution plays a fundamental role in Dual-Stack transition methods. Using the name
resolution algorithm in Windows, the document goes through various network environments and studies
how the introduction of routable IPv6 addresses will affect network applications. It also discusses DHCPv6,
SLAAC and the impact to DNS, and makes some recommendations.

Using IPSec
Your printer supports IPSec.

However, successful IPSec configuration requires advanced network expertise, and is beyond the scope of
this document. For IPSec to work, the printer’s IPSec configuration must exactly match that of the other
devices in your network. Any discrepancy will prevent communication with your printer until the
configuration is corrected or IPSec is disabled. For more information on IPsec configuration, download the file
IPsec_Admin_Guide.pdf from http://www.hp.com/go/T2500/manuals.

Connect a computer to the printer by network (Windows)

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 68 for alternative ways of printing.

Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your
network on page 16).

Now you can proceed to install the printer software and connect to your printer.

Printer software installation

1. Make a note of the printer's IP address from the front panel (see Access the Embedded Web Server
on page 45).

2. Insert the HP Start-up Kit DVD into your computer. If the DVD does not start automatically, run the
setup.exe program in the root folder of the DVD.

3. Navigate to the Software Installation button and press it.

4. Press the Install Software button, and choose your printer from the list of networked printers that
appears, identifying it by its IP address if necessary.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed,
which helps you to try to find your printer. If you have a firewall in operation; you may have to disable it
temporarily in order to find the printer. You also have the options of searching for the printer by its
hostname, IP address, or MAC address.

In some cases, when the printer is not in the same sub-net as the computer, specifying the printer's IP
address may be the only successful option.

5. Follow the instructions on your screen to install the printer drivers and other HP software, such as the
HP Designjet Utility and the HP Designjet Driver Preview with HP Designjet ePrint & Share.

HP Designjet ePrint & Share allows you to create a copy of your document any time you print, securely
in the cloud, in your private online print history. This means that you can reprint your documents from
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virtually anywhere. To use HP Designjet ePrint & Share, you must create a free password-protected
account to protect your documents.

If you have enabled Web Services on your printer, you can print to your printer by email. You can find

the email address in the printer's front panel: press . then - Then send the file you want to

print to that email address as an attachment. You can also use your HP Designjet ePrint & Share account
to print remotely to your printer.

Uninstall the printer software (Windows)

1.

Insert the HP Start-up Kit DVD into your DVD drive. If the DVD does not start automatically, run the
setup.exe program in the root folder of the DVD.

Navigate to the Software Installation button and press it.

Press the Install Software button, and follow the instructions on your screen to uninstall the printer
software.

Connect a computer to the printer by network (Mac 0S X)

You can connect your printer to a network under Mac 0S X by using the following methods:

Bonjour

TCP/IP

:{?'_ TIP: Bonjour is are recommended for your local network; TCP/IP is recommended for other networks.

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 68 for alternative ways of printing.

Before you begin, check your equipment:

The printer should be set up and on.
The Ethernet switch or router should be on and functioning correctly.

The printer and the computer should be connected to the (wired or wireless) network. See Connect the
printer to your network on page 16.

Now you can proceed to install the printer software and connect to your printer.

Bonjour connection

1. Goto the front panel and press . then - Note the mDNS service name of your printer.

2. For best performance while using the HP driver, you are recommended to change the Bonjour Highest
Priority Service from IPP Printing to 9100 Printing. You can change this setting from the Embedded
Web Server (see Access the Embedded Web Server on page 45): select Networking > Other settings >
Bonjour settings, change setting as indicated, then click Apply.

3. Insert the HP Start-up Kit DVD into your DVD drive.

4. OpentheDVD icon on your desktop.

5. Openthe Mac 0S X HP Designjet Installer.

6. Follow the instructions on your screen.
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10.

11.

The printer software is installed, including the printer drivers and other HP software, such as the HP
Utility. An active Internet connection is recommended in order to perform a full installation with the
latest software.

If you have enabled Web Services on your printer, you can print to your printer by email. You can find
the email address in the printer's front panel: press , then . Then send the file you want to
print to that email address as an attachment.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a
connection to your printer. Follow the instructions on your screen.

When you reach the Select Printer screen, look for your printer's mDNS service name (which you noted
in step 1) in the Printer Name column.

e If you find the right name, scroll sideways if necessary to see the Connection Type column, and
check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down
the list.

e If you cannot find your printer's name with a Bonjour connection type, check the box My printer is
not in the list.

Click Continue.

Continue following the instructions on the screen. When you reach the Printer Queue Created screen,
click Quit to exit, or Create New Queue if you want to connect another printer to the network.

When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

TCP/IP connection

1. Goto the front panel and make a note of the printer's URL (see Access the Embedded Web Server
on page 45).

2. Insert the HP Start-up Kit DVD into your DVD drive.

3. OpentheDVDicon onyour desktop.

4. Openthe Mac 0S X HP Designjet Installer.

5. Follow the instructions on your screen.

6. The printer software is installed, including the printer drivers and other HP software, such as the HP
Utility. An active Internet connection is recommended in order to perform a full installation with the
latest software.

If you have enabled Web Services on your printer, you can print to your printer by email. You can find
the email address in the printer's front panel: press , then . Then send the file you want to
print to that email address as an attachment.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a
connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1) in the
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Printer Name column.

Connect a computer to the printer by network (Mac 0S X)
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e If you find the right name, scroll sideways if necessary to see the Connection Type column, and
check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further
down the list.

e If you cannot find your printer's name with an IP Printing connection type, check the box My
printer is not in the list.

Click Continue.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen,
click Quit to exit, or Create New Queue if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

Uninstall the printer software (Mac 0S X)
1. Insert the HP Start-up Kit DVD into your DVD drive.
2. Openthe DVD icon on your desktop.

3. Openthe Mac 0S X HP Designjet Uninstaller, and follow the instructions on your screen to uninstall the
printer software..

To delete the print queue, select the Print & Fax dialog from the system preferences. Select the name of the
printer and click the = button.
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Setting up the printer

° Introduction

e  Setup your Web-connected printer

° Web Services manual configuration

° Configure a scan-to-network or scan-to-FTP folder

° Paper suitability options

e  Turn nesting on and off

e  Turnusage information on and off

e  Turn e-mail notifications on and off

e  Turnalerts on and off

° Control access to the printer

° Require account ID

° Set Windows driver preferences
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Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soonas a
new printer is assembled and ready for use.

Set up your Web-connected printer

Your printer can connect to the Internet to benefit from various Web Services (see also Web Services
on page 11):

e  Automatic firmware updates

e  Use HP Designjet ePrint & Share from the front panel

e  Use HP ePrint to print by email

To set up your printer for Web Services, please follow these steps, explained in more detail below:

1.  Make sure that your printer is correctly connected to the Internet.

2. Run the Connectivity Wizard: At the front panel, press . then - then Connectivity >
Connectivity wizard.

|*__*:"’49N0TE: The printer may need to restart if the firmware is updated during this process.

- TIP:  When the Wizard displays your printer code, you are recommended to make a note of it. A page is
* automatically printed with the printer’s email address, instructions on how to use it and how to manage
printer security.

3. Create an HP Designjet ePrint & Share account when prompted, or later, at http://www.hp.com/go/
eprintandshare. HP Designjet ePrint & Share saves copies of all your print jobs in the cloud so that you
can reprint and share them from almost anywhere, even from smartphones and tablets.

4. Activate your account by clicking the activation link that you will receive by email.

_{?_ TIP: If you don't see the message, remember to check your junk email folder.

5. Using a Web browser, enable remote printing from your HP Designjet ePrint & Share account, and give
your printer’s email address so that your printer can be used for remote printing.

6. Thisis an optional step: If you are the printer administrator, log in at the HP ePrint Center
(http://www.hp.com/go/eprintcenter) to customize your printer’s email address or manage printer
security for remote printing.

Congratulations, you now have completed Web Services setup. HP ePrint and HP Designjet ePrint & Share are
ready to use.

For the latest information, support, and terms of use of the HP ePrint Center and HP Designjet ePrint & Share,
see their respective websites, http://www.hp.com/go/eprintcenter and http://www.hp.com/go/
eprintandshare.

Web Services manual configuration

The Connectivity Wizard (see Set up your Web-connected printer on page 22) is normally sufficient for Web
Services configuration, but there are also facilities for manual configuration if you wish to use them.

Configure the printer’s Internet connection

You can configure the printer's Internet connection from the Embedded Web Server or from the front panel.
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E‘%"NOTE: If an administrator password has been set, it will be required to change these settings. Thus, the
administrator can prevent the printer from being connected to the Internet, if desired.

In the Embedded Web Server: select Setup > Internet connection.

Using the front panel: press , then n then Connectivity > Internet connectivity.

The following settings are available:

Internet connection: The default value is Yes.

Proxy > Enable proxy: Enable or disable a proxy server.

Proxy > Proxy address: Enter the proxy address, empty by default.
Proxy > Proxy port: Enter the proxy port number, zero by default.
Proxy > Proxy authentication: Enable or disable authentication.

Proxy > Restore factory settings: Return to the initial default settings.

If you have trouble with your Internet connection, see Cannot connect to the Internet on page 233.

Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download
firmware updates.

E}fNOTE: If an administrator password has been set, it will be required to change these settings.

In the Embedded Web Server: select Setup > Firmware update.

Using the front panel: press , then n then Updates > Firmware update.

The following settings are available:

Check: If you select Automatically (the default setting), the printer will check automatically every week
(or after the printer has been restarted seven times, whichever happens first) whether new firmware is
available. If you select Manually, the printer will not check automatically; you can check manually
whenever you like.

Download: If you select Automatically (the default setting), the printer will automatically download
new firmware whenever it becomes available. If you select Manually, you will be asked to approve each
download.

= NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install
the new firmware, you must confirm the installation manually.

Firmware update information: Information about the firmware currently installed

Firmware update history: A list of firmware versions that have been installed in the printer. It is usually
possible to reinstall the version immediately before the version that is currently installed, if you have
some problem with the current version.

Set remote printing preferences

At the front panel, press , then n then Setup > Printing preferences to define the default
properties of jobs sent to your printer from remote locations.
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Printer margins: Choose between Clip from contents and Add to content.

Color: Choose between Color, Grayscale, and Black and white printing.
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e  Print quality: Choose between Best, Normal, and Fast.

e  Roll: Choose between Roll 1, Roll 2, and Save paper, which automatically chooses the narrowest roll on
which the print will fit.

o  HP ePrint Center jobs: Choose between On hold and Direct print. By default, jobs from the cloud are On
hold. If you choose Direct print, the front panel will not ask for permission before printing.

Configure a scan-to-network or scan-to-FTP folder

A scanned image may be saved in a USB flash drive, in a network folder, or in an FTP folder. The USB flash
drive option requires no preparation, but the other options will not work until they have been set up in the
following way.

@’NOTE: The printer accesses shared folders (as a client) using NTLMv1-based authentication. If, for security
reasons, you prefer not to expose user credentials using NTLMv1, you should avoid using a scan-to-network
or scan-to-FTP folder.

Scan to network folder

1. Create afolder on a computer that the scanner can access through the network. See Example: Create a
scan-to-network folder under Windows on page 26 or Example: Create a scan-to-network folder
under Mac 0S on page 27.

2. Create auser account on the same computer for the printer.

3. Change the sharing options of the folder so that it is shared with the 'scanner user’, and assign full
control of the folder to that user.

4. Create ashare name for the folder.

Scan to FTP folder
1. Create afolder on an FTP server.

2. Ensure that you know the server name, user name, and password for the FTP server.

@IMPORTANT: You must complete the above steps for one option or the other before starting the remaining
steps below.

1. Inthe printer's Embedded Web Server, select the Setup tab and then Scan to network. See Access the
Embedded Web Server on page 45.

| @ HP Designjet T2500 - Scan to network ‘ | 3 v B v = dm v Pagev Safetyv Took+ @+

() HP Designjet T2500

NPIB40164 / 16.23 86 202 Printer status: () Jobs on hold in queve &3
T e

Configuration

; : Scan to network = |
Printer settings

Securiy

t |
ntemet connection [# add netwark roider

HP ePrint Center connectivity

E-mail server
Notification

Sean to network

Date & Time

Anonymous usage information storage
Maintenance

Firmware update

Faper management

€& Local intranet | Protected Mode: Off 3 - ®B00% -

Alternatively, in the HP Utility, select the Settings tab and then Scan to network. See Access the HP
Utility on page 45.

2. OntheScanto Network page, click Add folder details, and fill in the various fields.
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& HP Designjet T2500 - Scan to network 5o~ v [ g% - Page~v Safety~ Took~ @~

(}) HP Designjet T2500

NPI340164 / 16.23.86.202 Printer status: O Jobs on hold in queue @
= 1 Setup | Customer invotvemont Program | it !
Scan to network I |

Securty

Protocol: FTP -
Internet connection

HF eFrint Center connectivity Folertype @ Public © Private
E-mai server
Notification i
T e (=} Set this network destination as defautt
Date & Time

Server name: Folder name: Folder path
Anonymous usage information storage
Mitaienanee User domair User name User.
Firmvrare update

Paper management User password Confirm password

Note:
*If your user does not belong to any domain, simply leave this field empty. Please see help page for further details.

Done € Local intranet | Protected Mode: Off 4 v ®|10% ~

e  Protocol may be FTP or CIFS (Windows).

e  Folder type may be public or private. The folder type is displayed in both the Embedded Web
Server and the front panel with an icon. When you select a private folder, you must enter a
password in the front panel.

e  Alias name is displayed in the front panel when you are choosing the scan destination. It may be
different from the network or FTP folder name.

e  Server name should contain the network name of the remote computer.
o  Folder name should contain the share name of the folder.

e  User name should contain the name of the 'scanner user'.

e  User password should contain the password of the 'scanner user'.

° Domain name should contain the name of the domain in which the user name exists. If the
'scanner user' does not belong to any domain, leave this field empty.

The server and folder names are used to connect to the shared folder by building a network folder path
as follows: \\server name\folder name

For a network folder, enter the name or IP address of the remote computer, the name of the shared
folder, and the user name and password of the 'scanner user' that you have already created on the
remote computer. Leave the user domain field empty unless the user is a member of a Windows
domain. If the user is only a local user of the remote computer, leave the field empty. You can use the
name (instead of the IP address) in the server name field only if the shared folder is on a Windows
computer in the same local network. This must be a simple name (up to 16 characters long) without a
domain suffix (without any dots in the name). Fully qualified DNS domain names are not supported. If
the product and the network folder are in different networks, or if the remote computer is not running
Windows, then you must use the IPv4 address instead of the name of the remote computer. On IPv6
networks the IPv6 address is also supported.

For an FTP folder, enter the server name, folder name, user name, and password. Leave the user
domain empty.
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3. Click Add to save the configuration.

|‘__*:"’49N0TE: If the product has already been configured for scanning to the network and you now want to
use a different shared folder, click Modify.

4. The printer automatically checks that it can access the network folder. If not, see Cannot access the
network folder on page 200.

You can check at any later time that the shared folder remains accessible by clicking Verify in the
Embedded Web Server. A correctly configured shared folder can become inaccessible if the user’s
password is changed, or if the shared folder is moved or deleted.

Example: Create a scan-to-network folder under Windows

1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing user
account for this purpose, but it is not recommended.

2. Create a new folder on the remote computer, unless you want to use an existing folder.
3. Right-click the folder and select Properties.

4. Inthe Sharing tab, click the Advanced Sharing button.

| My Scans Properties [

Generall Sharing ‘ Security | Previous Versions Custom\zel

Network File and Folder Sharing

My Scans
| Not Shared

Netwark Path:
Not Shared

Advanced Sharing

Set custom permissions, create multiple shares. and set other
advanced sharing options.

5. Check the Share this folder box.
Advanced Sharing @

Settings
Share
My Scans
Add Remove
Limit the number of simultaneous users to: 10 A

Comments:

[ ok || cancl |[ appy
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6. You need to ensure that the 'scanner user' has full read/write control over the shared folder. To do this,
click Permissions and grant Full Control to the user (or to any suitable group that includes that user).

Permissions for My Scans @
Share Permissions

Group or user names:

Reeyore |
I Add ] I Remove ]
Permissions for Everyone Allow Deny
Full Control [
Change ]
Read (]
Learn about access control and p: ion:
[ oK ] I Cancel ] I Apply ]

7. Ifthereis a Security tab in the Properties window for your folder, then you must also grant the same
user Full Control over the folder in the Security tab. Only some file systems such as NTFS require this.

.
My Scans Properties @

‘ General | Sharmg‘ Security |Prevmus Versions Cusmmlze‘

Objectname: C:\My Scans

Group or user names;
2 Authenticated Users
4 SYSTEM

To change permissions, click Edit.

Permissions for Authenticated

Users Allow Deny
Full control v Pl
Modify v
Read & execute v 3
List folder contents v
Read v
Write v 2z

For special permissions or advanced seftings,
click Advanced. =

Learn about access control and permissions

l 0K ] l Cancel ] Apply

The 'scanner user' can now access the folder and write files to it. Next, you must configure the printer to
send scans to the folder.

Example: Create a scan-to-network folder under Mac 0S

1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing user
account for this purpose, but it is not recommended.

2. Create or choose a folder on the remote computer. By default, Mac OS users have a Public folder that
can easily be used for this purpose.
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3. Openthe System Preferences application and select the Sharing icon.

800

(<[> ) [showa ]

Sharing

Computer Name: Joe Blogg's iMac

Computers on your local network can access your computer at: Joe-

Bloggs-iMac.local

On | Service

DVD or CD Sharing
Screen Sharing |
Printer Sharing

‘Web Sharing

Remote Login
Remote Management
Remote Apple Events
Xgrid Sharing
Internet Sharing
Bluetooth Sharing

BE

DOoOO0DDOoOoD

) File Sharing: Off

Edit...

File Sharing allows other users to access shared folders on this computer

and allows administrators to access all volumes.

Shared Folders: Users:
[ Joe Blogg's Public Folder ] A Joe Blogg
28 Users
a8 Everyone
+ |- +

f
J_ ‘ Click the lock to prevent further changes.

4. Make sure the 'scanner user' has Read & Write access to the folder.

5. Click Options.

Read & Write &
Read Only -
Read Only H

Options...

@

6. Check the Share files and folder using SMB box, and make sure that the 'scanner user' is checked in the

On column.

1 Share files and folders using AFP

File Sharing: Off

1 Share files and folders using FTP

Warning: FTP logins and data transfers are not encrypted.

E‘Share files and folders using SMB

When you enable SMB sharing for a user account, you must enter
the password for that account. Sharing with SMB stores this

password in a less secure manner.

On  Account
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7. Click Done. You will now see file sharing enabled and Windows sharing on.

80 Sharing
[ «]» | [ showall Q
Computer Name: Joe Blogg's iMac
Computers on your local network can access your computer at: Joe- (T\
Blogas-iMac.local b
On  Service @ Windows Sharing: On
] DVD or CD Sharing Windows users can access your computer at smb://10.0.1.40.
] Screen Sharing
E‘ File Sharing
1 Printer Sharing Shared Folders: Users:
[T Web Sharing [71Joe Blogg's Public Folder A Joe Blogg Read & Write &
1 Remote Login 28 Users Read Only
[ Remote Management #f Everyone Read Only
"1 Remote Apple Events
[ Xgrid Sharing
"1 Internet Sharing
] Bluetooth Sharing
+[-] [+]-] ("Options... )

fl -
U] Click the lock to prevent further changes. &

The 'scanner user' can now access the folder and write files to it. Next, you must configure the printer to
send scans to the folder.

Paper suitability options

Paper mismatch action

If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put the job
on hold until some suitable paper is loaded, or it can ignore the problem and print the job on the unsuitable
paper. There are several ways in which the loaded paper may be considered unsuitable:

e  The paper type is not as specified for the job
e  The paper source (roll 1, roll 2 or sheet) is not as specified for the job
e  The paper size is smaller than specified for the job

You can set the printer's behavior in such cases from the front panel.

®  Press , then n then Setup > Job management > Paper mismatch action > Print anyway if

you want such jobs to print on whatever paper is loaded. This is the default option when printing from a
software application or from the Embedded Web Server; but it does not work when printing from a USB
flash drive.

®  Press &gl then n then Setup > Job management > Paper mismatch action > Put job on hold if
you want such jobs to be put on hold. The printer will send an alert whenever a job is put on hold.

When ajob is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded, after
which you can visit the queue and choose to resume printing it. Meanwhile, other jobs with different
requirements can continue printing.

Roll switching options

If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your
preferences. These can be set from the front panel: press , then n then Setup > Printing
preferences > Paper options > Roll switching options.
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Minimize paper waste. If this option is chosen, the printer will choose the narrowest roll that meets all
the criteria, to avoid wasting paper due to trimming. This is the default option.

Minimize roll changes. If this option is chosen, the printer will choose the roll that is currently active, to
avoid wasting time with a roll switch.

Use roll with less paper. If this option is chosen, the printer will choose the roll that has the least paper.

E‘/{’NOTE: This option is effective only if you have enabled Printing paper info (see Printing paper info

on page 63). Otherwise, it has the same effect as Minimize paper waste.

Turn nesting on and off

Nesting means automatically printing images or document pages side by side on the paper when feasible,
rather than one after the other. This is done to avoid wasting paper. See Nest jobs to save roll paper

on page 79.

To turn nesting on or off, you must first make sure that the job queue is enabled (see Turn off the job queue
on page 105 or Turn off the job queue on page 109) and the start of printing is set to After Processing (see

Select when to print a job in the queue on page 104 or Select when to print a job in the queue on page 107).

Then:

In the HP Designjet Utility for Windows: from the Admin tab, select Printer settings > Job
Management > Nest.

In the HP Utility for Mac 0S X: select Configuration > Printer Settings > Configure Printer Settings >
Job Management > Nest.

In the Embedded Web Server: select Setup > Printer settings > Job management > Nest.

Using the front panel: press [2Fg9 then n then Setup > Job management > Nest options >
Nesting.

In each case, you will see the following options:

In order: pages are nested in the order in which they are sent to the printer. The nested pages are
printed as soon as one of three conditions is met:

° The next page will not fit on the same row as the other pages already nested.
° No page has been sent to the printer during the specified wait time.

° The next page is incompatible with the pages already nested (see Nest jobs to save roll paper
on page 79).

Optimized order: pages are not necessarily nested in the order in which they are sent to the printer.
When it receives an incompatible page, the printer holds it and waits for compatible pages to complete
the nest. The nested pages are printed as soon as one of three conditions is met:

° The next page will not fit on the same row as the other pages already nested.
° No page has been sent to the printer during the specified wait time.

° The incompatible-page queue is full. The printer can queue up to six incompatible pages while
nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

Off: nesting is disabled. This is the default option.

The nesting wait time can be set at the front panel: press , then n, then Setup > Job management
> Nest options > Wait time.
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- TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print because the

"*" printer waits for compatible pages to arrive.

Turn usage information on and off

The printer can send usage information periodically by e-mail. You can request this in the following ways:
e  Inthe HP Designjet Utility for Windows: from the Admin tab, select Printer settings > Accounting.

e  Inthe HP Utility for Mac 0S X: select Configuration > Printer Settings > Configure Printer Settings >
Accounting.

e  Inthe Embedded Web Server: select Setup > Printer settings > Accounting.

In each case, you must set the following options:

e Send accounting files: On (the default is Off)

e  Send accounting files to: a valid e-mail address

e Send accounting files every: choose a number of days (1-60) or a number of prints (1-500)

You must also ensure that the e-mail server has been configured. To configure the e-mail server using the
Embedded Web Server, select Setup > E-mail server, and fill in the following fields:

e  SMTP server: the IP address of the outgoing mail server (SMTP) that will process all e-mail messages
from the printer. If the mail server requires authentication, e-mail notifications will not work.

° Printer e-mail address: each e-mail message sent by the printer must include a return address,
which does not need to be a real, functional e-mail address, but it should be unique, so that
recipients of the message can identify the printer that sent it. This is not the same e-mail address
that is used by HP ePrint.

° Name
° Port number

° Authentication. If you choose authentication, you are also asked for your username and
password.

Turn e-mail notifications on and off

In order to receive e-mail notifications from the printer, you must have configured the e-mail server (see
Turn usage information on and off on page 31).

The notification service is always turned on, but all specific notifications are turned off by default. You can
turn them on or off individually by selecting Notifications from the Setup tab of the Embedded Web Server.

Turn alerts on and off

ENWwW

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of
your printing jobs changes its status. The alerts are displayed by the printer's front panel, by the HP Utility,
and by the Embedded Web Server.

You can change the alert settings in various ways to display all, some, or none of the available alerts.

Turn usage information on and off
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To access alert settings under Windows
e  Select Alert Settings in the Tools menu of the HP Designjet Utility.
e  Select Alert Settings in any alert page displayed by the HP Designjet Utility.
e  Right-click the system tray icon of the HP Designjet Utility, and select Alert Settings.
In the Alert Settings window, you can use the Alerting slider to turn off alerts completely.

Alternatively, you can choose when, if ever, to display critical or non-critical alerts.

To access alert settings under Mac 0S X

e  Open HP Printer Monitor preferences, select your printer, and then Customize Alerts, so that you can
set each individual alert to appear in specific cases and with a specific time interval.

|+ s

Name: HPDesi¢  Reload Details

USRI Customize Alerts

Connection: 7 Bon
1P Address: 16.23.8  Turn Monitoring Off
Serial Number: CN27NQ

Go to HP Utility

You can turn off alerts completely by unchecking the “Show monitor status in menu bar” box in the
Notifications tab of the HP Printer Monitor preferences. If you leave that box checked but uncheck the “Notify
me when alert appears” box (as below), the alerts will be available in the HP Printer Monitor, but will not pop
up in the Dock screen.

ann Preferences
Lo} @)
General Monitoring | Notifications

E Show monitor status in menu bar ‘

[ Notify me when alert appears
DAl |
Critical only
Custom

List alerts in popup window
Notified only
*) All active

Control access to the printer

Front-panel security settings

From the front panel, you can press . then - then Security, to control some of the features of the
printer.

e  USBdrive: Enable or disable the use of a USB flash drive.
e  Firmware update from USB: Enable or disable firmware updates from a USB flash drive.

° Internet connection: Enable or disable the Internet connection.

E’/{’NOTE: If you disable it, you also disable automatic firmware updates, the HP Designjet ePrint & Share
connection, and remote printing.

e  Enable HP ePrint Center connectivity: Enable or disable the use of HP Designjet ePrint & Share with a
computer connected directly to the printer.
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e  User sessions: Enable or disable automatic log-out after 1, 3, or 5 minutes.

e  Printer access control: Enable, disable, or change the administrator password.

If an administrator password has been set, it must be given in order to perform the following operations:
e  Change the security settings (including the administrator password itself)

e  (Change the configuration of the Internet connection

e  (Change the Automatic Firmware Update configuration

e  Enable or disable automatic downloading and/or installation of automatic firmware updates

e  Restore an earlier firmware version

e  Reset factory defaults

E’%NOTE: The administrator password can contain only characters that appear on the front panel's on-screen
keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not
appear in that limited character set.

Embedded Web Server security settings

From the Embedded Web Server, you can select the Security tab to control access to the printer in various
ways:

e  Specify separate administrator and guest passwords to control access to the Embedded Web Server
e  Securely erase some or all files on the hard disk
° Enable or disable various groups of front panel operations

e  Use the same security settings that are available in the front panel (see above)

E“/,"NOTE: An administrator password may be required.

E“/,"NOTE: For more information, see the Embedded Web Server's online help.

Disable your HP ePrint Center connection

You can disable the connection to the HP ePrint Center if required for security. At the front panel, press
, then n then Connectivity > HP ePrint Center connectivity > HP ePrint Center connectivity and
select Disable.

Disable just puts the remote printing function on hold. If you want to resume using it, you just need to re-
enable it in the same menu. No more setup steps are required at the HP ePrint Center website or in HP
Designjet ePrint & Share.

If you want to disable remote printing permanently, select Disable permanently, which erases your printer
from your HP ePrint Center account. To use remote printing again, you will need to set it up again from
scratch (see Set up your Web-connected printer on page 22).

=2’ NOTE:  You can prevent non-administrators from changing these options by setting an administrator
password in the Embedded Web Server (Setup > Security).

Require account ID

If you want to keep records of printer usage by different user accounts, you can set your printer to require an
account ID for each job.
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e Inthe HP Designjet Utility for Windows: from the Admin tab, select Printer settings > Accounting >
Require account ID.

e Inthe HP Utility for Mac 0S X: select Configuration > Printer Settings > Configure Printer Settings >
Accounting > Require account ID.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on
hold for accounting”.

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting”
by the printer, you can introduce the account ID in the Embedded Web Server, HP Designjet Utility, or HP
Utility by going to the job queue and clicking the job that is on hold. A window with a text box is displayed and
you can enter the account ID into it.

Set Windows driver preferences

34

You can change some default settings in your printer driver according to your own preferences, for instance
to set color emulation or paper-saving options. To do this, press the Start button on your computer's screen,
then select Devices and Settings. In the Devices and Settings window, right-click your printer's icon, and
select Printing Preferences. Any settings you change in the Printing Preferences window will be saved as
default values for the current user.

To set the default values for all users of your system, right-click the printer’s icon, select Printer Properties,
go to the Advanced tab, and select Printing Defaults. Any settings you change in the printing defaults will be
saved for all users.

Other settings, such as Delivery Option constraint (referring to the stacker’s manual and normal modes),
can be changed in the printer properties. To do this, press the Start button, select Devices and Settings,
right-click your printer’s icon, and select Printer Properties. Select the Device Settings tab to define the new
default values.

= HP Designjet TL500 HPGL2 Properties e S

| Genersl | Shaing | Pems | Advanced |  Color M |
Securty Device Settings bout

9 Advanced Features
Show printer information: Yes

Delivery Option constraint: [T IR

[ oren |
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Network configuration

° Introduction

° Verify correct operation

° Preconfigure network settings if required

e  Add the printer to your network system

° Troubleshooting

L Reset network parameters

° Control network protocols

° Front-panel menu items

° Embedded services

e  Supported network protocols
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Introduction

The printer provides a single RJ-45 connector port for a network connection. In order to meet Class B limits,
the use of shielded I/0 cables is required.

The embedded Jetdirect print server supports connection to IEEE 802.3 10Base-T Ethernet, IEEE 802.3u
100Base-TX Fast Ethernet and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When connected
and powered on, the printer auto-negotiates with your network to operate with a link speed of 10, 100, or
1000 Mbps, and to communicate using full- or half-duplex mode. However, you can manually configure the
link using the printer's front panel, or through other configuration tools once network communication is
established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For
security, it includes features to control IP traffic to and from the printer and supports configuration of IP
Security (IPsec) protocols.

Verify correct operation
1.  Printan 10 Configuration page to check for status messages.
2. Inthe upper section of the 10 Configuration page, look for the status message 1/0 Card Ready.
3. If1/0 Card Ready appears, the print server is operating properly. Proceed to the next section.
If a message other than 1/0 Card Ready appears, try the following:
a. Turn the printer off and then on again to re-initialize the print server.

b. Check that the status indicator lights (LEDs) are providing proper status.

[g/%"NOTE: See Troubleshooting on page 37 for link configuration and troubleshooting information.

See the HP Jetdirect Print Servers Administrator’s Guide for your print server model to interpret and
troubleshoot other messages.

Preconfigure network settings if required

If your network requires that you configure network settings before you add the printer to your network
systems, you can do so now.

However, in most cases, you can skip this section. Instead, you can proceed directly to the next section to
install the printer on your network computer systems. The network installation software will allow you to
configure basic network settings and add the printer to your system configuration.

Tools for preconfiguration
The following tools can be used to preconfigure your network settings.
e  The front panel
e  The Embedded Web Server

e  You can use an advanced configuration method, such as BootP, DHCP, Telnet, or the arp and ping
commands. For instructions, see the HP Jetdirect Print Servers Administrator’s Guide for your print
server model.

After the printer is configured with network settings, the configuration values are saved and maintained even
after it is turned off and on again.
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Add the printer to your network system

When the printer is configured for proper operation on your network, you can then add the printer on each
computer that will send print jobs directly to it. To add the printer to your system configuration, you must use
network printer installation software for your system. You are recommended to use the HP Start-Up Kit DVD
that came with your printer.

Client-server printing

After you have set up the printer, you will need to set up your network clients to access it. The procedures
depend on the available utilities for your particular clients and network operating system.

For more information, refer to the documentation and help supplied with your operating system.

UNIX or Linux systems

The printer supports operation with UNIX or Linux systems over a network. Use your system utilities to install
the printer. For more help, visit http://www.hp.com/support/net_printing.

Troubleshooting

10 Configuration page

The 10 Configuration page provides comprehensive print server status. It is an important diagnostic tool,
especially if network communications are not available. For a description of messages that may appear on
the 10 Configuration page, see the HP Jetdirect Print Servers Administrator’s Guide for your print server
model.

LEDs

The printer has status lights (LEDs) that indicate the link status and network activity.
e  When the green light is on, the printer has successfully linked to the network.

e  When the yellow light is blinking, there is network transmission activity.

Link troubleshooting
If the printer does not successfully connect to the network:
e  Both LEDs will be off.
e  LANError - Loss of Carrier will be indicated on the 10 Configuration page.
If a link failure is indicated, try the following:
e  Check cable connections.

e  Manually configure the link setting to match the port configuration of the network hub or switch. For
manual configuration methods, see Link configuration methods on page 38. Turn the printer off, then
on again, to re-initialize the setting.

e  Print an |0 Configuration page and check link settings.
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Item Description

Port Config If the printer is properly linked, this item has one of the following values:

10BASE-T HALF: 10 Mbps, half-duplex
10BASE-T FULL: 10 Mbps, full-duplex
100TX-HALF: 100 Mbps, half-duplex
100TX-FULL: 100 Mbps, full-duplex

1000TX FULL

If the printer is not properly linked, one of the following messages will appear:

UNKNOWN: The printer is in an initialization state.

DISCONNECTED: A network connection has not been detected. Check network cables. Reconfigure
the link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

ON (default): The printer will attempt to automatically configure itself onto the network at the
proper speed and communication mode.

OFF: You must manually configure the link speed and communication mode using the front panel.
Your settings must match those of the network for proper operation.

Link configuration methods

The printer supports 10, 100, or 1000 Mbps network link speeds using full-duplex or half-duplex
communication modes (a 1000T half-duplex selection is not supported). By default, it will attempt to auto-
negotiate its link operation with the network.

When connecting to network hubs and switches that do not support auto-negotiation, the printer will
configure itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-
negotiating 10 Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.

If the printer is not able to connect to the network through auto-negotiation, you can set the link setting by
one of the following methods:

e  Thefront panel

e The Embedded Web Server

e  The Telnet interface, through a system command prompt

e  ATFTP (Trivial File Transfer Protocol) configuration file that is downloaded, for example, from a BootP

or DHCP server

e network management tools such as HP Web Jetadmin

Reset network parameters

Network parameters (for example, the IP address) can be reset to factory default values by a cold reset:
turning the printer off and on again. After a cold reset, print an 10 Configuration page to confirm that factory-
reset values have been assigned.

A CAUTION: A factory-installed HP Jetdirect X.509 certificate will be saved over a cold reset to factory default
values. However, a Certificate Authority (CA) certificate that has been installed by the user to validate a
network authentication server will not be saved.

See also The printer behaves strangely on page 232.
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Control network protocols

The printer can simultaneously support multiple network communication protocols. This allows network
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. For some

protocols, required parameters are automatically sensed and user-specified settings are not needed.
However, for other protocols, there may be many parameters to configure.

Enable or disable network protocols

If a network protocol is enabled, the printer may actively transmit on the network even when there are no

computers on the network that use the protocol. This may increase network traffic. To eliminate unnecessary

traffic, you can disable unused protocols. Disabling unused protocols lets you:

e  Reduce network traffic by eliminating broadcast messages from unused protocols

e  Provide better control over who prints to the printer by eliminating users from other networks who
might route print jobs to this printer

e Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Front-panel menu items
on page 39. For other tools, such as system command access to the embedded Telnet server, see the HP
Jetdirect Print Server Administrator’s Guide for your print server model.

Front-panel menu items

Menu item Sub-menu item

Sub-menu item

Values and Description

TCP/IP Host Name

An alphanumeric string, up to 32 characters, used to
identify the device. This name is listed on the HP Jetdirect
configuration page. The default host name is NPIXXXXXX,
where xxxxxx is the last six digits of the LAN hardware
(MAC) address.

IPV4 Settings

Config Method

Specifies the method that TCP/IPv4 parameters will be
configured on the HP Jetdirect print server.

Bootp: Use BootP (Bootstrap Protocol) for automatic
configuration from a BootP server.

DHCP (default): Use DHCP (Dynamic Host Configuration
Protocol) for automatic configuration from a DHCPv4
server. If selected and a DHCP lease exists, DHCP Release
and DHCP Renew menus are available to set DHCP lease
options.

Auto IP: Use automatic link-local IPv4 addressing. An
address in the form 169.254.x.x is assigned
automatically.

Manual: Use the Manual Settings menu to configure TCP/
IPv4 parameters.

DHCP Release

This menu appears if Config Method was set to DHCP and
a DHCP lease for the print server exists.

No (default): The current DHCP lease is saved.

Yes: The current DHCP lease and the leased IP address
are released.
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Menu item Sub-menuitem Sub-menuitem

Values and Description

DHCP Renew

This menu appears if Config Method was set to DHCP and
a DHCP lease for the print server exists.

No (default): The print server does not request to renew
the DHCP lease.

Yes: The print server requests to renew the current DHCP
lease.

Manual Settings

(Available only if Config Method is set to Manual)
Configure parameters directly from the printer control
panel:

IP Address: The unique IP address of the printer (n.n.n.n).
Subnet Mask: The subnet mask for the printer (n.n.n.n).

Syslog Server: The IP address of the syslog server
(n.n.n.n) used to receive and log syslog messages.

Default Gateway: The IP address (n.n.n.n) of the gateway
or router used for communications with other networks.

Idle Timeout: The time period, in seconds, after which an
idle TCP print data connection is closed (default is 270
seconds, 0 disables the timeout).

Default IP

Specify the IP address to default to when the print server
is unable to obtain an IP address from the network during
a forced TCP/IP reconfiguration (for example, when
manually configured to use BootP or DHCP).

Auto IP: Alink-local IP address 169.254.x.x is set.

Legacy: The address 192.0.0.192 is set, consistent with
older HP Jetdirect devices.

Primary DNS

Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE: This item appears only if Manual configuration is
a higher priority than DHCP in the Config. Precedence
table, configured through the embedded Web server.

Secondary DNS

Specify the IP address (n.n.n.n) of a Secondary Domain
Name System (DNS) Server.

NOTE: Thisitem will appear only if Manual
configuration is a higher priority than DHCP in the Config.
Precedence table, configured through the embedded
Web server.

IPV6 Settings Enable

Use this item to enable or disable IPv6 operation on the
print server.

Off: IPv6 is disabled.

On (default): IPv6 is enabled.

Address

Use this item to manually configure an IPv6 address.

Manual Settings: Use the Manual Settings menu to enable
and manually configure a TCP/ IPv6 address.

Enable: Select this item and choose On to enable manual
configuration, or Off to disable manual configuration.

Address: Use this item to type a 32 hexadecimal digit IPv6
node address that uses the colon hexadecimal syntax.
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Menu item

Sub-menuitem Sub-menu item

Values and Description

DHCPV6 Policy

Router Specified: The stateful auto-configuration method
to be used by the print server is determined by a router.
The router specifies whether the print server obtains its
address, its configuration information, or both from a
DHCPv6 server.

Router Unavailable: If a router is not available, the print
server should attempt to obtain its stateful configuration
from a DHCPv6 server.

Always: Whether or not a router is available, the print
server always attempts to obtain its stateful
configuration from a DHCPv6 server.

Primary DNS

Use this item to specify an IPv6 address for a primary DNS
server that the print server should use.

NOTE: This item will appear only if Manual
configuration is a higher priority than DHCP in the Config
Precedence table, configured through the embedded
Web server.

Secondary DNS

Use this item to specify an IPv6 address for a secondary
DNS server that the print server should use.

NOTE: This item will appear only if Manual
configuration is a higher priority than DHCP in the Config
Precedence table, configured through the embedded
Web server.

Proxy Server

Specifies the proxy server to be used by embedded
applications in the device. A proxy server is typically used
by network clients for Internet access. It caches Web
pages, and provides a degree of Internet security, for
those clients.

To specify a proxy server, enter its IPv4 address or fully-
qualified domain name. The name can be up to 255
octets.

For some networks, you may need to contact your
Independent Service Provider (ISP) for the proxy server
address.

Proxy Port

Type the port number used by the proxy server for client

support. The port number identifies the port reserved for
proxy activity on your network, and can be a value from 0
to 65535.

Security

Print Sec Page

Yes: Prints a page that contains the current IPsec security
settings on the HP Jetdirect print server.

No (default): A security settings page is not printed.

Secure Web

For configuration management, specify whether the
embedded Web server will accept communications using
HTTPS (Secure HTTP) only, or both HTTP and HTTPS.

HTTPS Required: For secure, encrypted communications,
only HTTPS access is accepted. The print server will
appear as a secure site.

HTTP/HTTPS optional: Access using either HTTP or HTTPS
is permitted.

NOTE: The factory default setting depends on the print
server model.
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Menu item Sub-menuitem Sub-menuitem Values and Description

IPSEC Specify the IPsec or Firewall status on the print server.

Keep: IPsec/Firewall status remains the same as
currently configured.

Disable: IPsec/Firewall operation on the print server is
disabled.

Reset Security Specify whether the current security settings on the print
server will be saved or reset to factory defaults.

No (default): The current security settings are
maintained.

Yes: Security settings are reset to factory defaults.

Link Speed The link speed and communication mode of the print
server must match the network. The available settings
depend on the device and installed print server. Select
one of the following link configuration settings:

CAUTION: If you change the link setting, network
communications with the print server and network device
might be lost.

Auto (default): The print server uses auto-negotiation to
configure itself with the highest link speed and
communication mode allowed. If auto-negotiation fails,
either 100TX HALF or 10TX HALF is set depending on the
detected link speed of the hub/switch port. (A 1000T
half-duplex selection is not supported.)

10T Half: 10 Mbps, half-duplex operation.

10T Full: 10 Mbps, Full-duplex operation.

100TX Half: 100 Mbps, half-duplex operation.

100TX Full: 100 Mbps, full-duplex operation.

100TX Auto: Limits auto-negotiation to a maximum link
speed of 100 Mbps.

1000TX Full: 1000 Mbps, full-duplex operation.

Embedded services

Key networking services embedded in the printer are listed below. For the latest features and services, visit
http://www.hp.com/go/jetdirect.

e  Configuration and Management
° BootP/DHCP (IPv4 only)
o DHCPv6
o TFTP (IPv4 only)
o Web Proxy (Automatic/Manual cURL)
° LLMNR
o Telnet (IPv4 only)

° SNMP (v1, v2c, v3) agents
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o Bonjour (for Mac 0S X)
o FTP (File Transfer Protocol)
o WS Discovery (Microsoft Web Services)
o Embedded Web Server, HTTP (TCP port 80)
o Embedded Web Server, HTTPS (TCP port 443)
° IP Security (IPsec)
° Printing
° Raw IP printing (HP-proprietary TCP ports 9100, 9101, 9102)
o LPD printing (TCP port 515)
o |PP printing (TCP port 631)
o FTP printing (TCP ports 20, 21)

° WS Print (Microsoft Web Services)

e  Security
° SNMP v3
° SSL/TLS

o

802.1X authentication: WEP, WPA, WPA2, LEAP, PEAP, and EAP-TLS

° Firewall

Supported network protocols

The supported network protocols, and popular network printing environments that use those protocols, are
listed below.

Supported network Typical network printing environments
protocols
TCP/IPv4 (Direct Mode printing) Microsoft Windows XP, Windows Server 2003, and later versions of Windows

Microsoft Terminal Server and Citrix MetaFrame environments

UNIX and Linux, including: Hewlett-Packard HP-UX, Sun Microsystems Solaris (SPARCsystems only), IBM AlX,
HP MPE-iX, RedHat Linux, SuSE Linux

LPR/LPD (Line Printer Daemon, RFC 1179-compliant) systems
IPP (Internet Printing Protocol)

FTP (File Transfer Protocol) printing

TCP/IPv6 Microsoft Windows XP, Windows Server 2003, and later versions of Windows, Direct Mode port 9100
printing (requires HP IPv6/IPv4 port monitor software running on the system)

LPR/LPD (Line Printer Daemon, RFC 1179—compliant) systems with IPv6 client support
IPP (Internet Printing Protocol) systems with IPv6 client support

FTP (File Transfer Protocol) printing
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Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.

®  If you can understand the current front-panel display language, press , then n, then Setup >
Front panel options > Language.

e If you cannot understand the current front-panel display language, start with the printer powered off.
Press the Power key to turn it on. When you see icons appear on the front panel, press @ and then

. The front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel display.
Press your preferred language.

The available languages are English, Portuguese, Spanish, Catalan, French, Italian, German, Polish, Russian,
Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Access the HP Utility

The HP Utility enables you to manage your printer from a computer with a TCP/IP or Jetdirect connection.

e  Under Windows, start the HP Designjet Utility from your desktop shortcut or from Start > All Programs
> Hewlett-Packard > HP Designjet Utility > HP Designjet Utility. This launches the HP Designjet Utility,
showing the printers installed on your computer. When you open the HP Designjet Utility for the first
time, it may offer you an automatic update with enhanced functionality that we recommend you to
accept.

e  Under Mac 0S X, launch the HP Utility from your Dock shortcut or by selecting STARTUP_DISK > Library
> Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the printers installed on
your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that
printer.

If you have followed these instructions but failed to get through to the HP Utility, see Cannot access the HP
Utility on page 233.

Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser
running on any computer.

To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer.
The following browsers are known to be compatible with the Embedded Web Server:

e Internet Explorer 7 for Windows XP, and later

e  Safari3 for Mac 0S X 10.5, and later

e  Firefox 3.6 and later

e  Google Chrome 7 and later

The Adobe Flash plugin version 7 or later is recommended for viewing job previews.

To access the Embedded Web Server on any computer, open your Web browser and give the IP address of
your printer.

ENWW Change the language of the front-panel display 45



You can see your printer's IP address on the front panel by pressing . and then -

You can also access the Embedded Web Server from the HP Designjet Utility or HP Utility.

If you have followed these instructions but failed to get through to the Embedded Web Server, see Cannot
access the Embedded Web Server on page 233.

Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only),
French, Italian, German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

e  Under Windows, select Tools > Set Language and select a language from the list.

e  Under Mac 0S X, the language is changed as for any other application. In System Preferences, select
International and re-launch the application.

Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish, Catalan,
French, Italian, German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese. It uses
whichever language you have specified in your Web browser's options. If you have specified a language that
it cannot support, it works in English.

To change the language, you must change your Web browser's language setting. For example, in Internet
Explorer, go to the Tools menu and select Internet Options > Languages. Then ensure that the language you
want is at the top of the list in the dialog box.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode
to save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and

press . then - then Setup > Front panel options > Sleep mode wait time. Select the wait time you
want and then press OK; you can set the time from 1 to 240 minutes. The default time is 30 minutes.

Change the auto-off setting

To help save energy, the printer is supplied with an auto-off (automatic power management) feature
enabled, which turns the printer off automatically after a period of inactivity. However, when the printer is
connected to a network, the auto-off feature is automatically disabled, to avoid inconveniencing network
users.

@’NOTE: The auto-off feature is different from sleep mode: it turns the printer off completely. To turn it back
on, use the Power button as usual.

You can configure the auto-off feature from the front panel: you can set it to turn off the printer after 2 to 12
hours of inactivity, or disable auto-off entirely. Press . then - then Setup > Front panel options >
Auto-off.

Change the loudspeaker volume

To change the volume of the printer's loudspeaker, go to the front panel and press . then - then
Setup > Front panel options > Speaker volume, and select Off, Low, or High.
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Change the front-panel display brightness

To change the brightness of the front-panel display, press , then n then Setup > Front panel

options > Display brightness, and select a value you want. Press OK to set the value. The default brightness
is set to 50.

Change the units of measurement

To change the units of measurement in the front-panel display, press , then n, then Setup > Front
panel options > Unit selection, and select English or Metric. By default the units are set to metric.

Configure network settings

ENWW

You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front
panel.

To do so with the Embedded Web Server, select the Networking tab.

With the HP Designjet Utility under Windows, select the Admin tab, then Network Settings. Under Mac 0S X,
select Configuration > Network Settings.

The following settings are available.

e IP Configuration method: Specify the way to set an IP address, selecting BOOTP, DHCP, Auto IP or
Manual.

e  Host name: Specify the IP name of the printer. The name may contain up to 32 ASCll characters.

e IP address: Specify the IP address of the printer. Duplicate IP addresses on a TCP/IP network will cause
communication to fail.

:O-TIP:  Make sure that the combination of IP address, subnet mask and default gateway is valid. If these
* three fields are inconsistent, you may not be able to connect to the printer at all until you fix the
problem from the front panel.

TIP: If you change the current IP address and click Apply, the browser loses the current connection to
the printer because it is pointing to the old address. To reconnect, browse to the new IP address.

e  Subnet mask: Specify a subnet mask, which determines which bits specify the network and which bits
uniquely specify the node within the network.

o Default gateway: Specify the IP address of a router or computer that is used to connect to other
networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the
printer.

e  Domain name: Specify the name of the DNS domain in which the printer resides (for example,
support.hp.com).

=7 NOTE: The domain name does not include the host name: it is not the fully qualified domain name,
such as printer1.support.hp.com.

e Idle timeout: Specify the time that an idle connection is allowed to remain open when a remote
computer is waiting for the printer. The default value is 280 seconds. If set to zero, the timeout is
disabled and the connection is allowed to remain open indefinitely.

° Default IP: Specify the IP address to use when the printer is unable to obtain an IP address from the
network when powered on or when reconfigured to use BOOTP or DHCP.

e  Send DHCP requests: Specify whether DHCP requests are transmitted when a legacy default IP address
or a default Auto IP is assigned.

Change the front-panel display brightness
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To configure the same network settings from the front panel, press , then n then Connectivity >
Network connectivity > Gigabit Ethernet > Modify configuration.

You have various other options available from the Connectivity > Network connectivity > Advanced menu.

Allow SNMP: Specify whether SNMP is permitted.

Embedded Web Server > Allow EWS: Specify whether the Embedded Web Server is enabled.

Web Services > HP Utility software: Enable or disable the HP Utility.

Web Services > Color and paper management: View the color and paper management settings.

Restore factory settings: restore the initial default values of the network settings.

Change the graphic language setting

You can change the graphic language setting by launching the Embedded Web Server from the HP Utility with
the following steps.

1.

Under Windows, select the Admin tab, then Printer settings > Printing preferences.

Under Mac 0S X, select Configuration then Printer settings > Configure printer settings > Printing
preferences.

Select one of the following options.

Select Automatic to let the printer determine which type of file it is receiving. This is the default
setting; it works for most software applications. You should not normally need to change it.

Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going
through a printer driver.

Select PDF only if you are sending a file of that type directly to the printer, without going through a
printer driver (PostScript printers only).

Select PostScript only if you are sending a file of that type directly to the printer, without going
through a printer driver (PostScript printers only).

Select TIFF only if you are sending a file of that type directly to the printer, without going through
a printer driver (PostScript printers only).

Select JPEG only if you are sending a file of that type directly to the printer, without going through
a printer driver (PostScript printers only).

Alternatively, you can change the graphic language setting from the front panel. Press , then n
then Setup > Printing preferences > Graphics language. Select the desired option.

?‘ NOTE: If the graphic language is set from the Embedded Web Server, it overrides the front panel setting.

Manage printer security

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your
printer's email address can print to your printer by just sending a file to it. Although HP provides a spam
filtering service, you should be careful about giving out your printer's email address, as everything sent to
that address may be printed on your printer.

If you are the printer administrator, you can manage printer security or change your printer status to lock
mode by visiting the HP ePrint Center at http://www.hp.com/go/eprintcenter. You can also manage print jobs
from there. At your first visit, you will need to create an account in the HP ePrint Center.
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You may wish to use the same credentials for HP Designjet ePrint & Share and the ePrint Center, so that they
are easier to remember.

Change your printer’s email address

You can change your printer's email address at the HP ePrint Center: http://www.hp.com/go/eprintcenter.
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General advice

A CAUTION: Before starting a paper loading process, ensure that you have enough room around the printer,
both in front and behind. You need at least enough space behind the printer to open the basket fully.

A CAUTION: Ensure that the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

A CAUTION: All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in landscape
orientation.

_‘{?: TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

W

Load a roll onto the spindle

1. Opentheroll cover.
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2. Remove the black end of the spindle from the printer, then the blue end.

A CAUTION: Be sure to remove the black end first. Removing the blue end first could damage the black
end.

/\ WARNING! Do not insert your fingers into the spindle supports during the removal process.
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3. Thespindle has a stop at each end. The blue stop can move along the spindle and has a latch to lock it in
place. Open the latch and remove the blue stop from the end of the spindle.

4. If thereisalready a roll or core on the spindle, remove it.

5. Iftherollis long, rest it horizontally on a table and insert the spindle into it.

:{71 TIP: You may need two people to handle a large roll.

6. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove
theroll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing
the correct orientation.

if—“‘ NOTE: From the front of the printer, the blue stop should be inserted into the right-side holder.

D) 7Y

Ensure both ends of the roll are as close to the spindle stops as possible.
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7. Put the blue stop onto the open end of the spindle, and push it towards the end of the roll.

8. Ensure that the blue stop is pushed in as far as it goes; until both ends are against the stops, then close
the latch.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of
different paper types on different spindles. Extra spindles are available for purchase, see Supplies and
accessories on page 166.

Load a roll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle
on page 51.

:{7'_ TIP: Do not try to open both roll covers at once; this may cause problems. Always close one cover before
* opening the other.

@’NOTE: The first two steps below are optional: you can start with step 3. However, in this case the printer
will not keep track of the length of the roll, and will print no barcode on the roll when it is next unloaded. So
you are recommended to follow all the steps, starting with step 1, unless you have turned off the Printing
paper info option. See Printing paper info on page 63.

1. From the front panel, press . then - if it is not already highlighted, then the rollicon, then
Load.

Alternatively, press . then - then Paper > Paper load > Load roll 1 or Load roll 2.
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If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.

2. Ifyoustart to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn to the standby position, so
that it can be printed on again without reloading whenever required (and vice versa).

=7 NOTE: If at any time you open a roll cover while that roll is loaded but not printing, the roll will be
automatically unloaded, and you will have to reload it the next time you want to print on it.

3. Opentheroll cover.

L

4. Load the spindle into the printer, with the blue stop on the right. Hold the spindle by its ends and not in
the middle, to avoid touching the paper and perhaps leaving marks on it.

5. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the
paper slightly and cut a straight edge.
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6.

Insert the edge of the paper into the printer.

A WARNING! Do not push your fingers inside the printer's paper path.

1.

¥
10.

11.

Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer
detects the paper, it feeds it in automatically.

If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode, which
falls into the basket.

If the leading edge of the paper has no barcode, the front panel prompts you to select the paper
category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list, see The paper type
is not in the list on page 174.

If the Printing paper info option is enabled, the front panel may ask you to specify the length of the
roll. See Printing paper info on page 63.

Close the roll cover when the front panel prompts you to do so.
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E’%NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper cannot be
loaded successfully on page 173.

Unload aroll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow the
appropriate procedure as described below.

Quick procedure with paper on the roll

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically. The front panel
prompts you to load a new roll or sheet.

E’/?"NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the
length of the roll when it is next loaded. See Printing paper info on page 63.

E’%NOTE: If you open the a roll cover while a sheet is loaded, the sheet is also unloaded.

Front panel procedure with paper on the roll

If there is paper on the roll, you can unload it from the front panel.

1. Press - then - if it is not already highlighted, then the roll icon, then Unload.

Alternatively, press - then - then Paper > Paper unload > Unload roll 1 or Unload roll 2.

2. You may need to open the roll cover.
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Load a single sheet

1. Ensure that bothroll covers are closed. If aroll cover is opened while a sheet is loaded, the sheet is
immediately unloaded.

A WARNING! Do not load the sheet before starting the loading process from the front panel.

2. Atthe front panel, press . then - if it is not already highlighted, then the sheet icon, then
Load > Load sheet.

Alternatively, press . then - then Paper > Paper load > Load sheet.

3. Ifarollis already loaded, you have to wait while it is automatically unloaded. The roll is not unloaded,
but withdrawn to the standby position, so that it can be printed on again without reloading as soon as
the sheet paper has been unloaded.

E”%NOTE: If at any time you open a roll cover while that roll is loaded but not printing, the roll will be
automatically unloaded, and you will have to reload it the next time you want to print on it.

4. Select your paper category and type.

_‘0'_ TIP: If you have loaded a paper type whose name does not appear in the paper list, see The paper type
* isnotin the list on page 174.

5.  When prompted by the front panel, insert the sheet into the front of the printer.

6. Align the left-hand edge of the sheet with the blue line on the left-hand side of the printer.
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7.  Push the sheet into the printer until it will not go any further.

A WARNING! Do not push your fingers inside the printer's paper path.

8. Guide the sheet into the printer until the printer beeps and starts pulling the paper.
9. The printer checks the alignment.

10. If the sheet is not correctly aligned, it is ejected, and you will have to try again.

E%NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper cannot
be loaded successfully on page 173.

The stacker

1. Basket

2. Stacker pivoting cover
3. Stacker

By default, the printer cuts the paper after every print job. The resulting printed sheet of paper is neatly
stacked on top of the other printed sheets by the stacker.

To empty the stacker, stand in front of the printer and pull the stack of printed sheets out of the stacker. The
stacker cover may open during this process; make sure that it is closed after you have removed the sheets.
Normally the return spring will close it automatically.

ENWW The stacker 59



60

:"}'_ TIP: Although you can remove sheets from the stacker while the printer is printing, you are recommended
* toremove all the prints together while the printer is not printing.

TIP:  You can lock the stacker cover in the open position to collect special jobs. Make sure that you close it
afterwards.

TIP: If you want to use a photo paper for printing in normal printing mode to the stacker, you are
recommended to use an HP Instant-Dry Photo Paper.

TIP: For stacking papers below 75 gr/m2 activate the blue separators located in the laterals of the stacker
cover. Make sure you deactivate them when using the rest of papers.

Manual printing with the stacker open

The stacker's manual printing mode is designed to be used when you want the highest-quality print possible
on photo paper, and you are willing to stand in front of the printer to ensure it.

You can choose manual mode either for a particular job (for example, from the printer driver), or by putting
the printer into manual mode from the front panel.

e If yousend ajob with manual mode selected, the job is put on hold, and other jobs can continue
printing, until you select it for printing from the front panel (the front panel can guide you through this
process) and open the stacker cover.

 Print & Copy jobs'|  Scan jobs

A HPSC0025.tif
HPSCNOO80

[® HPSCNOO11
HPSC0335.pdf

¥ HPSCNOO18

e If you put the printer into manual mode from the front panel, all jobs in the queue are put on hold for
manual mode, and you can print them from the queue. When you exit manual mode, any jobs still in the
queue return to their previous status.

= NOTE: When opening the stacker to enter manual mode, lock the stacker cover into the open position.
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In manual mode:
e  Youcan print only one page at a time. You must start each page manually from the front panel.
e  You print with the stacker cover open, and stand in front of the printer to check the print as it emerges.

e  With the stacker cover open, you have a better view of the print as it emerges, but the stacker cannot
guarantee that the print will follow the correct paper path, so you must watch over it to prevent
possible damage.

e  You cannot scan or copy because the stacker cover is blocking the scanner.

e If the printer is left idle and in manual mode for more than 15 minutes, manual mode is cancelled, and
you are advised to close the stacker.

e  You can exit manual mode from the front panel or by closing the stacker.

Manual mode is indicated in various front-panel screens by the micon.

Stacker information

Status: Ready

pransy

Stacker

Mode: Manual mode

Normal mode
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Paper information

Manual Standby Not loaded Not loaded

2

E n x
Stacker Roll 1 Roll 2 Sheet

{ -

The basket

The stacker is normally used to collect prints. If you decide not to use the stacker, you can send your prints to
the basket. You may decide to use the basket if the stacker is full, or if you want to separate a job from the
other jobs printed to the stacker.

The basket can accept up to 10 A1 or D-sized sheets of bond paper. Larger prints should be removed from the
basket immediately after printing.

:O-TIP: Ensure that you have routed all cables correctly, so that they do not interfere with paper falling into
the basket. Otherwise you may experience paper jams.

View information about the paper

To view the loaded paper information, press . then - if it is not already highlighted, then the roll
icon.

The following information is displayed on the front panel:
e  The paper type you have selected

e  Rollorsheet status

e  Width of the paper in millimeters (estimated)

The same information is displayed in the HP Designjet Utility for Windows (Overview tab > Supplies tab) and
the HP Utility for Mac 0S X (Information group > Supplies Status).

Paper presets

Each supported paper type has its own characteristics. For optimum print quality, the printer changes the
way it prints on each different paper type. For example, some may need more ink and some may require a
longer drying time. So the printer must be given a description of the requirements of each paper type. This
description is called the paper preset. The paper preset contains the ICC profile, which describes the color
characteristics of the paper; it also contains information on other characteristics and requirements of the
paper that are not directly related to color. Existing paper presets for your printer are already installed in the
printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer only contains
paper presets for the most commonly used paper types. If you have a paper type for which your printer has
no preset, you cannot select that paper type in the front-panel display.

There are two ways to assign a preset for a new paper type.

e  Use one of the existing HP factory paper presets by selecting the closest category and type in the front
panel or the printer driver. See The paper type is not in the list on page 174.
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=7 NOTE: Colors may not be accurate. This method is not recommended for high-quality prints.

e  Download the correct paper preset from http://www.hp.com/go/T2500/paperpresets.

=?NOTE:  HP provides presets for HP paper types only. If you do not find the paper preset you want on
the Web, you may find that it has been added to the latest firmware for your printer. You can check the
firmware release notes for information, see Update the firmware on page 153.

Printing paper info

Enable the Printing paper info option to record the printer’s estimate of the remaining roll length, paper
width and type. The information is a combination of barcode and text that is printed on the leading edge of
the roll when the paper is unloaded from the printer.

a  IEIRHNNNINNAIITiy

138 feet (42.1 m.) of 42 inch (1067 mm.) Photo Gloss Paper

E’%NOTE: The paper-length estimate is available only if the printer registered the amount of paper that was on
the roll when you loaded it. To provide this information to the printer, specify the roll length on the front
panel when loading the paper, or load a roll that has the paper-data barcode printed on it.

E‘/,"NOTE: The barcode and text are printed on the roll only when the loading and unloading processes are
started from the front panel's Paper menu.

E’%NOTE: This option can be expected to work only with papers that are completely opaque. It may fail with
transparent or translucent papers.

To enable the Printing paper info option, go to the front panel and press . then - then Setup >
Printing preferences > Paper options > Printing paper info.

E/%"NOTE: Enabling this option slightly changes the paper loading and unloading procedures.

Move the paper

If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You
may want to do this in order to have more or less white space between the last print and the next one when
the cutter is disabled; or to increase top margin of the next print.

To move the paper, press . then - then Paper > Move paper.

Maintain paper
To maintain paper quality, follow the recommendations below.
e  Storerolls covered by another piece of paper or cloth
e  Store cut sheets covered and clean or brush them before loading them in the printer
e  (leaninput and output platens

e  Keep the scanner lowered unless you need to lift it for some reason

E”%NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 191.
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Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints
where time is of higher importance or when you need to be sure ink is dry before handling.

Press . then - then Setup > Print retrieval > Drying time. You can select:

e Extended, to set a longer than recommended time to ensure ink is completely dry
e  Optimal, to set the default and recommended time for your selected paper (this is the default setting)
e  Reduced, to set a shorter than recommended time when quality is of lower importance

e None, to disable the drying time and remove your print as soon as it finishes printing

A CAUTION: If theink is not dry when the print is removed it could leave ink in the output tray and marks on
the print.

=7 NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away
due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper
and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does
not cut the paper until after the printhead maintenance has completed.

Change the retrieval time

You may wish to add some time after drying in which you can pick up the print before the next job starts.

Press . then - then Setup > Print retrieval > Retrieval time.

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off:

e  From the HP Designjet Utility for Windows, select the Admin tab and change the Cutter option in Printer
Settings > Advanced.

e  Fromthe Embedded Web Server, select the Setup tab, then Printer Settings > Advanced, and change
the Cutter option.

®  From the front panel, press ., then -, then Setup > Print retrieval > Cutter.

The default setting is On.

If the cutter is turned off, it does not cut the paper between jobs, but continues to cut the paper on loading,
unloading, switching between rolls, and switching between the stacker and the basket.

:{'?'_ TIP: To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 64.

Feed and cut the paper

If you go to the front panel and press ., then -, then Paper > Form feed and cut, the printer

advances the paper and makes a straight cut across the front edge. There are several possible reasons why
you might want to do this.
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e  Totrim the leading edge of the paper if it is damaged or not straight. The cut strip falls into the basket.
e Tofeed and cut the paper when the automatic cutter has been disabled.

e  Tocancel the waiting time and print the available pages immediately, if the printer is waiting to nest
more pages.

E’%NOTE: The printhead is serviced after each print, and the paper cannot be cut until the process completes,
S0 you may notice a delay.

E”%NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 191.

_‘{?’_ TIP: To move the paper without cutting it, see Move the paper on page 63.

®
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7 Working with two rolls

The uses of a multiroll printer

A multiroll printer can be useful in several different ways:
e  The printer can automatically switch between different paper types according to your needs.

e  The printer can automatically switch between different paper widths according to your needs. This
enables you to save paper by printing smaller images on narrower paper.

e Ifyouload two identical rolls into the printer, you can leave it printing unattended for a long time,
because it can switch from one roll to the other automatically when the first is exhausted. See
Unattended printing/overnight printing on page 81.

When working with multiple rolls, bear in mind that a protected roll is protected from use unless the roll
number or its paper type are specifically requested. See Roll protection on page 81.

The current status of both rolls is shown on the front panel if you press . then - if it is not already
highlighted.

= NOTE:  When you print from a USB flash drive, multiroll printing is considerably simplified: either you
specify manually which roll you want to use, or you can select Save paper, in which case the printer chooses
the narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls

When you submit a print job from the Embedded Web Server or the printer driver, you can specify (using the
Paper type or Type is option) that you want it to be printed on a particular paper type; you can even specify
(using the Paper source, Source is or Paper Feed option) that you want it to be printed on a particular roll (1
or 2). The printer will try to satisfy these requirements, and it will also look for a paper roll large enough to
print the image without clipping.

e If bothrolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll
switching options on page 29.

e If just one of the rolls is suitable for the job, it will be printed on that roll.

e If neither rollis suitable for the job, it will be held in the job queue with the status “On hold for paper”, or
printed on an unsuitable roll, depending on the paper mismatch action. See Paper mismatch action
on page 29.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the printer,
and on which rolls.

Here are some settings that may be used in typical situations.

@NOTE: The Type is and Source is settings are in the printer driver and the Embedded Web Server; the Roll
switching policy is set in the front panel.
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e  With different paper types loaded:
° Typeis: Select the paper type you require
° Source is: Automatically select / Predetermined
° Roll switching policy: doesn't matter
e  With different paper widths loaded:
° Typeis: Use printer settings
° Source is: Automatically select / Predetermined

° Roll switching policy: Minimize paper waste

_‘{}: TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper
® economically on page 79.

e  Withidentical rolls loaded:
° Type is: Use printer settings
° Source is: Automatically select / Predetermined

° Roll switching policy: Minimize roll changes
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° Introduction

° Print from a USB flash drive

° Print from a computer using the Embedded Web Server or HP Utility

° Print from a computer using a printer driver

° Advanced print settings

° Print from i0OS with AirPrint
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Introduction

There are various different ways in which you can choose to print, depending on your circumstances and
preferences.

e  PrintaTIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a USB flash drive. See Print from a
USB flash drive on page 69.

e  Printafile thatis already in the job queue. See Reprint a job from the queue on page 105.

e  PrintaTIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a computer connected to the
printer, using the Embedded Web Server or the HP Utility. See Print from a computer using the
Embedded Web Server or HP Utility on page 70.

e  Print any kind of file from a computer connected to the printer by network, using a software application
that can open the file, and a printer driver supplied with your printer. See Print from a computer using a
printer driver on page 71.

e  Print using AirPrint from a device that supports it. See Print from i0S with AirPrint on page 82.

° See also Web-connected printing on page 90.

E”%NOTE: To print PDF or PostScript files, a PostScript printer is required.

Print from a USB flash drive

ENWwW

1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript files into the
printer's USB port.

;“—“‘ NOTE: To print PDF or PostScript files, a PostScript printer is required.

=7 NOTE: The use of USB flash drives with your printer may be disabled by the administrator: see Control
access to the printer on page 32.

At the front panel, go to the home screen and press , then a

3.  Select the file to be printed. Files that cannot be printed are indicated with @. You can press folders to
browse their contents.

4. The default print settings are displayed. If you want to change them, press Settings. The following
settings are available:

e  Sizeallows you to resize the print in two different ways: to a percentage of its original size, or to
fit a particular paper size. The default is 100% (its original size).

e  (Color allows you to choose color, grayscale, or black-and-white printing.
e  Print quality allows you to set the print quality to Best, Normal or Fast.

e  Roll allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

e  Manual mode allows you to enable manual printing with the stacker open for this job (it is disabled
by default).

e  Paper output allows you to direct output to the stacker (the default) or the basket

e (Collate allows you to turn collation on or off
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e  Page order: allows you to choose first page on top, or last page on top

e  Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic,
which rotates the print automatically if that will save paper.

e  Printer margins allows you to change the default printer margins.

E’%NOTE: If you change the settings in this way, the changed settings apply to the current job but are not
saved permanently. You can change the default settings, except for the Output setting, by pressing

., then - then Print from USB preferences.

To display a preview of the printed job on the front panel, press Gy‘ .

When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.
6. When you are satisfied with the print settings, press Start.

7.  After printing, you can choose to print another file or go to the job queue. If you print another file
immediately without returning to the home screen, the temporary settings used for the previous file are
used again.

Print from a computer using the Embedded Web Server or HP
Utility

You can print files in this way from any computer that can access the printer's Embedded Web Server. See
Access the Embedded Web Server on page 45.

From the Embedded Web Server, select the Main tab and then Submit job. From the HP Utility, select Job
Center > Submit Job. You will see the window below.

- v [ dh v Pagew Safetyv Toolsv @+

| & HP Designjet 2500 - Submit job [

() HP Designjet T2500
NPIB£0164 / 16.23 .86 202 Printer status: Jobs on hold in queue £
Job center PP
Submit job 2|
Job queue
Stored jobs in printer Submit job i Manage presets 1
Submit job Step 1. Select the files you want to submit
Status
Supplies Path ] Add fles
History
Usage Ber
Accounting
View accessible version
Step 2. Select the settings for the jobi(s) and press the Print button to start printing.
Select saved preset Default
1 Job ssttings Help about the Submit Job page
[ Basic settings
Dserinnt Lnkaows The Submt Job page allows you to send one or more fies to the printer.
Store job in printer OFf Disk free space 43.7 GB
Copies ... Recommendations for best performance:
Collate Off
Reverse printing Last page on toj
% 3 P = Submit the job from the same computer that stores the files.
Hald for preview Default Ty o e
ILBL IR e se the latest version of your browser.
P —— = The browser should be connected dirsctly to the printer, without a proxy.
ey e = HTTP 1.1 should be used rather than HTTF 1.0.
el = HTTP can be significantly faster than HTTPS, You may nesd to changs the
. SR G printer network settings to alow HTTP.
HiNVERCey SO, = A 100baseT LAN is essential for fast fhroughput,
Note: I you have a popup blocker installed, you may need to disable it for this
Web site in order to submit jobs. If you observe that job submission is siow,
may be due to interference from other programs, such as firewalls.
Many options are avallable; however, the same settings are used for each file.
To submitthe file(s) with your settings, cick the Print button.
Jone € Local intranet | Protected Mode: Off v ®100% -
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Press the Add files button to choose the files from your computer that you want to print. The files must be in
one of the following formats:

e  HP-GL/2
e RTL

e TIFF

e JPEG

e  PDF (PostScript printers only)

e  PostScript (PostScript printers only)

E’%NOTE: When you print to a file, the file should be in one of the above formats, but its name may have an

extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and they will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need. Each
option has explanatory text on the right, so that you can understand the behavior of each setting. Remember
that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no
setting, the setting in the printer will be used.

If you have chosen some non-default settings and expect to reuse the same group of settings in the future,
you can save them all under a single name from the Manage presets tab, and recall them using that name
later.

Print from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the
computer (see Installing the software on page 15), and the computer must be connected to the printer by
network.

When the printer driver has been installed and the computer is connected to the printer, you can print from a
software application by using the application's own Print command and selecting the correct printer.

E‘/f’NOTE: When first printing, Windows automatically searches for the printer driver on the Internet (if the

computer is connected to the Internet). This means that you do not need to search for the driver yourself.
However, this process will install the driver without the rest of the software. Therefore, we recommend
installation using the DVD (or the install package that you can download from HP's website) so that all of the
printer software is installed.

Advanced print settings
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The rest of this chapter explains the various print settings that you can use when printing with a printer
driver, the Embedded Web Server or the HP Utility. These methods offer a relatively large number of settings
in order to satisfy all requirements.

_‘Q'?'_ TIP: Ingeneral you are recommended to use the default settings unless you know that they do not meet
° your requirements.

TIP: If youintend to reuse a particular group of settings repeatedly, you can save those settings under a
name of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the
Windows printer driver, and as a 'preset’ in the Embedded Web Server.

Print from a computer using a printer driver
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Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while
fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can also
select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases
printing speed even further, but reduces print quality. Economode can be selected only from the custom
options (not from the slider).

There is also two supplementary custom options that may have an effect on print quality: Maximum Detail
and More Passes. See High-quality printing on page 77.

=2 NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print
Quality Options dialog box (select Custom options and then Settings).

You can select print-quality options in the following ways:

e Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. If you
select Standard Options, you will see a simple slider with which you can select speed or quality. If you
select Custom Options, you will see the more specific options described above.

e Inthe Mac 0S X Print dialog: go to the Paper/Quality panel and look at the Quality Options section. If
you select Standard quality options, you will see a simple slider with which you can select speed or
quality. If you select Custom quality options, you will see the more specific options described above.

e  Onthe Embedded Web Server's Submit Job page: select Basic settings > Print quality. If you then
select Standard options, you can choose between Speed and Quality. If you select Custom options,
you will see the more specific options described above.

®  Using the front panel: press [[2Fg¥, then n then Setup > Printing preferences > Print quality.

E’/{’NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

i.“—“‘ NOTE: You cannot change the print quality of pages that the printer is already receiving or has already
received (even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.

=¥ NOTE: The paper size specified here should be the paper size in which the document was created. It is
possible to rescale the document to a different size for printing. See Rescale a print on page 75.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select your paper size from the
Document Size list.

e Inthe Mac 0S X Print dialog: select your printer, then select your paper size from the Paper Size list.

E’/{’NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e  Onthe Embedded Web Server's Submit Job page: select Advanced settings > Paper > Page size >
Standard.

®  Using the front panel: press [[2¥g4, then n then Setup > Printing preferences > Paper options >
Paper size.
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=¥ NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front

panel.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various
different ways to specify it.

Use the Windows printer driver

1.

2.

3.

4.

Select the Paper/Quality tab.
Press the Custom button.
Enter the name and dimensions of your new paper size.

Press OK. The new paper size is automatically selected.

A custom paper size created in this way has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

The paper size is local to the printer queue. It will not be seen from other printer queues in the same
computer.

In Domain server networks, the paper size is local to the computer. It will not be seen from other
computers sharing the printer queue.

In Workgroup networks, the paper size will be shared among all the computers sharing the printer
queue.

If the printer queue is deleted, the paper size is deleted with it.

Use Windows forms
1.  From the Start menu, or from the Control Panel, select Printers and Faxes.
2. From the File menu, select Server Properties.
3. IntheForms tab, check the Create a new form box.
4. Enter the name and dimensions of your new paper size. Leave the margins as 0.00.
5. Press the Save Form button.
6. Go to the printer driver, and select the Paper/Quality tab.
7. Select More... from the drop-down list of paper sizes.
8. Select your new paper size from the group of Custom sizes.

ENWwW

A custom paper size created in this way has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

Restricted users cannot create paper forms. The “manage documents” role in the Windows Active
Directory is the minimum required.

The paper size is local to the computer. It will be seen in all the printer queues that have been created
on the computer and that support paper of that size.

If a printer queue is shared, this paper size will appear in all the client computers.
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e If aprinter queue is shared from another computer, this paper size will not appear on the drivers
document size list. A Windows form in a shared queue needs to be created in the server.

e If the printer queue is deleted, the paper size is not deleted.

Use the Mac 0S X printer driver

1. Gotothe Page Setup dialog.

E’%NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

2. Select Paper Size > Manage Custom Sizes.

Use the Embedded Web Server
1.  Go to the Submit Job page.

2. Select Advanced settings > Paper > Page size > Custom.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper
(increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in several ways.

e  Inthe Windows driver dialog: select the Paper/Quality tab and then the Margins/Layout button.
e Inthe Mac OS X Print dialog: select the Margins/Layout panel.

e  Onthe Embedded Web Server's Submit Job page: select Advanced settings > Paper > Layout/
Margins.

You will then see at least some of the following options.

= NOTE: Under Mac 0S X, the available margins options depend on the paper size selected. For instance, for
borderless printing you must select a paper size name that includes the words “no margins”.

e  Standard. Your image will be printed on a page of the size you have selected, with a narrow margin
between the edges of the image and the edges of the paper. The image should be small enough to fit
between the margins.

e  Oversize. Your image will be printed on a page slightly larger than the size you have selected. If you cut
off the margins, you will be left with a page of the size you selected, with no margins remaining
between your image and the edges of the paper.

e  (lip Contents By Margins. Your image will be printed on a page of the size you have selected, with a
narrow margin between the edges of the image and the edges of the paper. In this case, if the image is
the same size as the page, the printer assumes that the extreme edges of the image are either white or
unimportant, and do not need to be printed. This may be useful when your image already contains a
border.

e  Borderless. Your image will be printed on a page of the size you have selected, with no margins. The
image is slightly enlarged to ensure that no margin is left between the edges of the image and the
edges of the paper. If you select Automatically by Printer, this enlargement is done automatically. If
you select Manually in Application, you must select a custom page size slightly larger than the page on
which you intend to print. See also Print with no margins on page 78.

Print on loaded paper

To print a job on whichever paper is loaded in the printer:
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Rescale a print

e  Inthe Windows driver dialog: select the Paper/Quality tab, then select Use printer settings in the
Paper Type drop-down list.

e Inthe Mac 0S X Print dialog: select the Paper/Quality panel, then select Any in the Paper Type drop-
down list.

E’%NOTE: These are the default Paper Type selections.

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful:

e If your software does not support large formats

e Ifyourfileis too large for the printer's memory—in this case, you can reduce the paper size in your
software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

e Inthe Windows driver dialog: go to the Layout/Output tab and look at the Resizing Options section.

o

The Print document on option adjusts the image size to the paper size you have selected. For
example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is
enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image
to fit the A4 size.

The % of actual size option enlarges the printable area of the original paper size (the page minus
the margins) by the percentage indicated, then adds the margins to create the output paper size.

e Inthe Mac 0S X Print dialog (non-PostScript printers): select the Paper Handling panel, then Scale to
fit paper size, and select the paper size to which you want to scale the image. If you want to increase
the size of the image, make sure that the Scale down only box is unchecked.

e Inthe Mac 0S X Print dialog (PostScript printers): select the Finishing panel, then Print document on,
and select the paper size to which you want to scale the image. For example, if you have selected ISO A2
as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper
size is selected, the printer reduces a larger image to fit the A4 size.

e  Onthe Embedded Web Server's Submit Job page: select Advanced settings > Resizing.

o

The Standard and Custom options adjust the image size to the standard or custom paper size you
have selected. For example, if you have selected ISO A2 as the paper size and you print an A4-size
image, it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a
larger image to fit the A3 size.

The % of actual size option enlarges the printable area of the original paper size (the page minus
the margins) by the percentage indicated, then adds the margins to create the output paper size.

®  Using the front panel: press , then n then Setup > Printing preferences > Paper options >
Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise
the image will be clipped.

Change the treatment of overlapping lines
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E’%NOTE: This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

Advanced print settings
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Off: where the lines cross, only the color of the top line is printed. This is the default setting.

On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and press , then n then Setup > Printing preferences >

HP-GL/2 options > Merge. You can set the merge option from your software in some applications. Settings in
your software override the front-panel settings.

Preview a print

Previewing a print on the screen allows you to check the layout of the print before printing, which may help
you to avoid wasting paper and ink on a bad print.

To preview a print under Windows, you have the following options:
° Use your application's print preview option.

° Check the Show preview before printing option, which you can find in the driver's Paper/Quality
tab and Layout/Qutput tab. The preview may be provided in different ways, depending on your
printer and printer driver.

To preview a print under Mac 0S X, you have the following options:
° Use your application's print preview option.

° Open the PDF menu at the bottom left of your application's Printing panel. Select the HP Print
Preview option, which opens the HP Print Preview application to display the final appearance of
your printed image. Printing features, such as the ability to change paper size, paper type, and
print quality, or rotate the image, can be changed on the fly.

To preview a print using the Embedded Web Server, select Basic settings > Hold for preview.

Print a draft

You can specify fast draft-quality printing in the following ways:

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move
the print-quality slider to the extreme left (‘'Speed').

In the Mac 0S X Print dialog: go to the Paper/Quality panel and move the print-quality slider to the
extreme left ('Speed).

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Standard
options > Speed.

Using the front panel: press , then n then Setup > Printing preferences > Print quality >
Quality level > Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for
documents containing only text and line drawings.

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Select
Custom Options, then set the quality level to Fast and check the Economode box.

In the Mac 0S X Print dialog: go to the Paper/Quality panel and set the quality options to Custom, then
set quality to Fast and check the Economode box.

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Custom. Set
Quality level to Fast, and Economode to On.

Using the front panel: press , then n then Setup > Printing preferences > Print quality >
Economode.
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E‘%"NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing

You can specify high-quality printing in the following ways:

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move
the print-quality slider to the extreme right ('Quality').

In the Mac 0S X Print dialog: go to the Paper/Quality panel and move the print-quality slider to the
extreme right ('Quality').

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Standard
options > Quality.

Using the front panel: press , then n then Setup > Printing preferences > Print quality >
Quality level > Best.

E‘%"NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

:{7'_ TIP: For the highest-quality printing on photo paper, see Manual printing with the stacker open on page 60.

If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print
Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail
option. This option is available only if you are printing on photo paper and you have selected Best print
quality.

In the driver dialog (Mac 0S X Print dialog): select Custom instead of Standard print-quality options,
then check the Maximum Detail box.

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Custom. Set
Quality level to Best, and Maximum detail to On.

Using the front panel: press , then n then Setup > Printing preferences > Print quality >
Maximum detail.

E’/{’NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase the
amount of ink used.

If you have printhead problems

If your printheads have an excessive number of clogged nozzles (which may cause banding or white streaks
on your prints), print quality can be improved by selecting the More Passes option.

In the driver dialog (Mac 0S X Print dialog): select custom instead of standard print-quality options,
then check the More Passes box.

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Custom. Set
Quality level to Best, and More passes to Yes.

E’%NOTE: The More Passes option results in slower printing, but it does not increase the amount of ink used.

_‘{'?'_ TIP:

Instead of using this option, consider using the Image Diagnostics Print to identify the printhead or

"*" printheads that are causing the problem, and then clean or replace them. See The Image Diagnostics Print
on page 196.

ENWW
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Printin gray shades

You can convert all colors in your image to shades of gray: see Printing in grayscale on page 115.

Print with no margins

Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done only on
rolls of photo paper.

In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink
deposited outside the paper is absorbed by the sponge situated in the platen.

You can request printing with no margins in the following ways:

e Inthe Windows driver dialog: select the Paper/Quality tab and press the Margins/Layout button.
Then select Borderless.

e Inthe Mac 0S X Page Setup dialog: select a paper size name that includes the words “no margins”.
Then, in the Print dialog, select Margins/Layout > Borderless.

E’%NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e Inthe Mac 0S X PostScript Page Setup dialog: select a paper size name that includes the words “no
margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

E‘%"NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e  Onthe Embedded Web Server's Submit Job page: select Advanced settings > Paper > Layout/Margins
> Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:

e  Automatically by printer means that the printer automatically enlarges your image slightly (normally
by a few millimeters in each direction) in order to print over the edges of the paper.

e  Manually in application means that you must enlarge the image yourself in your application, and select
a custom paper size that is slightly larger than the actual paper size.

=¥ NOTE: If the first print job after loading paper is a borderless job, the printer may trim the leading edge of
the paper before printing.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure
that the print is borderless. It then cuts the paper again so that no residual part of the image is included in the
next print. However, if the job is cancelled, or if there is white space at the bottom of the image, only a single
cut is made.

Print with crop lines

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop
lines with individual jobs in the following ways:

e Inthe Windows driver dialog: select the Layout/Output tab, then Crop lines.
e Inthe Mac 0S X Print dialog: select the Finishing panel, then Crop lines.

e  Onthe Embedded Web Server's Submit Job page: select Advanced settings > Roll options > Enable
crop lines > Yes.

Alternatively, you can choose to print crop lines with all jobs by default:
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e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Use crop lines
when printing > On.

®  Using the front panel: press , then n then Setup > Printing preferences > Paper options >
Enable crop lines > On.

To print crop lines with nested jobs (see Nest jobs to save roll paper on page 79), you must select a
different option:

e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Use crop lines
when nest is enabled > On.

®  Using the front panel: press , then n then Setup > Job management > Nest options >
Enable crop lines > On.
Use paper economically
Here are some recommendations for making economical use of paper:

e If you are printing relatively small images or document pages, you can use nesting to print them side by
side instead of one after another. See Nest jobs to save roll paper on page 79.

e  You may be able to save some roll paper by using the following options:

° In the Windows driver dialog: select the Layout/Output tab and then Remove blank areas and/or
Rotate by 90 degrees or Autorotate.

° In the Mac 0S X Print dialog (non-PostScript printers): select the Finishing panel, then Remove
Blank Areas.

° In the Mac 0S X PostScript Print dialog (PostScript printers): select the Finishing panel, then
Remove Blank Areas and/or Rotate by 90 degrees.

° On the Embedded Web Server's Submit Job page: select Advanced settings > Roll options >
Remove top/bottom blank areas and/or Rotate.

e If you check the print preview on your computer before printing, you can sometimes avoid wasting
paper on prints containing obvious mistakes. See Preview a print on page 76.

Nest jobs to save roll paper

Nesting means automatically printing images or document pages side by side on the paper, rather than one
after the other. This is done to avoid wasting paper.

T to

1. Direction of paper flow

2. Nesting off
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4,

Nesting on

Paper saved by nesting

When does the printer try to nest pages?

When both of the following are true:

The printer is loaded with roll paper, not sheet paper.

The printer's Nest option is turned on. See Turn nesting on and off on page 30.

What pages can be nested?

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless
there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot
be split between two rolls.

Which pages qualify for nesting?

In order to be in the same nest, the individual pages must be compatible in all of the following ways:

All pages must have the same print quality setting (Economode, Fast, Normal or Best).
The Maximum Detail setting must be the same on all pages.

The Layout/Margins setting must be the same for all pages.

The Mirror Image setting must be the same for all pages.

The Rendering Intent must be the same for all pages.

The Cutter setting must be the same for all pages.

The color adjustment settings must be the same for all pages. See Color adjustment options
on page 114.

Pages must be all color, or all grayscale: not some in color and some in grayscale.

All pages must be in one or other of the following two groups (the two groups cannot be mixed in the
same nest):

° HP-GL/2, RTL, TIFF, JPEG
° PostScript, PDF

JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some
cases.

How long does the printer wait for another file?

So that the printer can make the best nest possible, it waits after a file has been received to check whether a
subsequent page will nest with it or with pages already in the queue. This waiting period is the nest wait time;
the factory default nest wait time is 2 minutes. This means that the printer waits for up to 2 minutes after the
last file is received before printing the final nest. You can change this waiting time from the printer's front
panel: press , then n then Setup > Job management > Nest options > Wait time. The available

rangeis 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel.

80 Chapter 8 Printing ENWwW



Use ink economically

Here are some recommendations for making economical use of ink.

For draft prints, use plain paper and move the print-quality slider to the left end of the scale ('Speed').
For further economy, select custom print quality options, then select Fast and Economode.

Clean the printhead only when needed. Cleaning the printhead can be useful, but it uses a small amount
of ink.

Leave the printer permanently turned on so that it can maintain the printhead in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printhead.

Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses
some ink, and its frequency is related to the number of passes made by the printhead. Therefore,
nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper on page 79).

Roll protection

If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll number or
the paper type loaded on the roll. This may be useful, for example, in the following cases.

To stop people from accidentally printing unimportant jobs on expensive paper.

To avoid printing on a particular roll when printing from AutoCAD without interacting with the HP printer
driver.

To protect aroll, go to the front panel and press , then n then Setup > Printing preferences >
Paper options > Roll protection.

=7 NOTE: If you protect aroll, then later unload the current roll and load a new one, the new roll remains
protected. You are protecting the roll number, not one specific roll of paper. That roll number will remain
protected until you cancel the protection.

:{7'_ TIP:

If you print without specifying a roll number or paper type, you will not be able to print on any

"*" protected roll.

Unattended printing/overnight printing

ENWW

The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent
image quality.

Here are some recommendations to help you deal with a long queue of printing jobs.

Empty the stacker.
If feasible, use brand-new long rolls of paper.

If you want to print on partly-used rolls, you can check the paper type and the remaining length in the
Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your
jobs.

=¥ NOTE: Information on the remaining length is available only if you told the printer the length of the

roll when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically switch
to the other.

Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put
“on hold for paper” if the paper mismatch action is set to Put job on hold (see Paper mismatch action

on page 29).
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e  C(Check theink levels remaining in your ink cartridges.

e  When you have submitted your print jobs, you can use the Embedded Web Server from a remote
location to monitor their status.

e  Drying time should be set to Optimal.

®  Press . then - then Setup > Printing preferences > Paper options > Roll switching options
> Minimize roll changes or Use roll with less paper.

We recommend the following settings, depending on the paper type and what kind of prints you are making.

Table 8-1 Recommended settings for unattended printing

Print type Print mode MaxDetail Drying time Paper types

Lines Normal Off Optimal Coated, Bond,
Heavyweight Coated,
Photo

Lines and fills Normal On Optimal Coated, Bond,
Heavyweight Coated,
Photo

Maps Best On Optimal Coated, Heavyweight
Coated, Photo

Renderings, Best On Optimal Coated, Heavyweight

photographs Coated, Photo

Print from i0S with AirPrint

You can print using AirPrint without needing a printer driver, bearing in mind the following points.

®  Ensure that Airprint is enabled: go to the printer’s front panel and press . then - then Setup >
Connectivity > AirPrint connectivity > AirPrint.

e  Your AirPrint device must be in the same segment of the same local network as the printer. When using
Wi-Fi, the Wi-Fi network must be bridged to the wired network used by the printer (as is the case with
most home or small-office routers).

®  Toidentify the right printer from your AirPrint device, go to the printer's front panel, press . then
-, and make a note of the Bonjour/AirPrint name.

e  Many iPhone apps may not be able to print pages larger than A4 or US Letter size. Please check with the
app developer.

e If you cannot print from the app you are using, try printing from another app.

¥ E-mail Document
Ei Open In...
Df Send For Signature

™ Print Document
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e  Toprint, press the arrow and then Print. Choose your printer's name from the list that appears.

®  If you need more information, go to the printer's front panel, and press . then - then Setup >
Connectivity > AirPrint connectivity > Help.

Alternatively, visit http://www.hp.com/go/airprint.
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9 Scanning

Paper types suitable for scanning

The scanner does not support the full range of paper types that may be used by the printer.

The following paper types are supported by the scanner.

White paper to scan any matte original printed with inkjet technology. Choose this option to scan, for
instance, anything printed with this printer on any of these paper types: HP Universal Inkjet Bond Paper,
HP Coated Paper, HP Heavyweight Coated Paper, plain paper.

Photo paper to scan glossy and satin originals. Inkjet, offset and traditional photo technologies are
supported by this option. Choose this option to scan, for instance, any photo or other image printed on
any of these paper types: HP Universal High Gloss Photo Paper, HP Premium Instant Dry Gloss/Satin
Photo Paper. However, for some specific photo originals, this option may not give completely accurate
results, in which case you could try White paper instead.

A CAUTION: Photo and glossy papers may be scratched while passing through the scanner.

Old/recycled paper to scan matte originals printed on recycled paper or very old originals, the
background of which is no longer white. Choose this option to scan, for instance, anything printed on
this printer using HP Recycled Bond Paper, or any old print on plain paper that has become yellowish
over the years.

Translucent paper to scan semi-transparent tracing papers (> 65 g/m?), including HP Natural Tracing
Paper, HP Vellum and HP Translucent Bond.

Blueprints for scanning blueprint originals with optimum results, in grayscale only. This option greatly
enhances the contrast of the resulting image.

For best results, you should select the correct paper type in the scan settings before scanning.

The following paper types are not supported by the scanner.

e Film
e  Backlit material
e  (ling material
e  Translucent paper (< 65 g/m?)
Scan to file
1.  Load the sheet with the printed side facing upwards (you can also load the sheet before step 1, if you

prefer). Align the center of the sheet approximately with the center of the scanner. Use the standard
size markings to help you.
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@NOTE: The maximum length of paper that the scanner can scan depends on the paper width and the
scan resolution. An alert is displayed if the maximum length is exceeded.

@NOTE: Scanned images may be saved to PDF files with the T2500 PS only.

2. Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will automatically
grab the sheet and move it into position for scanning. If you feel that the sheet has loaded badly and
you want to try again, you can pull it out manually.

At the front panel, go to the home screen and press , then select where you would like to store the

scanned image.

Select destination

USB drive Network folder HP ePrint&Share

° In a USB flash drive
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[g/%"NOTE: The use of USB flash drives with your printer may be disabled in the Embedded Web
Server (Setup > Security > Disable USB drives).

e Inanetwork folder (a folder on a computer that is accessible through the network)

E/;’NOTE: The network folder option will not work unless the network folder has been correctly set
up and identified in the Embedded Web Server or HP Utility: see Configure a scan-to-network or
scan-to-FTP folder on page 24.

Q TIP:  To check the currently-configured network folder, go to the front panel and press ,

then .

e In HP Designjet ePrint & Share

Q TIP:  To check the currently-configured network folder, go to the front panel and press ,

then .

E”%NOTE: If the scanner is later unable to store your file in the chosen destination (USB flash drive or
network folder), you are given the opportunity to change your mind and use the other alternative.

4. Some of the default scan settings are displayed. Press Settings to see the complete list of settings, and
check in particular that the Original type setting corresponds to the paper type that you intend to scan.

o  Format allows you to specify the format of the file in which the scanned image will be saved: TIFF,
JPEG or (with the T2500 PS only) PDF.

e  Compression allows you to specify the level of compression: maximum, high (the default level),
medium, or low. This option is available if the format is JPEG or PDF.

e  Resolution allows you to specify the scan resolution: Standard (200 dpi), High (300 dpi), or Max
(600 dpi).

e  Color allows you to choose color, grayscale or black and white scanning.

o  Content type allows you to optimize the scan for a line drawing, a photographic image, or a mixed
image.

e  Original type allows you to specify the paper type on which the original image has been printed.
To optimize scan quality, ensure that this setting is correct.

e  Background removal allows you to remove unwanted background color. You can specify the
strength of this setting, from 0 to 10.

o  Blueprintsinvert allows you to generate a scanned image with a light background. It is useful
when the original you intend to scan is a blueprint with a dark background. This option is available
only if the Original type is set to Blueprints.

E’/{’NOTE: If you change the settings in this way, the changed settings apply to the current job but are not
saved permanently. You can change most of the default settings from the main menu: press n
then Scan preferences.

5. When you are satisfied with the scan settings, press anywhere on the screen to return to the previous
page, then press Start.

6. Once the original has been scanned, you can (if you like) check the file size and change the
automatically-generated filename of the scanned image.

7. If you are scanning to a USB flash drive, wait until the scanned image has been saved in a file, then press
on the front panel and press Eject. Remove the USB flash drive when prompted by the front
panel.
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8.  Press E to eject the scanned sheet from the scanner; be ready to pick it up from the rear.

9. After scanning, you can choose to scan again or go to the job queue.

_‘{?'_ TIP: Allscan jobs are saved in the scan queue, where they can be accessed by any user. If your job is
* private, you may wish to delete it from the queue after recovering the image file.

TIP: If you scan animage to a file and then decide to print it one or more times, you can change the print
settings every time. You can also save it to another location.

E‘%"NOTE: By default, if the original is skewed in the scanner (not loaded straight), the scanner will try to
correct the skew automatically. To turn off this automatic correction, press , then n, then Scan
preferences > De-skew > Off.
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10 Copying

Before starting to copy, see Paper types suitable for scanning on page 84.

1.  Load the sheet with the printed side facing upwards (you can also load the sheet before step 1, if you
prefer). Align the center of the sheet approximately with the center of the scanner. Use the standard
size markings to help you.

@NOTE: The maximum length of paper that the scanner can scan depends on the paper width and the
scanresolution. An alert is displayed if the maximum length is exceeded.

2. Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will automatically
grab the sheet and move it into position for scanning. If you feel that the sheet has loaded badly and
you want to try again, you can pull it out manually.

At the front panel, go to the home screen and press .

4. Some of the default copy settings are displayed. Press Settings to see the complete list of settings, and
check in particular that the Paper type setting corresponds to the paper type that you intend to scan.

e  Size allows you to resize the print in two different ways: to a percentage of its original size, or to
fit a particular paper size. The default is 100% (its original size).

e  Copy quality allows you to set the print quality to Best, Normal or Fast.

88 Chapter 10 Copying ENWW



ENWW

e  Copy color allows you to choose color or grayscale printing.

e  Roll allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit.

e Job output allows you to send the print to stacker or basket.

e  (Content type allows you to optimize the scan for a line drawing, a photographic image, or a mixed
image.

e  Original type allows you to specify the paper type on which the original image has been printed.
To optimize scan quality, ensure that this setting is correct.

=¥ NOTE: If you change the settings in this way, the changed settings apply to the current job but are not
saved permanently. You can change the default settings from the main menu: press , then n
then Copy preferences.

5. When you are satisfied with the copy settings, press anywhere on the screen to return to the previous
page, then press Start.

6. Iftworolls are loaded, you can choose to print on either roll, or you can let the printer choose
automatically.

=2 NOTE: The printer will automatically rotate the image by 90° if it can save paper by doing so.

7. When the scan is complete, press E to eject the scanned sheet from the scanner; be ready to pick it
up.

8.  While the scanned image is being printed, you can perform some other operation: you don't need to wait

for the end of the print.

9. After printing, you can choose to make another copy or go to the job queue. If you make another copy
immediately without returning to the home screen, the temporary settings used for the previous copy
are used again.

E‘/f’NOTE: By default, if the original is skewed in the scanner (not loaded straight), the scanner will try to
correct the skew automatically. To turn off this automatic correction, press , then n then Scan
preferences > De-skew > Off.
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Web-connected printing

Introduction

Enable Cloud printing for your printer

Print through the Cloud with HP Designjet ePrint & Share

Print by email

Print from a smartphone or tablet

View and print from the HP Designjet ePrint & Share website

Print from HP Designjet ePrint & Share using the printer’s front panel

Scan to an email address

View and print from other content repositories

Create your Online Print History

Share files in your Online Print History

HP Designjet ePrint & Share security
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Introduction

Your printer can be connected to the Web, providing various benefits:

Automatic firmware updates (see Update the firmware on page 153)

Print on HP ePrinters from almost anywhere

Print on HP ePrinters from almost any device, including smartphones, tablets, and laptops

For the latest information, see http://www.hp.com/go/designjeteprinters.

E‘%NOTE: You can print by email from any device capable of sending email.

HP Designjet ePrint & Share requires an HP Designjet ePrint & Share account, an Internet connection to the
printer, and a connected Internet-capable device running Windows, Android, or i0S (see http://www.hp.com/
go/eprintandshare for full information). Data or connection charges may apply. Print times may vary.

Enable Cloud printing for your printer

If you are working from home, and you want to print to your office printer, you can print through the Cloud
with HP Designjet ePrint & Share. You need to enable Cloud printing only once for your printer in order to
print remotely.

1.

2.

Ensure that your computer and your printer are connected to the same network.
From your application, send the file to print, selecting your printer.

The HP Designjet Print Preview appears. Select the printer's name, then select Enable Cloud Print from
the drop-down menu.

£} HP Designjet

£ HP Desic

Follow the instructions on the screen. You need to have your HP Designjet ePrint & Share account
credentials to sign in, and the printer's email address to identify it. You can find the email address in the

printer's front panel: press . then -

Printer information _Firmware update |

Product name: HP Designjet T2500 Post...
Printer email: johnsmith@hp.com

Serial number: CN2700H002

Firmware version: MRY_01_00_01.1

Firmware status: Current firmwareisupt...

You can now print through the Cloud to this printer.

Print through the Cloud with HP Designjet ePrint & Share

If you are working from home or at another location outside your office, and you want to print to your office
printer, you can print using HP Designjet ePrint & Share.

ENWW
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1.  From your application, send the file to print, selecting your printer.

2. Ifyouare already signed into your HP Designjet ePrint & Share account, you can select settings and
continue printing through the Cloud.

If you are not signed in to HP Designjet ePrint & Share, a dialog appears asking you if you are trying to
print locally or remotely through the Cloud. Select the option Print remotely through the cloud and
sign in to your account, then continue printing normally.

?‘ NOTE: When printing through the Cloud, no print preview is available. You can specify a paper source and

generate the print preview.

Print by email

After you have enabled Web Services, you can print to your printer by email. You can find the printer's email
address from the front panel: press , then - Then send the file you want to print to that email
address as an attachment.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver.
There are a few limitations that you should bear in mind:

e  The attached files to be printed must be in PDF, JPEG, or TIFF formats.
e  The maximum file size is 10 MB, but your email server may have a lower limit.

e  Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally
in portrait orientation (some printers may offer autorotation)..

Print from a smartphone or tablet

The HP Designjet ePrint & Share apps enable you to access files on your mobile device or in HP Designjet
ePrint & Share and print them to an HP Designjet Web-connected printer. You can obtain these apps from the
following sources:

e  http://www.hp.com/go/designjeteprinters

e  Your smartphone's application storefront

For the latest information, see http://www.hp.com/go/eprintandshare.

? NOTE: Printing with these apps is not the same as printing with AirPrint.

You can use your 3G connection to print. You do not need to be connected with the printer by Wi-Fi, and you
do not need a printer driver.

1. Select the files to print from your Online Print History or from any other location connected to your HP
Designjet ePrint & Share account..
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2.

errmusnare  History

A Printed Scanned Shared

3| Building Render v16

T4dpm

HP Designget T120

School Layout 3

1:41 pm

HP Designint T120
Building Section 1

1:37 pm

HP Designgot T120

Mall 2nd Floor relayout
1

i n-.qr,m T2300 PostSenpt

... Basement Kitchen
anm

Carrier 3G

Basement

220x200 mm

Save offline

Printers

HP Designjet T920
v Ready

=, HP Designjet T920
Ready

An image of your print is displayed.

To print the file, press Print.

Select the printer if it is already listed; or, if necessary, press Add a printer and give your printer's email
address to add it to the list.

Print from a smartphone or tablet
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5. Choose the print settings, then press Print.

solect Primter | Printer settings

Printer name HP Designjet T120

Media source Multi-sheet tray »

Rotate 90 degrees

Coples: 1

Quality MNormal »

r__i”%NOTE: Printing may not start immediately.

Whenever you print a document with HP Designjet ePrint & Share, it is saved in your Online Print History.

From other applications, when there is an ‘Open In’ option available, select ePrint & Share in order to print
your documents on a Web-connected HP Designjet printer.

Reply

Forward
Openin

Cancel

View and print from the HP Designjet ePrint & Share website

1. Goto http://www.hp.com/go/eprintandshare and log in to your account.
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2.

To view and print a file, select the category to filter your list of saved files (printed, scanned, shared
with me, or all). You will see a list of your files ordered by time. The file can be identified by the name,
the date and time of printing, the printer that was used, and the thumbnail.

@ HP Designjet ePrint & Share Home Settings My Printers Support yanna vogiazou@hp.com Sign Out .

My History

( Q)

Sort by- | Creation Date E

= &
€1 4 Page1/1 »

£ prinied

Local 1
[P Scanned 12 Apr 2013 15:08

| _ | sentto HP Designjet T920 FostSeript

[y Shared with me Protect | Delete
i Deleted fies Local 1

12 Apr 2013 14:57
Other storage [+] _ | sentto HP Designjet T920 PostScript

Protect | Delete

—_@® |Welcome to HP ePrint & Share

12 Apr2013 14:35

EE Protect | Delsts

—— | one page
7 Mar 2013 13:1

Shared by ftoscano@hp.com
Delete

You're currently using 0.05% of your quata (2.47MB / 5120.00MB) ©2011 Hewlett-Packard Development Company, LP. | » Privacy statement | » Using this site means you accept its Terms of Usel

Select the file, and a file preview is shown in the right panel. If the file contains multiple pages, you can
navigate through the pages using the arrows. You can also click the preview to enlarge it, and zoom in
to see details.

Press the Print button.

If you have the full HP Designjet software suite installed, a print-preview dialog appears, in which you
can check and modify some settings and select your local or remote ePrinters.

If you do not have the software installed on the computer you are using, you will see a generic screen
that allows you to select the remote printer and change basic settings.

Press the Print button again to send your document to print.

To print on any printer, use the option Print to .PDF. This creates a copy of your document in your
computer, which you can print later.

Print from HP Designjet ePrint & Share using the printer’s front

panel

ENWwW

HP Designjet ePrint & Share allows you to print files on any Web-connected printer, when you want. You don't
need a computer: you can use the printer's front panel.

1.

Press the Print icon on the home screen.
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2. Pressthe HP ePrint & Share icon.

3. Signinto HP Designjet ePrint & Share using your registered email address and password.

Sign in to HP ePrint&Share

Password

0K

New user?

4. Press the white Email address field to enter your email address. A keyboard is displayed so that you can
enter the letters. Press OK when you have finished; then enter your password in the same way.

96 Chapter 11 Web-connected printing ENWW



5. Select an event category by pressing its name. You can select All events, all Printed events, all Scanned
events, or all Shared events.

History user @hp.com

All

Printed

Scanned

Shared

6. Select a particular event by pressing the event name. The number of files associated with each event is
shown on the right.

7. Select afile from the event by pressing the file name.

8. The default print settings are displayed, and you can change them by pressing the Settings button. The
number of copies can be changed by pressing the up or down arrows.

Print from HP Designjet ePrint & Share - HP_ePrint_&_S...

Copies: <Ll»

Size: 100%
Gi, Color: Color

Print quality: Normal

Roll: Save paper

Rotation: Automatic

| Settings |

9. Whenyou are ready to print, press the Print button.

10. After sending one file to print, you can press the Add more icon to select another file. Alternatively,
press the Sign out icon to return to the home screen, or the Job queue icon to go to the job queue.

i Job submitted

The job has been submitted to the queue.
It will be printed as soon as it reaches the local
job queue.

m =

-_

Add more Job queue

;“—“‘ NOTE: If you press Sign out, your HP Designjet ePrint & Share session is closed and you will need to
signin to access it again. Your session is also closed automatically when sufficient time has passed
without activity.

Scan to an email address

You can scan documents directly to any email address through HP Designjet ePrint & Share. Every scan you
send is also copied to your Online Print History.
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1.  Press the Scanicon on the front panel's home screen.

2. Pressthe HP ePrint & Share icon.

Select destination

e

USB drive Network folder HP ePrint&Share

3. Signinusing your registered email address and password.

Sign in to HP ePrint&Share

Password

0K

New user?

4. Press the white Email address field to enter your email address. A keyboard is displayed so that you can
enter the letters. Press OK when you have finished; then enter your password in the same way.

98 Chapter 11 Web-connected printing ENWW



5. The default scan settings are displayed, and you can change them by pressing the Settings button.

can to HP ePrint and Share John Smith

PDF
Standard (200 dpi)
Color
Mixed
Available quota: 500 GB

Settings

= NOTE:  You can change the default settings from the front panel.

6. When you are ready to scan, press the Start button.

7. If you have not already done so, feed the document into the scanner as shown, centered and facing up.

: Please feed the original into the scanner centered and
facing up

8. When the scanis complete, the scan results are displayed. You can press the event name or the file
name to change it; you can press the magnifying glass icon to preview the scan.

= NOTE:  The file name must end with .pdf.

If all is well and the scanned file is within your quota, press the Next button to continue. If the file
exceeds your quota, or if the preview looks wrong, you can press Scan again to change the scan
settings and try again.

Scan details

Event name: HPSCN0023
File name: HPSCNO0023 pdf

File size: 0.00 KB

Available quota: 3.44 GB

I‘i.l Ii.l
Scan again Continue
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9. Inthe next screen, you can choose to share the scan with any of your contacts. You can also add new
contacts. Press the Send button when ready.

E’%NOTE: Your own email address is always selected by default.

Share file with John Smith

* johnsmith@hp.com

Add new contact Send

Your contact will receive an email invitation to view and download the file from the HP Designjet ePrint
& Share website.

10. After adding one document to the scan queue, you can press the Make another scan icon to scan
another document. Alternatively, press the Sign out icon to return to the home screen, or the Scan
queue icon to go to the scan job queue.

E’%NOTE: If you press Sign out or @ your HP Designjet ePrint & Share session is closed and you will
need to sign in to access it again.

11. The scanned document will be available in the Scanned event that was named in the Scan details
screen, and you can later print it or share it with other people.

View and print from other content repositories

You may be able to connect your HP Designjet ePrint & Share account to other content repositories, such as
FTP sites, in which case you can use HP Designjet ePrint & Share to print directly from those repositories. For
further information, see http://www.hp.com/go/eprintandshare.

Create your Online Print History

Documents are automatically added to your Online Print History in each of the following cases:

e  Whenever you print using the HP Designjet ePrint & Share driver, and you are logged into HP Designjet
ePrint & Share from that driver
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Share files in your Online Print History

HP Designjet ePrint & Share security

ENWwW

HP Designjet Preview.

Print List &% HP Designjet T1500 HPGL2

v

AD3 Emplacament (Planta soterrani).pdf

R03 Emplagament (Pla..

For automatic media source, printer policy will apply.

® Stacker

22.99%32.72in

e  Whenever you print from the front panel using HP Designjet ePrint & Share

e  Whenever you print from the the mobile app on your smartphone or tablet

e  Whenever you print from an FTP site using HP Designjet ePrint & Share or the mobile app

Documents are not added to your Online Print History when you print by email without using HP Designjet

ePrint & Share.

You can share any of the files in your Online Print History with your colleagues. For further information, see

http://www.hp.com/go/eprintandshare.

When you add new content to your Online Print History (by printing), only you will have access to that
content; but, whenever you choose to share a file, which you do by sharing a special link with your colleague,

anyone who has that link can access your file.

The access control mechanism is on a file-by-file basis, meaning that if you share something with someone,
that person will have access only to the content of that specific shared file.

You can also unshare a file at any time, in which case the link will no longer work, and no-one will be able to

see the file any more.

&”%NOTE: Anyone who has printed the file will still have it in his or her online print history.

HP support personnel have special account privileges to help in troubleshooting any issue you may have, but

they cannot download any of your files.

As part of the normal service operation, HP performs regular backups of your data. These backups are an
automated process with only the software processes themselves having access to your data.
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HP Designjet ePrint & Share is hosted in a first-class data center. Physical access to these premises is strictly
controlled and restricted. Only employees who have a legitimate business need can access the data center.

All the computers hosting the HP Designjet ePrint & Share service are protected by a multi-tiered firewall, all
the systems are constantly monitored, and intrusion detection tests are run periodically.

The servers on which your files are stored have additional levels of security and isolation, both physical and
logical, even from other services hosted in the same premises.

HP takes security and data privacy very seriously. HP will not sell, rent, or lease your personal information to
others.

You retain full ownership, and any intellectual property rights you may have, to the files you upload to HP
Designjet ePrint & Share. By providing the service, HP does not obtain any special ownership or rights to
these files.

In order for HP to be legally capable of making backups of your data and performing certain actions
(generate a preview, etc.), you grant to HP the right to use the files, solely for the purposes of providing the
HP Designjet ePrint & Share service.

Before you log off from your computer, check that all pending uploads to your Online History have been
submitted or cancelled. Otherwise, they could be uploaded by another user of the same computer.

For the latest information, see http://www.hp.com/go/eprintandshare.
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12 Job queue management

e Thejob queuein the front panel

e Thejob queue in the Embedded Web Server or HP Utility
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The job queue in the front panel

To see the job queue on the front panel, press on the home screen. You can choose Print & Copy Jobs

or Scan Jobs from the tabs at the top of the screen.

Job queue page

The job queue page shows all jobs that are available in whichever job queue you have selected. The print &
copy queue includes jobs that are being received, parsed, rendered, printed, and already printed. The scan
queue includes jobs that are being scanned and jobs that have been scanned.

Each line shows the name of the job and its status. Scan and copy jobs are assigned automatically-generated
names, but you can change them if you like. For more information on a particular job, including a preview of
the job, press the line showing the job.

Jobs that cannot be completed for any reason appear at the top of the queue.

Job preview

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job
preview is available once the job is processed.

= NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.

To preview a job, first press the name of the job in the job queue. The front panel displays a page of
information about the job, and the print preview.

~7NOTE: Previews may be blocked by an administrator, in which case you will not be able to see them.

When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.

You can also press ] to preview the previous job, or [Jto preview the next job.

Select when to print a job in the queue

@NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Press , then n then
Setup > Job management > When to start printing.

There are three options you can select:

e  When After Processing is selected, the printer waits until the whole page has been processed and then
it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

e  When Immediately is selected, the printer prints the page as it is processed. This is the quickest setting,
but the printer may stop halfway through a print to process data. This setting is not recommended for
complex images with dense color.

e  When Optimized is selected (this is the default setting), the printer calculates the best time to begin
printing the page. It is usually the best compromise between the After Processing and Immediately
settings.

Prioritize ajob in the queue

You can select a job in the queue and make it the next one to be printed. After selecting the job, press Move
to front.
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If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be
printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as
described above.

In the following cases, the Move to front button is not displayed:

e Thejobis already at the front of the queue.

e  Thejobis on hold—in this case the Force print button is displayed instead.
e  Thejob has finished—in this case the Print button is displayed instead.

e  Thejob has some error condition.

Pause a job in the queue

If you select the job in the queue that is currently printing, you will see a Pause button, which you can press
to pause printing. The Pause button then changes to a Force print button, which you can press to resume
printing.

Reprint a job from the queue

To reprint an already-printed job, select the job from the queue, then select Print.

When reprinting a print job, you cannot change the print settings, because the job has already been
rasterized.

Save a scanned job to another destination

From the scan queue, select the job, and save to. There you will be able to save the scanned job to another
destination.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just
fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid
printing it, you can simply select the job and then press Delete.

E‘/,"NOTE: If an administrator password has been set, it will be required.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can press Cancel and then Delete.

Delete all jobs

To delete all jobs in a queue, press the Delete icon at the top right of the job queue screen, and then press
Delete all Print & Copy jobs or Delete all Scan jobs.

E‘/,"NOTE: If an administrator password has been set, it will be required.

Turn off the job queue

To turn off the job queue, press . then - then Setup > Job management > Queue > Off.
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The job queue in the Embedded Web Server or HP Utility

The HP Utility provides a different way of accessing the Embedded Web Server's job management facilities,
but the facilities are exactly the same whether you use the Embedded Web Server or the HP Utility.

To see the queue in the Embedded Web Server, select Job Center from the HP Utility.

Job queue page

By default, access to the job queue is open to all users. An administrator can set a password so that users are
required to enter a password for:

e  Seeing job previews
e  (anceling or deleting jobs

The job queue page shows all jobs that are available in the print queue. The print queue includes jobs that are
being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:

e  Preview: Click the icon to see the job preview. The job preview is available once the job is processed.
e  File name: Click the file name to see the properties of the job.

e  Status: Gives the current job status.

e  Pages: Number of pages in the job.

e  (Copies: Number of copies printed.

e Date: Date and time the printer received the job.

e  User: The user's name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of
the corresponding column. You can perform the following operations on one or all jobs in the queue:

e  Cancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains
stored in the printer, but will not be printed unless you click Reprint.

e  Hold: Holds the select jobs until you click Continue to print.

e  Continue: All selected jobs, which are on hold, continue printing.

e  Reprint: Prints more copies of a job. Type the number of copies (default 1, maximum 99) and click Print.
e  Move to front: Sends all selected jobs to the top of the job queue.

o  Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.

E’/{’NOTE: The Delete operation can be disabled by an administrator.

Refresh: Refreshes the page, ensuring the information is updated.

E‘/f’NOTE: The job queue page does not automatically update.

Job preview

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job
preview is available once the job is processed.
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E‘%"NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.

To reach the preview page, click the magnifying glass icon, which appears in the Preview column on the job
queue page. The preview page shows the following job details along with a thumbnail preview of the job:

° File name: The file name of the job.
e Loaded paper: The type of paper loaded in the printer.
e Job dimensions: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which appears
on the right-hand side of the printer image.

E‘/{’NOTE: Browsers without the Adobe Flash plug-in show the job image as yellow shaded. Browsers that have
the Adobe Flash plug-in version 7 and above show an enhanced preview of the job image inside the paper
loaded in the printer.

Select when to print a job in the queue

E’/{’NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Select the Setup tab, then Printer
settings > Start printing.

There are three options you can select:

e  When After Processing is selected, the printer waits until the whole page has been processed and then
it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

e  When Immediately is selected, the printer prints the page as it is processed. This is the quickest setting,
but the printer may stop halfway through a print to process data. This setting is not recommended for
complex images with dense color.

e  When Optimized is selected (this is the default setting), the printer calculates the best time to begin
printing the page. It is usually the best compromise between the After Processing and Immediately
settings.

Prioritize a job in the queue

You can select any job in the queue and make it the next one to be printed. After selecting the job, click
Reprint.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be
printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as
described above.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just
fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid
printing it, you can simply select the job and then select Delete.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can select Cancel and then Delete.

Reprint or copy a job in the queue

To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server and click
the Reprint icon, then specify the number of copies you want. The job will be moved to the top of the queue.
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To make more than one print of a non-printed job in the queue from the front panel, select the job and
choose Copies, then specify the number of copies required. This overrides any value set by your software.

=7 NOTE: If Rotate was On when you sent the file, every copy will be rotated.

@'NOTE: You cannot use this method for PCL3GUI jobs. To reprint old jobs that are PCL3GUI, you may be able
to use your operating system's printer spooler, if you have already set the spooler to save old jobs. This
facility depends on your operating system.

=2 NOTE: When reprinting a print job, you cannot change the print settings, because the job has already been
rasterized.

Job status messages
These are the possible job status messages, approximately in the order in which they may be seen:
e  Receiving: The printer is receiving the job from the computer

e  Waiting to process: The job has been received by the printer and is waiting to be rendered (for jobs
submitted through the Embedded Web Server only)

e  Processing: The printer is parsing and rendering the job
e  Preparing to print: The printer is performing writing system checks before printing the job
e  Waiting to print: The job is waiting for the print engine to become free to proceed with printing

e  Waiting for nest: The printer is set up with Nesting=0n and is waiting for other jobs in order to
complete the nest and proceed with printing

e  Onhold: The job was sent with the on hold for preview option and is on hold

E‘/f’NOTE: Do not send a job for preview with more than 64 pages, this may cause the driver software to
crash.

E”%’NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially
printed job will appear in the queue as on hold when the printer is next turned on. When you resume the
job, it will start printing at the page at which it was interrupted.

e  Onhold for paper: The job can't be printed because the right paper is not loaded in the printer. Load the
required paper, see Paper handling on page 50, and click Continue to resume the job

e  Onhold for accounting: The job can't be printed because the printer requires all jobs to have an account
ID: enter the account ID and then click Continue to resume the job

-‘SI?'- TIP: TosetanaccountID, see Require account ID on page 33.

On hold for stacker: The stacker is open, jammed, or full

e  On hold for manual mode: You must go to the front panel to activate manual mode
e  Printing

e  Drying

e  (Cutting paper

e Ejecting page

e (Canceling: Thejob is being canceled, but will remain in the printer job queue

e Deleting: The job is being deleted from the printer
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e  Printed
e  Canceled: The job has been canceled by the printer
e  (Canceled by user

e  Empty job: The job does not contain anything to print

Reactivate a job on hold

When the printer puts a job on hold you receive an alert, see Alerts on page 234, which explains why the job
is on hold. Follow the instructions on the screen to remove the hold and continue printing.

Turn off the job queue

To turn off the job queue, select the Setup tab, then Printer settings > Job management > Queue and select
Off.
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13 Color management

° Introduction

° How colors are represented

L A summary of the color management process

e  (Color calibration

° Color management from printer drivers

e  Color management from printer drivers (PostScript printers)

° Color management from the Embedded Web Server

e  (Color management from the front panel

° Color management and the scanner
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Introduction

Your printer has been engineered with advanced hardware and software features to ensure predictable and
dependable results.

e  (olor calibration for consistent colors.
e  Onegray and two black inks provide neutral grays on all paper types.
e  The Photo Black ink provides pure blacks when printing on photo papers.

e  Color emulation of other HP Designjet printers.

How colors are represented

All devices that display color use a color model to represent color in numerical terms. Most monitors use the
RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-Yellow-blacK) color
model.

An image can be converted from one color model to another, but in general the conversion is not perfect.
Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors
a little differently from another device, even if they use the same color model. However, software can adjust
the colors in an image according to the characteristics of the particular device, using a color profile of the
device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper type
that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then
(see Color calibration on page 111). In addition, you may wish to calibrate immediately before a
particularly important print job for which color consistency is vital.

2. When printing, select the correct color preset for the paper type you are using.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printhead, inks, and
paper type that you are using, and under your particular environmental conditions. After color calibration,
you can expect to get similar prints from any two different printers situated in different geographical
locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the
following circumstances:

e  Whenever the printhead is replaced
e  Whenever a new paper type is introduced that has not yet been calibrated with the current printhead
e  Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper from the front panel at any time:
press [g2Fay, then n then Image quality maintenance > Calibration status. The status may be one of
the following:

e Recommended: the paper has not been calibrated.
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E”%NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is reset
to Recommended.

e  Obsolete: the paper has been calibrated, but the calibration is now out of date because the printhead
has been replaced, and should be repeated.

e Done: the paper has been calibrated, and the calibration is up to date.

e Disabled: this paper cannot be calibrated.

|‘__“:"’/'°NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can also check the color calibration status by using the HP Utility.
You can start color calibration in the following ways:

e  From the HP Designjet Utility for Windows: select Color Center > Calibrate paper, and choose the paper
to be calibrated. If the Color Center is not available, try using the Print Quality Toolbox in the Support
tab.

e  From the HP Utility for Mac 0S X: select Paper Preset Management from the HP Color Center group,
choose the paper to be calibrated, press the [¢ ]| button and select Calibrate Paper.

®  From the front panel: press . then - then Image quality maintenance > Calibrate color.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of
the type you wish to calibrate—which should be A4 or any larger size. If you have more than one roll loaded,
the printer will ask which roll you want to use for the calibration.

The process takes about 3—-5 minutes and consists of the following steps.

1. Acalibration chart is printed, which contains patches of each ink used in your printer.
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2. Thechartis allowed to dry for a period of time that depends on the paper type, so that the colors have
time to stabilize.

3. Thechartis scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent
color printing on that paper type. It also calculates the maximum amount of each ink that can be applied
to the paper.

Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when
you print an image, you see very similar colors as when you view the same image on your monitor.
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There are two basic approaches to color management for your printer:

e Application-Managed Colors: in this case your application program must convert the colors of your
image to the color space of your printer and paper type, using the ICC profile embedded in the image
and the ICC profile of your printer and paper type.

e Printer-Managed Colors: in this case your application program sends your image to the printer without
any color conversion, and the printer converts the colors to its own color space. The details of this
process depend on the graphics language that you are using.

° PostScript (PostScript printers): the PostScript interpreter module performs the color conversion
using the profiles stored in the printer and any additional profiles sent with the PostScript job. This
kind of color management is done when you are using the PostScript driver and you specify printer
color management or when you send a PostScript, PDF, TIFF or JPEG file directly to the printer
through the Embedded Web Server. In either case you have to select the profiles to use as default
(in case the job doesn't specify any) and the rendering intent to apply.

> Non-PostScript (PCL3GUI, HP-GL/2): the color management is done using a set of stored color
tables. ICC profiles are not used. This method is somewhat less versatile than the alternatives, but
is a little simpler and faster, and can produce good results with standard HP paper types. This kind
of color management is done when you are using a non-PostScript driver and you specify printer
color management, or when you send a PCL3GUI or HP-GL/2 file directly to the printer through the
Embedded Web Server.

i_%"yNOTE: There are only two color spaces that the printer can convert to its own color space using
the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB and ColorSync
if you are using Mac 0S X.

ColorSync is the Mac 0S X built-in Color Management System; so, when you select ColorSync, color
management is performed by Mac 0S X, and it is done based on the ICC profiles of the specified

paper type.

ColorSync can be selected from the Color Matching panel.

You are recommended to consult the HP Support Center (see HP Support Center on page 240) to see how to
use the color management options of your particular application.

To choose between Application-Managed Colors and Printer-Managed Colors:
e Inthe Windows driver dialog: select the Color tab.
e Inthe Mac 0S X Print dialog: select the Color Options panel.

e Insome applications: you can make this choice in the application.

Printer emulation

If you want to print a particular job and to see approximately the same colors that you would get from
printing the same job on a different HP Designjet printer, you can use the emulation mode provided by your
printer.

E‘%"NOTE: This option is available only when printing an HP-GL/2, PostScript or PDF job. Accuracy is guaranteed
only when printing on plain, coated, or heavyweight coated paper.

e  Inthe Windows HP-GL/2 or PostScript driver dialog: select the Color tab, then Printer Managed
Colors, then select Printer Emulation from the Source Profile list. You can then select from the
Emulated Printer list.
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e Inthe Mac 0S X Print dialog: select the Color Options panel, then select from the Printer Emulation list.

Color adjustment options

The aim of color management is to print accurate colors. If you perform color management correctly, then
you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:
e If your color management is not working correctly for some reason
e If youwant colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color or in
grayscale. If you are printing in pure black and white, there are no color adjustment options.

Printing in color
You can adjust the colors of your print as follows.

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color adjustments box is
checked, then press the Settings button beside it.

You can then make adjustments using a lightness slider and three color sliders.
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% HP Designjet T2500 HPGL2 Printing Preferences B l
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e  The lightness slider simply makes the whole print lighter or darker.

e The color sliders can be used to fade or emphasize each of the primary colors in the print. The primary
colors may be red, green and blue; or cyan, magenta and yellow; depending on the color model used in

the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can convert all colors in your image to shades of gray in the following ways:
e Inyour application program: many programs provide this option.

e  Inthe Windows driver dialog: go to the Color tab and look at the Color Options section. Select Print in
Grayscale. You can also select Print in pure black and white if you want only black and white, without

gray shades.

e Inthe Mac 0S X Print dialog: go to the Color Options panel and select Grayscale from the Mode drop-
down list. You can also select Pure Black and White if you want only black and white, without gray
shades.

e  Onthe Embedded Web Server's Submit Job page: select Color, then set Color/Grayscale to Print In
Grayscale. You can also select Pure Black and White if you want only black and white, without gray
shades.

You can adjust the gray balance of your print under Windows:

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color adjustments box is
checked, then press the Settings button beside it.

You will then be able to make adjustments using separate controls for highlights, midtones and shadows.
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Advanced Lightness and Gray Balance Adjustments

Lightness Preview
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Apply midtone adjustments to all

Reset Cancel

e  The lightness slider simply makes the whole print lighter or darker. This slider is available in the same
window as the other grayscale controls.

e  The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

e  The other controls for highlight, midtone and shadow can be used to adjust the gray balance of
highlights, midtones and shadows respectively.

The Reset button restores each control to its default setting.

:{'?'_ TIP: To emulate grayscale printing from older Designjet printers, you can convert the file to be printed to
* grayscale using an image editing program, and then use Print in Color and the appropriate emulation in the
driver.

Color management from printer drivers (PostScript printers)

This facility is available when printing with the PostScript driver.

HP Professional PANTONE Emulation

When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK
or RGB approximation to that color. But the application does not take the printer or the paper type into
account, it merely produces a generic approximation of the PANTONE color, which will look different on
different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of
the printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a
given printer using a given paper type. This technology is designed to produce emulations similar to those set
up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by
default.

e Inthe Windows PostScript driver dialog: go to the Color tab and select HP Professional PANTONE
Emulation.

e Inthe Mac 0S X PostScript Print dialog: go to the Color Options panel and select HP Professional
PANTONE Emulation.
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Color emulation

Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and CMYK
devices such as presses and printers.

You can set color emulation in the following ways:
e  Inthe Windows PostScript driver dialog: select the Color tab, and Printer Managed Colors.

e Inthe Mac 0S X Print dialog: select the Color Options panel, then select Printer Emulation from the
Color Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The
standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the
most common standards for the different devices.

The options are as follows.

CMYK color emulation

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to the
printer, because different printers will produce different colors from the same CMYK data. If the image file
you are printing was not created specifically for your printer, it will require some readjustment, which can be
done using one of the following options provided with your printer.

e None (Native): no emulation. The printer will use its default internal conversion from CMYK to RGB,
without following any color standard. This does not imply that results will be bad

e IS0 Coated 2-ECl is based on the characterization dataset FOGRA39L.txt, applicable to the following
reference printing conditions according to the international standard ISO 12647-2:2004/Amd 1:
commercial and specialty offset, paper type 1 and 2, gloss or matt coated paper, positive plates, tone
value increase curves A (CMY) and B (K), white backing.

e Coated GRACoL 2006-15012647 provides GRACoL proofing and printing on Grade 1 coated paper, ISO
12647-2 Paper type 1.

e  PSO0 Uncoated 1S012647-ECl is based on the characterization data set FOGRA47L.txt, applicable to the
following reference printing condition according to the international standards ISO 12647- 2:2004 and
IS0 12647-2:2004/Amd 1:2007: commercial and specialty offset, paper type 4, uncoated white paper,
positive plates, tone value increase curves C (CMY) and D (K), white backing.

e  PSOLWCImproved-EClis based on the characterization data set FOGRA45L.txt, applicable to the
following reference printing condition according to the international standards 1SO 12647-2:2004 and
ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, improved LWC paper (light weight
coating), positive plates, tone value increase curves B (CMY) and C (K), white backing.

e Web Coated SWOP 2006 Grade 3 provides SWOP® proofing and printing on U.S. Grade 3 coated
publication paper.

e Web Coated SWOP 2006 Grade 5 provides SWOP® proofing and printing on U.S. Grade 5 coated
publication paper.

e U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 350% total area of ink coverage, negative plate, bright white
offset stock.

e U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white
offset stock.

e U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 300% total area of ink coverage, negative plate, coated
publication-grade stock.
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U.S. Web Uncoated 2 uses specifications designed to produce quality separations using U.S. inks under
the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white
offset stock.

Euroscale Uncoated 2 uses specifications designed to produce quality separations using Euroscale inks
under the following printing conditions: 260% total area of ink coverage, positive plate, uncoated white
offset stock.

Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher Association for
digital proofing of images in the Japanese magazine/advertising market.

Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper. Itis
designed to produce quality separations using 350% total ink coverage, positive film and coated paper.

Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated) paper. It is
designed to produce quality separations using 310% total ink coverage, positive film and uncoated

paper.

Japan Color 2002 Newspaper uses the Japan Color 2002 for Newspapers specification. It is designed to
produce quality separations using 240% total ink coverage, positive film and standard newsprint paper.

Japan Color 2003 WebCoated is for type 3 coated paper. It is designed to produce quality separations
for standard 1SO printing using 320% total ink coverage, positive film, and coated paper on heat-set
web offset presses.

JMPA: Japanese standard for offset press.
Toyo is designed to produce quality separations for Toyo printing presses.

DIC is designed to produce quality separations for Dainippon Ink Company printing presses.

=¥ NOTE: These options have no effect if the application is defining its own CMYK space, known as calibrated
CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation

Your printer is provided with the following color profiles:

None (Native): no emulation, for use when the color conversion is done by the application or operating
system, and therefore the data arrive at the printer already color-managed.

sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard space is
endorsed by many hardware and software manufacturers, and is becoming the default color space for
many scanners, printers and software applications.

ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space provides a
smaller gamut alternative to Adobe RGB (1998) for print production work.

Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety of
desktop publishing applications. Use this space for files that you plan to display on Apple monitors, or
for working with old desktop publishing files.

Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print
production work with a broad range of colors.

Color management from the Embedded Web Server

Submit Job options

When you send jobs to the printer using the Embedded Web Server's Submit Job page, you have the
following color management options.
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If you leave an option set to Default, the setting saved in the job will be used. If the job contains no setting,
the front-panel setting in the printer will be used.

e  Color/Grayscale: you can choose to print in color, in shades of gray, or in pure black and white.

e Default RGB source profile: you can choose from a selection of RGB source profiles recognized by the
printer.

e  Printer emulation: you can choose to emulate a different HP Designjet printer. Default: Off (no printer
emulation).

T2500 PS options (with PostScript or PDF jobs)

e  Default CMYK source profile: you can choose from a selection of CMYK source profiles recognized by
the printer. Default: US Coated SWOP v2.

e Rendering intent: you can select the rendering intent.
e  Black point compensation: you can turn black point compensation on or off.

e  HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation on or off.

Rendering intent

Rendering intent is one of the settings used when doing a color transformation. As you probably know, some
of the colors you want to print may not be reproducible by the printer. The rendering intent allows you to
select one of four different ways of handling these so-called out-of-gamut colors.

e  Saturation (graphics): best used for presentation graphics, charts or images made up of bright,
saturated colors.

e Perceptual (images): best used for photographs or images in which colors blend together. It tries to
preserve the overall color appearance.

e Relative colorimetric (proofing): best used when you want to match a particular color. This method is
mainly used for proofing. It guarantees that, if a color can be printed accurately, it will be printed
accurately. The other methods will probably provide a more pleasing range of colors but do not
guarantee that any particular color will be printed accurately. It maps the white of the input space to the
white of the paper on which you are printing.

e  Absolute colorimetric (proofing): the same as relative colorimetric, but without mapping the white.
This rendering is also used mainly for proofing, where the goal is to simulate the output of one printer
(including its white point).

Perform black point compensation

The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the source
space is mapped into the full dynamic range of the destination space. It can be very useful in preserving
shadows when the black point of the source space is darker than that of the destination space. This option is
allowed only when the Relative colorimetric rendering intent is selected (see Rendering intent on page 119).

Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by pressing , then n then
Image quality maintenance > Calibrate color. See Color calibration on page 111.

The other color options in the front panel can all be found by pressing , then n, then Setup >
Printing preferences > Color options.
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@’NOTE: These front panel settings can all be overridden by the printer driver or Embedded Web Server job
submission settings.

e  Color/Grayscale: you can choose to print in color, in shades of gray, or in black and white. Default: Print
in color.

e Select RGB source profile: you can choose from a selection of RGB source profiles recognized by the
printer. Default: SRGB.

e  Emulate printer: you can choose to emulate a different HP Designjet printer. Default: Off (no printer
emulation).

-‘SI?'- TIP: If you have old HP-GL/2 or PostScript files made for a different HP Designjet printer, you can send
* them to the printer and use the front panel to turn on the appropriate emulation mode.

T2500 PS options (with PostScript or PDF jobs)

e  Select CMYK source profile: you can choose from a selection of CMYK source profiles recognized by the
printer. Default: US Coated SWOP v2.

e Selectrendering intent: you can select the rendering intent. Default: Perceptual.
e  Black point compensation: you can turn black point compensation on or off. Default: On.

e  HP Professional PANTONE Emulation: you can turn HP Professional PANTONE Emulation on or off.
Default: On.

Color management and the scanner

The files obtained from your scanner (TIFF, JPEG, PDF) contain an embedded ICC profile corresponding to the
type of paper selected prior to making the scan. When you load these files into any image reader software
application, the information of the ICC profile is automatically used for optimum color appearance on your
monitor. When you print a scanned image, or copy an original, the embedded ICC profile is also automatically
used by the printer for optimum printing results.
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Practical printing examples

For printing examples using HP Designjet ePrint & Share, see http://www.hp.com/go/eprintandshare.

Print from Adobe Acrobat

Print from Autodesk AutoCAD

Print from Adobe Photoshop

Print and scale from Microsoft Office
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Print from Adobe Acrobat

1.  Inthe Acrobat window, move the mouse cursor to the bottom left corner of the document pane until the

document size appears there.

) T2500 UG.pdf - Adobe Acrobat Pro

=

= [ |

File Edit View Window Help

x

5

@Createv |@D %‘@@@'}@@)
:'i‘:li‘uofzsg)‘.@ ‘ (= _

Tools

Comment

Share

)
P = &
I introduction =
L/% [P Installing the software

i : :

Iéﬂ Setting up the printer

[P Network configuration =

g Personalizing the printer

g Printing
g Scanning
7 Copying
[P Web-connected printing

User’s Guide

[P Job queue management
[P color management
[P Practical printing examples

g Retrieving printer usage
information

=1

g Paper handling
[P Working with two rolls L @ Designjet T2500 eMultifunction Series

2. Select File > Print and ensure that Page Scaling is set to None.

[print A s

Printer

Mame: | HP Designjet T1500 PS HPGL2 v] [ Properties ]

Status: Ready Comments and Forms:

Type:  HP Designjet T1500 PS HPGL2 [Documantand Markups v]
Print Range Preview: Compasite

@ al PRS- ; S—"
(©) Current view .

() Current page

()Pages 1-210

subset: | Al pagesinrange =

[T reverse pages
Page Handing

Copies: 1 B Collate 1169
[E—
[] Auto-Rotate and Center

Use custom paper size when needed -
ke

Document: 8,3 x 11,7in

[Elprint to fie Paper: 8,3 11,7n
[ Print color as black 122
[Printing Tips | | Advanced | | summarize Comments | [ ok [ concel |

r__f”%NOTE: The page size will not be automatically selected according to the document size.
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3. Press the Properties button and then select the Paper/Quality tab.

i HP Designjet T2500 HPGL2 Printing Preferences ]

Paper/Qualty | Layout/Output | Color | Sewvices [ Advanced
Quick sets:

[Factory defauits - Save Delete

Paper Options

Document size: 8.50 x 11.00 inches

Letter -

[ Margnsiayout... || Custom...

Printed on: 8.50 x 11.00 inche
# | currently loaded paper: e an: 8. 30X nenes

Roll 1: HP Uy | Instant-dry Gl Photo P; ,
00 b o iy s Fheta Paper [Elshow preview before printing

Roll 2: Plain paper, 24.00 inches
Single sheet: Not loaded Print Quality

@ Standard options

b,

Paper source:

Speed Quality
Use printer settings -
(©) Custom options Settings...
Paper type:
Use printer settings - Rendering resolution (ppi): 600
Printing resolution (dpi): Automatic

@

4. Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom
paper size, press the Custom button.

r = ) B
Custom size N—— é

Units
© fnches

() Milimeters
size
Width: 8.50 (3.00 - 36.25)

Length: 11.00 (5.51- 3582.68)

Name

Custom

5. Select the Layout/Output tab, and then Autorotate.

i HP Designjet T2500 HPGL2 Printing Preferences ]

Paper/Qualty | Layou/Output | Color | Sevices [ Advanced

Quick sets:

[Factory defauits - Save Delete

Resizing Options
@ Actual size
© Fitto:

Letter

(@ % of actual size:

Printed on: 8,50 x 1100 inches
100 < »

[ show preview before printing
Orientation Roll Options

@ Portrait @ Olandscage [ A [ pisable automatic cutter

["|Remoye blank areas

Crop lines
Qutput Options Dgron
Copies [“]remove margins between pages
= [ Rotate by 90 degrees
T B Collate
[V] Agtorotate

Page Order: First page on top - From printer

[ Hold for manual printing with stacker open Account ID:

@D
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6. Click OK, and check that the print preview in the Print dialog box seems correct.

Printer
Mame: | HP Designjet T1500 PS HPGLZ - [ properties |
Status:  Ready Comments and Forms:
Type:  HP Designjet T1500 PS HPGLZ [ocument and Markups. -]
Print Range Preview: Composite
@ al 87—
(©) Current view =
(©) Current page
(Cpages 1-210
Subset: |All pages in range =
[l Reverse pages () oo insoa s
Page Handing b
= e
Copies: 1 B [@cost 1169 |
|
Fage scing:
Auto-Rotate and Center
Choose paper source by PDF page size
[[Juse custom paper size when needed L -
Document: 8,3 x 11,7in
.
[Elprint to fle Paper: 8,3 11,7n
[CIPrint color as bladk 222
[printing Tps | | Agvanced | [ summarize Comments | Eook ] [ cancel |

Print from Autodesk AutoCAD

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

Enter new value for TILEMODE <1»: O Regenerating layout.
Command: CVDRAWING

Command :

2.  Click the Plot icon at the top of the window.

Y= Sl

Plot... (Ctri+P)
Prints a drawing to a plotter, printer, or file

[ PLOT

[?] Press F1 for more help
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3. ThePlot window opens. You can see further options by pressing the circular button in the lower right
corner of the window.

rigplot - Model i x|
(i) Learn about Plotting
- Page setup
Mame: [<iome | Add...
[~ Printer fplotter
Mame: [ HP Designiet T320 HPGLZ =] Properties... |
Flotter: HP Designjst T920 HPGLZ - Optimized driver - by HF
wehere:
Description:
I Plot ka file
Paper size Number of copies
- 1 -
Carta (portrait) =
Plot area Flot scale
wihat ko plot: [V Fit to paper
Dkplay Il scale: [Custom 2
[ Plot offset {origin set to printable area) ——— 1 mm ==
w |11.55 mm I™ Center the plat I—ZZ'” it
yi | -13.65 mm [T scale lineweights

Prevlewml Apply to Layout | oK | Cancel | Help |®

4. Press the Properties button.

X

(i) Learn about Plotting

- Page setup i~ Plat style table (pen assignments) — |
Mame: [<ione > = add... hane =
i~ Printer fplotter -Shaded viewport options —————————— |
Heriie: [ HP Designiet T320 HPGLZ =] Fropertiss. . Shadeplot | ns displayes B
Flotter:  HP Designjet T920 HPGL2 - Optimized driver - by HP Quaity Hormal -
wihere: o =
Description:
I~ Plat options
I Piot b fils I~ Plat in background
[¥ Plot abject lineweights
Paper size Mumber of copies
5 ™ Flak transparency
Cart. trait; - ! =
[carta parurary H I = I¥ Plat with plat styles
~Plot area Flot scale ¥ [Plot pperspace est
Wihat bo plat: I P et I= ' Hide paperspace objects

™ 5ave changes ba layout

[~ Plot offset origin set to printable area) | ! mm b ~Drawing orientation—————————————
w1155 i I” Center the plok I—ZZ T units & Portrait

yr | 1365 mm ™ Scale lineweights

™ Plat upside-down

Preview,.. Apply to Layout | ok | cancel | Help |©

: - I Plat stamp on
Display al Scale: [Custam &

5. Select the Device and Document Settings tab, and press the Custom Properties button.

Plotter Configurati jet x|

Eene.a\| Parts  Dievice and Documant Setlings

© HP Designiet 1320 HPGL2
Es7 Media
Source and Size <Size: Carta [portait]>
Media Destination <Default>
Graphics
2 Custom Properties
=l [.é% User-defined Paper Sizes & Calibration
Custom Paper Sizes
Moty Standard Paper Sizes [Printable Area]
Filter Paper Sizes
-2 Plotter Calibration
{2 PMP Fils Name <None>

[~ Access Custom Dialog

=)

Press the following button to access the
device diiver-specific userinterface,

Custom Propeties

Impar.. Savess. | Defauts |

ok | Cancel | Helo |
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In the Paper/Quality tab, select the paper type that you intend to use, and the print quality (your own
choice between high speed and high quality).

= HP Designjet T2500 HPGL2 Printing Preferences

S

Paper/Qualty | Layout/Output | Color | Services | Advanced
Quick sets:

[Factory defauits - Save Delete

Paper Options

Document size: 8,50 % 11.00 inches

Letter

[ Margnstayout... || Custom...

Printed on: 8.50 x 11.00 inch
& | currently loaded paper: rinted on: x inches

Roll 1: HP Universal Instant-dry Gloss Photo Paper,
36.00 inches

Roll 2: Plain paper, 24,00 inches

Single sheet: Not loaded

[] show preview before printing
Print Quality

@ Standard options

@

Paper source:

Speed Quality
Use printer settings -
) Custom options Settings...
Paper type:
Use printer settings - Rendering resolution (ppi): 600
Printing resolution (dpi): Automatic

@

I

Press the Margins/Layout button for additional layout options.

-
Layout and Margins Options 0

@%}
Layout Mode

Preview
@ Brint with margins
- Application view:
Layout Options
@) Standard
() Oversige

(©) Clip contents by margins

(©) Borderless
Image Enlargement Print preview:
@ Automatically by printer

Manually in application

Usage

This is the way desktop printers work. You wil get a paper of size equal to that
of the paper you have selected in the driver.

|
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8. Ifyouintend to print on roll paper, you must decide where the printer should cut the paper. In the
Layout/Output tab, check or uncheck the Disable automatic cutter option, and check the Autorotate
option, which can help to avoid wasting paper.

= HP Designjet T2500 HPGL2 Printing Preferences ]

Paper/Qualty | Layout/Output | Color | Services | Advanced

Quick sets:

[Factory defauits - Save Delete

Resizing Options
@ Actual size
© Fitto:

Letter

(@ % of actual size:

100

Printed on: 8,50 x 1100 inches

[ show preview before printing
Orientation Roll Options

@ Portrait @ Olandscage [ A [ pisable automatic cutter

["|Remoye blank areas

Crop lines
Output Options Clgree
Copies [ remove margins between pages
- 3] [ rotate by 50 degrees
1B Collate B
[V] Agtorotate
Page Order: First page on top = From printer
[ Hold for manual printing with stacker open Account ID:
@

9. Press the OK button and save your configuration changes to a PC3 file.

B Changes to a Printer Confiquration File [

Youhave made changes to 3 PC3 Printer Configuration File.

Apply changes for the current plat only.

@) Save changes to the following fle:

0K | Cancel Help

Using printer emulation

Printer emulation can be requested by selecting Advanced settings > Color > Color management > Printer
Managed Colors > Printer emulation.

You can select Off (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

Using clip contents by margins

You can select this margins option from Advanced settings > Paper/Quality > Margins/Layout > Print with
margins > Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you

have selected. The printer will use the white border for its margins and you will get a page of size equal to
that which is selected in the driver.

Print from Adobe Photoshop

1. InPhotoshop (S5, select File > Print, then select your printer and press Print Settings.
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Print

il 59,37 cm x 84,1 cm

[IMatch Print Colors
[ Gamut Warning
[]5how Paper White

Printer:  1p Designjet T1500 PS HP...

[~ Color Management v
@ Document

(Profie: U.S. Web Costed (SWOP) v2)

i

Print Resclution: 187 PRI

m}
@

Copies: 1 () Proot
iy
Print Settings...
g5 Coier Hapding:
— Position
Printer M: Color hd
(7] Cartr g rinter Manages Colors
Remember to ensble the printer's color
ploes D ! management in the print settings dislog bax,
Left: Printer Profile:
 ceaied Print Se [ acobe ree (1558 -
] Rendering Intent:
el e
Relstive Colormetric -

[[]Black Point Compensation

Procf Setup:

[working crv -

[] Simulate Paper Color

[#] Bounding Box [/] Simulate Black Ink
Units: o -
] [ pore | [ Print

Choose from the available document sizes.

HP Designjet T2500 HPGL2 Printing Preferences

Paper/Qualty | Layout/Output | Color_|[ Senvices [ Advanced |

Ouick sets:

[Factory defauits

Delete

Paper Options

Document size: 8,50 % 1100 inches

Letter

Tabloid

a4

A3

54 (J15)
83 (JIS)
Super B/A3
Arch €
More...

Papgr source:

Use printer settings -
Paper type:
Use printer settings -

@

Printed on: 8.50 x 11.00 inches

Print Quality

@ Standard options

07

Speed Quality

) Custom options | setings... |
Rendering resclution (ppi): &00
Printing resalution {dni): Automatic

[ox J[ concel ][ oy |

If you do not find the size that you intend to use, press the Custom button. Enter the width, the length,
and the name of your custom size. Press the Save and OK buttons.

-
Custom size ‘-@__M

Units
Size
with: 8.50 eTaa)
Length: 11.00 (5.51-3582.68)
Mame
Custom
swe | [ ok | [ cance
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3. You may wish to change the default paper source, paper type, and print quality.

(=
= HP Designjet T2500 HPGL2 Printing Preferences

=)

Paper/Qualty | Layout/Output | Color | Sewvices [ Advanced
Quick sets:

[Factory defauits

- save Delete
Paper Options

Document size: 8.50 x 11.00 inches
Letter

[ Margnsiayout... ||

# | currently loaded paper:

Roll 1: HP Universal Instant-dry Gloss Photo Paper,
36,00 inches

[ show preview before printing
Roll 2: Plain paper, 24.00 inches
Single sheet: Not loaded

Custom...

Printed on: 8,50 x 1100 inches

Print Quality
@ Standard options

b,

Speed Quality
Use printer settings

Paper source:

(©) Custom options Settings...
Paper type:

Use printer setings - Rendering resolution (pp): 500

Printing resolution (dpi): Automatic

@

L

4.

In the Color tab, the default color management option is Printer managed colors, and this is the correct
option because you have already selected Printer Manages Colors in Photoshop.

=
= HP Designjet T2500 HPGL2 Printing Preferences '

[

Paper/Qualty | Layout/Output | Color | Services | Advanced
Quick sets:

[Factory defauits

- save Delete
Color Options

@ Printin color
(0 Print in grayscale

) Print in pure black and white

Color management:

) Application managed colors

Printed on: 8.50 x 11.00 inches
@) Printer managed colors

Source profie:

[ Show preview before printing
SRGE

[7] Advanced color adjustments

@

Settings...

Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office 2010.
Using PowerPoint

1. Select the File tab, then Print, and select the name of your printer.
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ST — T Prmentstionl - Mivrasal PowerPaint e— -

Hame Traeet Desbgn Tranidicn: Animaticn. Slide Showe Review Viewr Acrchial
i save
Print
B save s b
= Copies: |1 =
G Open Print
L Close
o Printer
HP Diesignjet T1500 PS HPGL2 !
Recent Fesdy
Mew
Settings
Print ente presentation
: — int entife presentatio
Slides:
Help Fidl Page Slides o
et — Print 1 shd i
Friee r & per page
B opens gy el ol

123 123 123

Exit
£ - 3

Edit Hrader & Froter

i1 lefld 5% (S

2. Select Printer Properties > Layout/Output > Fit to to scale the document to a particular size.

o P—
0 HP Designjet T2500 HPGL2 Printing Preferences (=l
Paper/Quaity | Layout/Output | Color_[ Services [ Advanced
Quick sets:
[Factory defaults x| [sae) [ Deete

Resizing Options

@) Actual size

Paper size: 8,50 x 11.00 inches
E Printed on: 8.50 x 11.00 inches
Legal
Arch A

Orie Arch B Roll Cptions
Arch C

Disable automatic cutter

Remoye blank areas

Out Arch E3 Crop lines
copd Remove margins between pages
1l :; Rotate by 90 degrees
Al Autorotate
A0 R
pag B4 (I50) Roll width: From printer -
83 (150) [romprinter 7
52 (150)
Dellz1 (150) Accounting
54 (115
[ie3 Ensg Account ID:
52 (J15)
81(JIS)
Super B/A3
[ suoer CjAz
Super D/AL

[ok ][ cancel [ feey |
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3.

4.

Select the Paper/Quality tab, then select Paper Source and Paper Type.

-
@ HP Desigrjet T1500 PS HPGL2 Properties — =]

Paper/Qualty | Layout/Output | Color | Services [ Advanced

Quick sets:

[Factory defauits

Delete

Paper Options

Document size: 841.00 x 554.00 mm

Al -

[ Margnsiayout... || Custom...

Printer information not available

Print Quality

@ Standard options

Paper source: speed

Use printer settings -
(©) Custom options

Paper type:

HP Bright White Inkjet Paper

HP Universal Bond Paper
6 HP Coated Paper

Plain paper

Heavyweight Coated paper

-] Currently loaded paper: Printed on: 841.00 x 534.00 mm

Use printer settings - Rendering resolution (ppi): 600
Printing resolution (dpi): Automatic

Quality

Settings...

Photo Gloss Paper
More. ..

Select Margins/Layout, then select Clip contents by margins to keep the size.

-
Layout and Margins Options

=

Layout Mode
@) Print with margins
Layout Options

(@ Standard

() Oversize

@ Clip contents by margins

) Borderiess
Image Enlargement
@ Automatically by printer

Manually in application

|| usage

This is the way desktop printers work. You will get & paper of size equal to that
of the paper you have selected in the driver.

Preview

Application view:

Print preview:

Using Project

ENWwW

1.

Select File > Page Setup > Print.

- — ~
Page Setup - Gantt Chart fTeve =

Bage: Margine | Header | Footer tegend | view
Orientation
© Porgrait
Sesiing
@ Adjustto:  [100 |5 s normal size

©fto: [L Epageswideby [T ekl
Other

Paper Size: [A% =]

First page number:  [Auto

Print Preview... | [ gptions... | [ pint.. | [ ok | [ cance
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2. Select your printer's name, then Close.

r b
Print =
Printer
Name: HP Designjet T1500 PS5 HPGL2 [=]
Status:  Ide
Type: HP Designjet T1500 PS
Where:
Comment:
Print range Copies
@Al MNumber of copies: [1 =
sty goms [ (2] 1o [ 2]
Timescal
meseaE [¥] Manual page breaks
C]
() Dates From: [Tue 13/11/12
To: |Tue 13/11/12 =
[ Print left column of pages only.
L

3. Select Page Setup, and choose the Paper Size you want.

r — ~
Page Setup - Gantt Chart 'EETe 19 [

Page } Margins } Header } Footer Legend } View }
Orientation

© porat Y
Sealing

© Adustto: 100 | 5] % normal size
Ost: [ H =

Other

Paper Size:

Tabloid

c !
PrintPreview,. | | Qptions.. | | Bmtn. ] | Ok ] | Cancel

4. Select Options to go to the printer driver. The default options in the Paper/Quality tab are probably
suitable: Paper source: Use printer settings and Paper Type: Use printer settings.

— N
= HP Designjet T2500 HPGL2 Printing Preferences [
Paper/Qualty | Layout/Output | Color | Senvicss [ Advanced
Quick sets:
Factory defaults - Save Delete
Paper Options
Document size: .50 x 1100 inches
Letter -
[ wergnspayout... [ Custom...
Printed on: 8.50 x 11.00 inchs
% | currently loaded paper: rinted on * inches
Rall 1 HP Uni | Instant-dry Gl Photo P: .
.00 chan. o netant-ary Gloss Prioto Paper ] Show preview before printing
Roll 2: Plain paper, 24.00 inches
Single sheet: Not loaded Print Quality
@ Standard options
Paper source: sped Quaity
Use printer settings -
(©) Custom options Settings...
Paper type:
Use printer setings . Rendering resolution (ppi): 600
Printing resolution (dpi): Automatic
U]
(-
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Using Excel

1.

ENWwW

Select Layout/OQutput > Fit to to scale the document to a particular size. Alternatively, you can scale

the document in Project.

(%1 HP Designjet T2500 HPGL2 Printing Preferences

Paper/Qualty | Layout/Output | Color | Services [ Advanced

Quick sets:

[Factory defauits

Resizing Options

(@) Actual size

@ Fitto:

Letter -

@ Tabloid
O

D
E
Legal
Arch A

Orighrch 8
ArchC

& 1ArchD IE|

© renz
archEl
ArchE2

outArchE3
a4

[

pagB4 (IS0)
B3 (150)

B2 {ISC)
Delig’ (150)
84 (JIS)
[[B3 (115)
B2 (JIS)

B1(JI5)
@ Super B/A3
[5uper Cja2

Super DfA1

Paper size: 8,50 x 11,00 inches
Printed on: 8,50 x 11,00 inches

Roll Options
[FDisable automatic cutter
[C]remoye blank areas
[Flgrop lines
[C]remove margins between pages
[ rotate by 20 degrees
[ Autorotate

Foll width: From printer

Accounting

Account ID:

L)

] [ cancel ] [ ooy

)

Select the Page Layout tab, then Size, and choose the paper size you want.

Hame  Trseit

Page Lagoal  Formukas
—

I e
— . Print

oo =

Copies: |1 =
= o

e Print

L Close

o Printer

HP Designjet LS00 P5 HPGLY
Recent W
Mew

Settings

Prirt Active Sheets

Save & Send
Help
Collated
i .~
7 aading -
5] optians | Portrait Qrientation
E3 et P

MemxMTem

Hosmal Margins

Left 176 cm . Righ

[TIC] Me Scaling

sheets o their actual size

Arrabat

41 ofl

o=

Print and scale from Microsoft Office 133



2.  Select the File tab, then Print, and select the name of your printer.

Page

Ecoton - s [_
2 P ’ .
& Fores - | l=h fL1
5 Marging Onentation  Site  Pint [
- - area=

Trseit

pout | Foemulay Data

Page Tatup

C |

b5 Background Prnt
i

Nevieve

Seale tu Fil

£1] Helgnt: Automatic = | |
& sele 100%

widin: Automatic + Gridines  Headngi

7 view

1 Mird

2 B RAQ

Bing Send  Seledtion Algn
Forwnrd = Backward = Pane

Sirange

3. Select Printer Properties to go to the printer driver. In the Paper/Quality tab, select Paper source,

Paper Type and Print Quality.

=
=0 HP Designjet T2500 HPGL2 Printing Preferences

S

Paper/Qualty | Layout/Output | Color | Services | Advanced

Quick sets:

[Factory defauits

Delete

Paper Options

Document size: 8.50 x 11,00 inches
Letter -
[ Margnstayout... || Custom...

# | currently loaded paper:

Roll 1: HP Universal Instant-dry Gloss Photo Paper,
36.00 inches

Roll 2: Plain paper, 24,00 inches

Single sheet: Not loaded

Paper source:

Use printer settings -
Paper type:

Use printer settings -

@

Printed on: 8.50 x 11.00 inches

[] show preview before printing
Print Quality
(@ Standard options

g

Speed
) Custom options

Rendering resolution {ppi):
Printing resolution {dpi):

Quality

Settings...

600

Automatic

Apply
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4.

Select Layout/OQutput > Fit to to scale the document to a particular size. Alternatively, you can scale

the document in Excel.

(%1 HP Designjet T2500 HPGL2 Printing Preferences

Paper/Qualty | Layout/Output | Color | Services [ Advanced

Quick sets:

[Factory defauits

Resizing Options

©) Actual size

@ Fitto:

Letter

() Tabloid
- c

D
E
Legal
Arch A
CrigArchg
Arch €
@ ArchD
Oz
ArchEl
Arch E2
outArchE3

As
CD[AE

pagB4 (IS0)
83 (50)

B2 {ISC)
Delig’ (150)
84 (JIS)
[[B3 (115)
B2 (JIS)

B1(JI5)
[ Super B/43
[5uper CjA2

Super DfA1

]

Paper size: 8,50 x 11,00 inches
Printed on: 8,50 x 11,00 inches

Roll Options

[FDisable automatic cutter
[C]remoye blank areas
[Flgrop lines
[C]remove margins between pages
[ rotate by 20 degrees
[ Autorotate

Foll width: From printer

Accounting

Account ID:

[ ok [ cencel ][ 2opv
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15 Retrieving printer usage information

° Get printer accounting information

o  Check usage statistics

° Check usage statistics for a job

° Request accounting data by email
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Get printer accounting information

There are various different ways of getting accounting information from your printer.

e View printer usage statistics for the whole lifetime of the printer, see Check usage statistics
on page 137.

e Viewink and paper usage for each of your recent jobs by using the HP Utility, see Check usage statistics
for ajob on page 137. If the HP Utility is not available, see Access the HP Utility on page 45.

e  Request accounting data by email. The printer sends data in XML at regular intervals to a specified email
address; the data may be interpreted and summarized by a third-party application, or displayed as an
Excel spreadsheet. See Request accounting data by email on page 138.

e  Use athird-party application to request printer status, printer usage or job accounting data from the
printer through the Internet. The printer provides data in XML to the application whenever requested.
HP provides a Software Development Kit to facilitate the development of such applications.

Check usage statistics

There are various ways of checking your printer's usage statistics.

r__*:")f’NOTE: The accuracy of the usage statistics is not guaranteed.

From the Embedded Web Server

1.  Access the Embedded Web Server, see Access the Embedded Web Server on page 45.

2. Gotothe Main tab.

3. Select History > Usage.

From the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 45.

2. Inthe HP Designjet Utility for Windows, go to the Admin tab and open the Embedded Web Server. Then
go to the Usage tab in the Embedded Web Server.

In the HP Utility for Mac OS X, select Information > Printer Usage and press the Lookup button.

From the front panel

3. Press Internal prints.
4. Press User information prints.

5. Press Print usage report.

Check usage statistics for a job

There are two ways to check usage statistics for a particular job.

E‘/,"NOTE: The accuracy of the usage statistics is not guaranteed.
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Accounting statistics with the HP Utility

1.

2.

Access the HP Utility, see Access the HP Utility on page 45.

Under Windows, select the Job center and then Accounting, which launches the Embedded Web Server.

Under Mac 0S X, select Job Accounting and click the Look Up button.

Accounting statistics with the Embedded Web Server

1.

2.

3.

Access the Embedded Web Server, see Access the Embedded Web Server on page 45.

Go to the Main tab.

Select History > Accounting.

Request accounting data by email

1.

10.

11.

12.

13.

14.

15.

Obtain the IP address of the outgoing mail server (SMTP) from your IT department; this is required in
order to send email messages.

Ensure that the outgoing email server is configured to enable relaying of email messages that the
printer will send.

Open your Web browser and connect to the printer's Embedded Web Server.
Select the Setup tab.

From the Configuration menu in the left-hand column, select Date & Time.
Ensure that the printer's date and time have been set correctly.

From the Configuration menu, select Email server.

Enter the IP address of the outgoing mail server (SMTP).

Specify an email address for the printer. The latter does not need to be a valid email address; but it
should have the form of an email address. It serves to identify the printer when it sends email
messages. See Turn usage information on and off on page 31.

From the Configuration menu, select Printer settings.

In the Accounting section, if you set Require account ID to On, then every time someone sends a print
job to the printer, he or she must provide an account ID: for example, an ID corresponding to his or her
department or to a specific project or client. If someone sends a job without providing an account ID, the
printer will hold the unidentified job in the queue without printing it until an account ID is provided.

If you set Require account ID to Off, then the printer will print all jobs whether or not they have an
account ID.

Set Send accounting files to Enabled.

Set Send accounting files to to the email address (or addresses) to which you want the accounting
information sent. This may be an address that you have created specifically to receive automatically
generated messages from the printer.

Set Send accounting files every to the frequency with which you want the information sent, choosing a
specific number of days or prints.

You may want to set Exclude personal information from accounting email to On, so that the
accounting messages will not contain personal information. If this option is Off, information such as
user name, job name, and account ID will be included.
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When you have completed the above steps, the printer will send accounting data by email with the frequency
that you specified. The data are provided in XML and can easily be interpreted by a third-party program. The
data provided on each print job include when the job was submitted, when the job was printed, the printing
time, the type of image, the number of pages, the number of copies, the paper type and size, the amount of
each color of ink used and various other attributes of the job. Accounting data are also provided on scan and
copy jobs.

You can download an Excel template from HP's Web site (http://www.hp.com/go/designjet/accounting) that
will enable you to display the XML data more readably in the form of a spreadsheet.

Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of your
printer. You can, for instance:

e  Bill each customer for the total amount of ink and paper used by that customer over a particular period.
e  Bill each customer separately per job.

e  Bill each customer separately for each project, broken down by job.

E‘%"NOTE: In some circumstances Excel may lose or misplace the decimal point in a number: for instance, the
number 5.1806 may be misunderstood as 51806 and displayed as 51,806. This is an Excel problem that
cannot be solved by HP.
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16 Handling ink cartridges and printhead

° About the ink cartridges

e  (Check the ink cartridges status

° Remove an ink cartridge

° Insert an ink cartridge

e Safe mode

° About the printhead

° Check the printhead status

° Remove the printhead

° Insert the printhead

e  Storage of anonymous usage information
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About the ink cartridges

Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper. To
purchase additional cartridges, see Supplies and accessories on page 166.

A CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see
the Glossary on page 247). Avoid touching pins, leads and circuitry.

Check the ink cartridges status

To view the ink levels of your ink cartridges, press . on the front panel, then - There is a Replace

ink cartridges option on the ink information page in case you want to do so (see also Remove an ink
cartridge on page 141).

To get more information on your ink cartridges, you can press the color of the cartridge on which you want
information.

You can also get this information from the HP Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 227.

HP Utility procedures
e Inthe HP Designjet Utility for Windows, go to the Supplies tab.

e Inthe HP Utility for Mac OS X, select Printer Status in the Information group.

Remove an ink cartridge

There are three occasions when you need to remove an ink cartridge.

e  Theink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you
can use up the remaining ink in the first cartridge at a more convenient time).

e Theink cartridge is empty or faulty, and you must replace it to continue printing.

e  Youwant to replace the printhead, and there is not enough ink left in the ink cartridge to complete the
printhead replacement process. In this case, if the cartridge is not empty you can use it again later.

A CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove anink cartridge only if you are ready to insert another one.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

E’%NOTE: When a cartridge runs out of ink, the current job is not automatically cancelled: unless you cancel it
manually, it will resume printing when the empty cartridge has been replaced. If there is a delay in replacing
the cartridge, you may see some banding on the print.

1. From the front panel, press . then - then Replace ink cartridges.

Alternatively, press . then - then Ink > Replace ink cartridges.
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2. Opentheink cartridge cover on the left- or right-hand side of the printer.

3.  Grip the cartridge you wish to remove.

4. Pull the cartridge straight up.

E’%NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink on
the connection.

E’%"NOTE: Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.
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2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters (in
these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the
cartridge label.

3. Insert the ink cartridge into its slot: photo black, gray, and matte black on the left; cyan, magenta, and
yellow on the right.

4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see confirmation
that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 227.

ENWW Insert anink cartridge 143



5. Whenall cartridges have been inserted, close the cover.

6. The front-panel display confirms that all cartridges have been correctly inserted.

Although it is possible to use non-HP ink cartridges, this choice has several serious disadvantages. It may not
be possible to determine with enough accuracy the ink level or status of used, refilled, or counterfeit ink
cartridges. Any service or repair required as a result is not covered under the warranty. System ink flushing,
color calibration, and printhead alignment are recommended. If you experience print-quality problems, HP
recommends changing to Original HP inks.

Safe mode

Under certain conditions, including printer operation outside of environmental specifications, and when a
used, refilled, or counterfeit ink cartridge has been detected, the printer will operate in ‘safe’ mode. HP is
unable to warrant the performance of the printing system when operated outside of environmental
specifications or when a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to
protect the printer and the printheads from damage due to unexpected conditions, and is in operation when
the@icon is displayed on the printer’s front panel and by the Embedded Web Server. For optimal
performance, use Original HP ink cartridges. HP Designjet printing systems, including Original HP inks and
printheads, are designed and engineered together to provide uncompromising print quality, consistency,
performance, durability, and value—with every print.

About the printhead

The printhead is connected to the ink cartridges and jets ink onto the paper.

A CAUTION: Observe precautions when handling the printhead because it is an ESD-sensitive device (see the
Glossary on page 247). Avoid touching pins, leads, and circuitry.

Check the printhead status

The printer automatically checks and services the printhead after each print. Follow the steps below to get
more information on your printhead.

1. From the front panel, press . then -

2. The front panel displays:
e C(olors
e  Productname
e  Product number

e  Serial number
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. Status, see Front-panel error messages on page 236

e  Volume of ink it has used
e  Warranty status
You can also get some of this information from the HP Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 229.

If the warranty status is See warranty note, this indicates that expired ink is being used. If the warranty
status is Out of warranty, this indicates that non-HP ink is being used. See the limited warranty document
provided with your printer for details of the warranty implications.

Remove the printhead

A CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

A CAUTION: Printhead replacement must be performed with the printer powered on.

1. From the front panel, press . then - then Replace printhead.

Alternatively, press . then - then Ink > Replace printhead.

The front panel may ask whether the replacement printhead is new or used.

@NOTE: You can cancel the process at any time by pressing .

2. The carriage moves automatically to the left side of the printer.

A CAUTION: If the carriage is left in the removal position for more than three minutes without inserting
or removing the printhead, it tries to move back to its normal position in the right-hand end.
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3. The front panel asks you to lift the scanner.

4. Locate the printhead carriage.

5. Raise the blue printhead cover.
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6. Pull the blue cover back towards you, raising the black piece to which it is attached.

7. Leave the black piece approximately vertical.

8.
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9. Lift the printhead out of the carriage.

Insert the printhead

2»NOTE: You cannot insert a new printhead successfully if a connected ink cartridge has not enough ink to
complete the printhead replacement process. In this case, you should replace the ink cartridge before
inserting the new printhead. You can use the old cartridge later if it still contains some ink.

1. Insert the new printhead.

/\ CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you insert it
too fast, or at an angle, or if you rotate it as you insert it.

1

2. Check that the printhead is correctly aligned with its ink connectors.
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3. Lower the black piece over the printhead.

4. C(Close the blue cover and make sure that it is properly closed.

b

When the printhead has been inserted correctly and is accepted by the printer, the printer beeps.

=7 NOTE: If the printer does not beep when you insert the printhead and the Replace message appears
on the front-panel display, the printhead may need to be reinserted.
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5. Lower the scanner.

6. The front-panel display confirms that the printhead is correctly inserted. The printer starts checking
and preparing the printhead. The default routine process takes 10 minutes. If the printer finds problems
in preparing the printhead, it takes longer, up to 45 minutes. After the printhead is checked and
prepared, the printhead realignment procedure runs automatically if paper is loaded, see Align the
printhead on page 228.

7. Youare recommended to perform a color calibration after inserting a new printhead. See Color
calibration on page 111.

Storage of anonymous usage information

Each ink cartridge contains a memory chip that assists in the operation of the printer. In addition, this
memory chip stores a limited set of anonymous information about the usage of the printer, which can include
the following: the date when the cartridge was first installed, the date when the cartridge was last used, the
number of prints printed using the cartridge, the print coverage, the frequency of printing, the printing
modes used, any printing errors that may have occurred, and the product model. This information helps HP to
design future products to meet our customers' printing needs.

The information collected by the memory chip does not include information that could be used to identify a
customer or user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling
program (HP Planet Partners: http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/). The
sampled memory chips are read and studied in order to improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the information. Any third party
possessing the cartridge may be able to access the anonymous information on the memory chip. If you prefer
not to allow access to this information, you can render the chip inoperable. However, after you render the
memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can tell the printer not to store the
information in the memory chip. To do so, access the Embedded Web Server, and select Setup > Anonymous
Usage Information Storage. This does not prevent the cartridge from working normally in other respects.
However, if you change your mind later, you can restore the factory defaults to resume collecting printer
usage information.
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17 Printer maintenance

° Check printer status

° Clean the exterior of the printer

° Maintain the ink cartridges

° Move or store the printer

° Update the firmware

° Update the software

° Printer maintenance kits

e  SecureFile Erase

° Disk Wipe
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Check printer status

You can check the current status of the printer in various ways:

e |If youstart the HP Utility and select your printer, you see a page of information describing the status of
the printer and its paper and ink supplies.

e Ifyouaccess the Embedded Web Server, you see information about the general status of the printer.
The Supplies page in the Main tab describes the status of the paper and ink supplies.

® At the front panel, you can press . for information about paper, ink levels, ink cartridges, and

printhead. If there is a current problem, you are taken automatically to the area with the most urgent
problem.

If there are any current alerts, the upper row of the home screen shows the top-priority alert. Press the
alert message to see the tab in which this alert is shown and the problem can be solved. Press .

and - to see the list of alerts.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

A WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you
cleanit. Do not let water get inside the printer.

/\ CAUTION: Do not use abrasive cleaners on the printer.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain
the best print quality, replace a cartridge when it reaches its expiration date. The printer's front panel notifies
you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 152.

See also Handling ink cartridges and printhead on page 140.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare the
printer, follow the instructions below.

1. Do not remove the ink cartridges or printhead.

2. Make sure that no paper is loaded.

3. Make sure that the printer is idle.

4. Disconnect any cables connecting the printer to a network or a computer.

5. If the stacker seems likely to impede the movement of the printer through doorways, you can fold it out
of the way by removing two screws.

If you need to leave the printer turned off for a long time, follow the additional steps below.
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1. Turn off the power using the Power key on the front panel.
2. Also turn off the power switch at the rear of the printer.

3. Disconnect the printer's power cable.

A CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious damage.

When reconnecting the power cable, remember to route the cable tidily along the back gutter.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare
the printhead. Preparing the printhead normally takes just over a minute. However, if the printer has been off
for a six weeks or more, preparing the printhead could take up to 45 minutes.

A CAUTION: If the printer remains off for a long period of time, the printhead may become unusable. In this
case, you need to replace the printhead.

O-TIP: Because preparing and purging the printhead uses both time and ink, you are strongly recommended

"*" to leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printhead.
In both cases, the printer wakes up from time to time to maintain the printhead. Thus, you can avoid going
through lengthy preparation processes before using your printer.

Update the firmware

The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from Hewlett-Packard. These updates increase the
printer's functionality, enhance its features, and may correct minor problems.

E’%IMPORTANT: You are strongly recommended to update the firmware periodically in order to take
advantage of the latest developments.

There are various ways of downloading and installing firmware updates; you can choose whichever you find
most convenient. They can be divided into two categories: automatic and manual updates.

E’%NOTE: The firmware includes a set of the most commonly used paper presets. Extra paper presets can be
downloaded separately; see Paper presets on page 62.

Automatic firmware updates

Automatic firmware updates are a convenience that is possible with Web-connected printers. Your printer
can automatically download the latest firmware release and install it for you.

Important notes

e  Your printer must be connected to the Internet; see Set up your Web-connected printer on page 22.

e  To configure automatic firmware updates, you can use the front panel or the Embedded Web Server;
see Set up your Web-connected printer on page 22.

e If an administrator password has been set, it will be required to change these settings.

e Afirmware update package can be large; you may want to consider whether there are any implications
for your network or Internet connection.

e Afirmware update is downloaded in the background: the printer can be printing at the same time.
However, it cannot be installed in the background: printing must stop.

Manual firmware updates

Manual firmware updates can be performed in the following ways:
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e  Using the Embedded Web Server, select the Setup tab and then Maintenance > Firmware update. Press
Check now to check whether new firmware is available. If new firmware is available, some information
about the new firmware is displayed, and you are given the opportunity to download and install it.

e  Using the HP Designjet Utility under Windows, select the Admin tab and then Firmware Update.
e  Using the HP Utility under Mac 0S X, select Firmware Update in the Information and Support group.

e  Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic
updates.

e  Using a USB flash drive. Download the firmware file from http://www.hp.com/go/T2500/firmware

(according to your printer model) into the USB flash drive and insert it into the Hi-Speed USB host port in
the front panel. A firmware update assistant will appear on the front panel to guide you through the
update process.

Update the software

To update printer drivers and other software for your printer, go to http://www.hp.com/qo/T2500/drivers.

e  Under Windows, HP Software Update regularly offers to update your software automatically, and the
HP Designjet Utility may offer you automatic updates when restarted.

e Under Mac 0S X, Apple SW Update offers you software updates when available.

Printer maintenance kits

Two maintenance kits are available for your printer, containing components that may need to be replaced
after long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 242) and
request the maintenance kit. The kits are installed by service engineers only.

Secure File Erase

The printer's hard disk is used as a temporary storage area for print jobs. Secure File Erase can erase your
temporary files from the hard disk to protect them from unauthorized access. It begins to do so as soon as
you turn it on, but old temporary files that were already on the hard disk are not erased retroactively. If you
want to erase the old files too, see Disk Wipe on page 155.

Secure File Erase provides three different levels of security:

e  Non-Secure: all pointers to the information are erased. The information itself remains on the hard disk
until the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains
on the disk, it is difficult for most people to access, but may be accessed using software designed for
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the purpose. This is the normal method in which files are erased on most computer systems; it is the
fastest method but the least secure.

e Secure Fast Erase (1 pass): all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure, but more secure. It
may still be possible to access fragments of the erased information by using special tools to detect
residual magnetic traces.

e  Secure Sanitizing Erase (5 passes): all pointers to the information are erased, and the information
itself is repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense
5220-22.m requirements for clearing and sanitization of disk media. This is the default security level
when using Secure File Erase.

While files are being erased, the printer's performance may be affected.

Secure File Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print
management software: see http://www.hp.com/go/webjetadmin.

If you have difficulty in using Secure File Erase from Web JetAdmin, please contact HP Support: see Contact
HP Support on page 242.

The Secure File Erase configuration can be changed from Web JetAdmin or the Embedded Web Server (Setup
> Security).

Disk Wipe

Disk Wipe is the same as Secure File Erase (see Secure File Erase on page 154), except that it erases all
temporary files, including old ones.

The Disk Wipe configuration can be changed from Web JetAdmin or the Embedded Web Server (Setup >
Security).

=7 NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several times
during the process, which will take about 6 hours with Secure Fast Erase or 24 hours with Secure Sanitizing
Erase.
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18 Scanner maintenance

° Clean the scanner’s glass plate

° Replace the scanner’s glass plate

° Calibrate the scanner
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Clean the scanner’s glass plate

You are recommended to clean the scanner's glass plate periodically, depending on how often you use the
scanner.

1. Turn off the printer using the Power key at the front, then also turn off the power switch at the rear and
disconnect the power cable.

2. Thereis a small lever at the rear left of the scanner. Slide the lever up and open the scanner cover.

A WARNING! Do not lift the scanner while the scanner cover is open. Your fingers or hand may be
trapped or crushed.
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3. Gently wipe the glass plate and the surrounding area with a lint-free cloth dampened with water and
then wrung dry. A suitable cloth is provided with the printer.

A CAUTION: Do not use abrasives, acetone, benzene or fluids that contain these chemicals. Do not spray
liquids directly onto the scanner glass plate or anywhere else in the scanner.

Do not worry about tiny droplets of water left on the glass: they will evaporate.

4. Optionally, for more thorough cleaning:

e  Remove the glass plate and clean it on both sides. See Replace the scanner’s glass plate
on page 160.
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e  (leanthe pressure rollers and the feed rollers.
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5. Close the scanner cover and gently push it down to lock it into place.

6. Clean the area immediately in front of the scanner, where the scanned sheet rests before scanning.

7. Reconnect the printer's power cable, turn on the power switch at the rear, and turn on the printer using
the Power key.

Replace the scanner’s glass plate

Over time, the condition of the glass plate can deteriorate. Small scratches on the surface of the glass can
reduce image quality. Contact HP Support (see Contact HP Support on page 242) to order a new glass plate.

1. Turn off the printer using the Power key at the front, then also turn off the power switch at the rear and
disconnect the power cable.
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2. Thereis a small lever at the rear left of the scanner. Slide the lever up and open the scanner cover.

A WARNING! Do not lift the scanner while the scanner cover is open. Your fingers or hand may be
trapped or crushed.

3. Unscrew 4 screws from the upper part if you intend to replace any of the three upper glasses; or
unscrew the 4 screws of the lower part for the two lower glasses.
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4. Remove the plastic piece (upper or lower as appropriate), and the plastic tabs next to the glass you
intend to remove.
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6. Slide the new glass into place.

7. Put back the plastic tabs you removed earlier.
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8. Putback and screw in the plastic piece you removed earlier.

10. Reconnect the printer's power cable, turn on the power switch at the rear, and turn on the printer using
the Power key.
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Calibrate the scanner

Your scanner has been calibrated at the factory, and theoretically CIS scanners do not need to be recalibrated
during their lifetimes. Nevertheless, because of environmental changes, your scanner may start showing
image defects that can be easily corrected by recalibrating the scanner. The whole procedure takes less than
10 minutes, and you are recommended to recalibrate the scanner whenever you see some undesired artifact
or a lack of quality in scanned files or copies, bearing in mind the limitations of CIS technology already
explained in this guide. If you perform calibration successfully and still have concerns about the image
quality, please read Troubleshooting scan-quality issues on page 201 in order to detect whether you are
facing a product limitation, and may want to consider buying a CCD scanner.

To calibrate the scanner

1. Clean the scanner. See Clean the scanner’s glass plate on page 157.

2. (o to the front panel and press , then n then Image Quality Maintenance > Calibrate
scanner.

3. Follow the instructions in the front panel.

The supplied maintenance sheet required to perform scanner calibration looks like this:

e A B A rar—

Load the maintenance sheet into the scanner face up, centered and with as little skew as possible. Once the
calibration is finished, the maintenance sheet should be carefully placed into its solid cover, and saved in a
fresh and dry place. Otherwise, it could be damaged, which could affect the operation of your scanner in the
future. Check that the maintenance sheet is not dirty, wrinkled, scratched or folded before calibrating the
scanner. If necessary, call HP support and ask for a new maintenance sheet.

If calibration fails

1. Ensure that the printer is turned on and ready for normal operation.

2. Ensure that the scanner is working correctly. To test it, scan a small document to file.

3. Ensure that the scanner is clean before calibration. If in doubt, clean the scanner and restart the
calibration process.

4. Eject and reload the calibration sheet, checking that it is clean, in good condition, face up and perfectly
centered in the scanner.

5. If the above steps do not help, eject the sheet and restart the printer (turn off and on). When the system
has restarted, repeat the calibration.

6. If you cannot perform the calibration successfully in three consecutive attempts, call HP support and

report the error code that appears in the front panel.
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19 Supplies and accessories

° How to order supplies and accessories

° Introduction to the accessories
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How to order supplies and accessories

There are two alternative ways to order supplies or accessories:

e  Visit http://www.hp.com/go/T2500/accessories on the Web. There you will also see the latest list of
supplies and accessories for your printer.

e  Contact HP Support (see Contact HP Support on page 242), and check that what you want is available in
your area.

The rest of this chapter lists the available supplies and accessories, and their part numbers, at the time of
writing.

Order ink supplies
The following ink supplies can be ordered for your printer.

Table 19-1 Ink cartridges

Cartridge Part number
HP 727 40-ml Cyan Designjet Ink Cartridge B3P13A
HP 727 40-ml Magenta Designjet Ink Cartridge B3P14A
HP 727 40-ml Yellow Designjet Ink Cartridge B3P15A
HP 727 40-ml Photo Black Designjet Ink Cartridge B3P17A
HP 727 40-ml Gray Designjet Ink Cartridge B3P18A
HP 727 69-ml Matte Black Designjet Ink Cartridge C1Q11A
HP 727 130-ml Cyan Designjet Ink Cartridge B3P19A
HP 727 130-ml Magenta Designjet Ink Cartridge B3P20A
HP 727 130-ml Yellow Designjet Ink Cartridge B3P21A
HP 727 130-ml Matte Black Designjet Ink Cartridge B3P22A
HP 727 130-ml Photo Black Designjet Ink Cartridge B3P23A
HP 727 130-ml Gray Designjet Ink Cartridge B3P24A
HP 727 300-ml Matte Black Designjet Ink Cartridge C1Q12A

Table 19-2 Printhead

Printhead Part number
HP 727 Printhead B3P06A
Order paper

The following paper types are currently provided for use with your printer.

E”/,"NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/T2500/accessories.

E‘%NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability:
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e (A)indicates papers available in Asia (excluding Japan)

e (0 indicates papers available in China

e  (E) indicates papers available in Europe, the Middle East and Africa

e (J)indicates papers available in Japan

e (L)indicates papers available in Latin America

e (N)indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Table 19-3 Roll paper

Paper type g/m? Length Width Part numbers
HP Bond and Coated Paper
HP Universal Bond Paper 80 45.7 m (150 ft) 594 mm (23.39in) (A1) Q8003A (A))
610 mm (24 in) Q1396A
914 mm (36 in) Q1397A
HP Bright White Inkjet Paper 90 45.7 m (150 ft) 420 mm (16.54 in) (A2) Q1446A (EJ)
594 mm (23.39in) (A1) Q1445A (EJ)
610 mm (24 in) C1860A (LN),
C6035A (AEJ)
841 mm (33.11in) (A0) Q1444A (E))
914 mm (36 in) C1861A (LN),
C6036A (AEJ)
91.4 m (300 ft) 914 mm (36 in) C6810A
HP Universal Coated Paper 90 45.7 m (150 ft) 610 mm (24 in) Q1404A (AEJN)
914 mm (36 in) Q1405A (AEJN)
HP Coated Paper 90 45.7 m (150 ft) 420 mm (16.54 in) (A2) Q1443A ()
594 mm (23.39in) (A1) Q1442A (E))
610 mm (24 in) C6019B
841 mm (33.11in) (A0) Q1441A (E))
914 mm (36 in) €6020B
91.4 m (300 ft) 914 mm (36 in) C6980A
HP Universal Heavyweight Coated 125 30.5m (100 ft) 610 mm (24 in) Q1412A (AEJN)
Paper
914 mm (36 in) Q1413A
HP Heavyweight Coated Paper 130 30.5m (100 ft) 610 mm (24 in) C6029C (AEJN)
914 mm (36 in) €6030C
HP Super Heavyweight Plus Matte 210 30.5m (100 ft) 610 mm (24 in) Q6626A or B
Paper
914 mm (36 in) Q6627A or B

HP Technical Paper
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Table 19-3 Roll paper (continued)

Paper type g/m2 Length Width Part numbers

HP Natural Tracing Paper 90 45.7 m (150 ft) 594 mm (23.39in) (A1) Q1439A(J)
610 mm (24 in) C3869A (AEN)
914 mm (36in) C3868A (AELN)

HP Translucent Bond Paper 67 45.7 m (150 ft) 610 mm (24 in) C3860A (AJN)
914 mm (36 in) (3859A (JLN)

HP Film (Technical and Graphic)

HP Clear Film 174 22.9m (75 ft) 610 mm (24 in) C3876A (AEJN)
914 mm (36 in) C3875A

HP Matte Film 160 38.1 m (125 ft) 610 mm (24 in) 51642A (AEJN)
914 mm (36 in) 51642B

HP Photographic Paper

HP Premium Gloss Photo Paper 240 15.2m (50 ft) 610 mm (24 in) CZ984A (AEN)

22.9m (75 ft) 914 mm (36 in) Q8806A (AEN)
HP Premium Satin Photo Paper 240 15.2 m (50 ft) 610 mm (24 in) CZ987A (AEN)
22.9m (75 ft) 914 mm (36 in) Q8808A (AEN)

HP Premium Matte Photo Paper 210 30.5m (100 ft) 610 mm (24 in) CG459AorB
914 mm (36 in) CG460A or B

HP Universal Gloss Photo Paper 190 30.5m (100 ft) 610 mm (24 in) Q1426A (AEJN)
914 mm (36 in) Q1427A (AEJN)

HP Universal Satin Photo Paper 190 30.5m (100 ft) 610 mm (24 in) Q1420A (AEJN)
914 mm (36 in) Q1421A (AEJN)

HP Universal Instant-dry Gloss Photo 200 30.5m (100 ft) 610 mm (24 in) Q6574A

Paper
914 mm (36 in) Q6575A

HP Universal Instant-dry Satin Photo 200 30.5m (100 ft) 610 mm (24 in) Q6579A

Paper
914 mm (36 in) Q6580A

HP Premium Instant-dry Gloss Photo 260 22.9m (75 ft) 610 mm (24 in) Q7991A

Paper 30.5m (100 ft) 914 mm (36 in) Q7993A

HP Premium Instant-dry Satin Photo 260 22.9m (75 ft) 610 mm (24 in) Q7992A

Paper 30.5m (100 ft) 914 mm (36 in) Q7994A

TIP: The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for more
than two weeks, you should laminate them to achieve longer life.

HP Self-Adhesive Material

HP Everyday Adhesive Matte 120 22.9m (75 ft) 610 mm (24 in) COF18A
Polypropylene, 2 Pack without

liner 914 mm (36 in) COF19A
HP Everyday Adhesive Gloss 130 22.9m (75 ft) 914 mm (36 in) COF28A
Polypropylene, 2 Pack without

liner
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Table 19-3 Roll paper (continued)

Paper type g/m2 Length Width Part numbers
HP Colorfast Adhesive Vinyl, 2 Pack 190 12.2m (40 ft) 914 mm (36 in) COF08A
without
liner
HP Universal Adhesive Vinyl, 2 Pack 150 20.1 m (66 ft) 914 mm (36 in) C2T51A
without
liner
HP Banner and Sign Material
HP Everyday Matte Polypropylene, 2 120 30.5m (100 ft) 610 mm (24 in) CHO22A
Pack
914 mm (36 in) CHO23A
HP Durable Banner with DuPont 140 22.9m (75 ft) 914 mm (36 in) COF12A
Tyvek, 2 Pack
HP Premium Matte Polypropylene, 2 140 22.9m (75 ft) 914 mm (36 in) C2T53A
Pack
Table 19-4 Sheet paper
Paper type g/m2 Length Width Part numbers
HP Photographic Paper
HP Premium Gloss Photo Paper 240 483 mm (19in) 330 mm (13in) (Z985A (AEN)
610 mm (24 in) 457 mm (18 in) CZ986A (AEN)
HP Premium Satin Photo Paper 240 483 mm (19in) 330 mm (13in) CZ988A (AEN)
610 mm (24 in) 457 mm (181in) CZ989A (AEN)

Order accessories

The following accessories can be ordered for your printer.

Name Product number
HP Designjet PostScript Upgrade COC66A
HP Designjet 36-inch Rollfeed Spindle COE65A
HP Designjet 3-in Spindle Adaptor Kit CN538A

Introduction to the accessories

PostScript Upgrade

The PostScript Upgrade enables a T2500 to print the same file types that a T2500 PS can print, including PDF
and PostScript files. The PostScript upgrade can be plugged into the printer's USB host. It is not necessary to
leave it permanently connected: just plug it in once, and the printer is upgraded forever.

Spindle

With extra spindles, you can change rapidly from one paper type to another.
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3-in Spindle Adaptor Kit

With this adaptor you can use paper rolls with 3-inch cores, provided that the diameter of the roll is within
printer specifications.

ENWW Introduction to the accessories 171



20 Troubleshooting paper issues

e  The paper cannot be loaded successfully

e  The paper typeis not in the list

° The printer printed on the wrong paper type

e An“onhold for paper” message

° The paper has jammed in the print platen

° The paper has jammed in the stacker

e  The printer reports unexpectedly that the stacker is full

e  The printer displays out of paper when paper is available

° Prints do not fall neatly into the basket

e  The print remains in the printer after printing has completed

° The cutter does not cut well

e Therollis loose on the spindle
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The paper cannot be loaded successfully

e  Ensure no paper is loaded.
e  Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.

e  The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load

e |f the paper does not load, the leading edge of the paper may not be straight or clean and needs to be
trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a
new roll of paper.

e  Ensure the roll ends are tight against the spindle ends.
e  (Check that the spindle is correctly inserted.

e  (Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards the
stacker.

e  (Check that all roll end plugs have been removed.

e  (Check that the paper is wound tightly on the roll.

e Do not touch the roll or paper during the alignment process.

e  When loading a roll, the roll cover must remain open until the front panel prompts you to close it.

e Iftherollis not aligned, the front panel displays an error and instructions to start again. To start the
load process again, cancel the process on the front panel and rewind the roll from the end of the spindle
until the edge is removed from the printer.

|‘__“:"’/'°NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load

e  Keep pushing the sheet until you feel resistance. Do not release the sheet until the printer starts to pull
the paper and you hear a beep.

e  (Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
e  Ensure that the sheet is aligned with the reference line on the roll cover.

e Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-
panel display.

e Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.
In case of any problem, please follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel. If a sheet is in the
printer, it is ejected to the stacker.

Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

Front-panel message Suggested action

Close the roll cover when the paper loadis  Close the roll cover when the paper load is finished.
finished
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Front-panel message Suggested action

Paper not detected During the paper load process the printer did not detect any paper. Ensure the paper is
inserted fully and is not transparent.

Roll cover closed during paper load process Do not close the roll cover until you are prompted to do so by the front panel.

Sheet too small During the load process the printer detected that the sheet of paper is too narrow or too
short to be loaded in the printer. Press .to stop the load process. See Functional

specifications on page 244.

The paper type is not in the list

To work with a paper that does not appear in the list in the driver or front panel, you can choose one of the
other papers in the list. However, you should at least choose a paper of the same type: transparent or
translucent, photo or bond, coated or technical.

;“—“‘ NOTE: For photo paper, it is important to select a photo paper type, as the printer adjusts its use of ink for
photo paper.

Transparent or translucent film

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/Clear
film.

If your paper is a translucent paper or film (for example, technical paper), select paper type Film > Matte
film.

Photo paper

If your paper is a photo paper, use the Photo Paper category. For gloss or high-gloss paper, select paper type
Photo Gloss Paper. For semi-gloss, satin, pearl, or luster finishes, select paper type Photo Semi-gloss/Satin
Paper.

To increase gamut on photo paper, select paper type HP Universal Gloss Photo Paper or HP Universal Satin
Photo Paper, depending on the finish.

Bond and coated or technical paper
Your paper type selection for generic paper depends on the paper’s ink absorption capacity.

e For thin papers (< 90 g/m?) or uncoated papers (for example plain paper or bright white paper), select
paper type Bond and Coated Paper > Plain Paper. You can also select Recycled Bond Paper.

®  For light coated papers (< 110 g/m?), select paper type Bond and Coated Paper > HP Coated Paper.

e  For heavyweight coated papers (< 200 g/m?), select paper type Bond and Coated Paper > Heavyweight
Coated Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use an optimized ink combination,
select paper type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink

Reduce the quantity of ink, or use thicker paper. Matte paper categories from thinnest to thickest are:
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e  Plain Paper
e  (oated Paper
e  Heavyweight Coated Paper

e  Super Heavyweight Plus Matte Paper

_‘{?'_ TIP: If you load paper that is slightly thicker than the paper type you selected, the printer will use less ink
* than usual for the loaded paper.

For other print-quality problems, see Troubleshooting print-quality issues on page 182.

The printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Any or Use
printer settings selected for the Paper Type in the printer driver. In this case, the printer will print
immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 50, and
select your paper type specifically in the driver.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select your paper type from the Paper
Type list.

e  Inthe Mac 0S X Print dialog: select the Paper/Quality panel, then select your paper type from the
Paper Type list.

E’%NOTE: The driver default is Any for Mac 0S and Use printer settings for Windows; they have the same
effect.

An “on hold for paper” message

Based on a set of conditions that you can set when sending a job to the printer (see Paper mismatch action
on page 29), the printer will decide which of the loaded rolls of paper is more suitable to print the job. If there
is no roll of paper available that meets all the conditions, the printer will put the job on hold for paper. You
can manually resume the job, forcing it to print on a paper other than the one originally specified, otherwise
it will stay on hold.

Which criteria are used to decide on which roll a job will be printed?

When a user sends a job, the desired paper type can be set (in the driver or in the Embedded Web Server). The
printer will print the job on a roll of paper of the chosen paper type that is large enough to print the drawing
without clipping. If there is more than one roll on which the job could be printed meeting all the criteria, the
roll will be chosen according to your preferences. These can be set from the front panel: see Roll switching
options on page 29.

Whenis a job put on hold for paper?

If the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 29), ajob is put on
hold for paper in the following cases:

e  The paper type that has been selected by the user is not currently loaded on the specified roll—or on
either of the rolls, if no roll has been specified.

e  The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too
large to fit on the roll—or on either of the rolls, if no roll has been specified.
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If | load a new roll of paper, will jobs that were on hold for paper be automatically
printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that
could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can | preventit?

Yes, this can be done from the front panel: see Paper mismatch action on page 29.

| set the option “Paper mismatch action” to “Print anyway”, but some jobs are still
put on hold (Windows driver only)

If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are put on hold
until you have checked the preview and resumed the job. Check that the Show print preview option is not
checked in the driver, and that there are no pending preview windows waiting for confirmation to continue
printing.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put
on hold for paper

Margins are managed in different ways depending on the file type:

e  For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in)
HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for

paper.

e  For other file formats, such as PostScript, PDF, TIFF or JPEG, the printer assumes that margins need to
be added outside the drawing (as, in many cases, these formats are used for photographs and other
images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs
to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the job
to be put on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip
contents by margins option can be used. This option will force the margins to be set inside of the
drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put on
hold. However, if there is no white space already included in the drawing’s borders, some contents could
be clipped because of the margins.

3.“—“‘ NOTE: If you choose the option Match exact size, your job will be printed only on paper whose width
exactly matches the width of the job.

The paper has jammed in the print platen

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display, and a
system error 81:01 or 86:01.

1.  Lift the scanner.
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2. Move the carriage manually to the left side of the printer, if feasible.

3. Gotothe paper path.
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4. Cut the paper with a pair of scissors.
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6. Manually rewind paper onto the roll.

7. If the leading edge of the paper is ragged, trim it carefully with scissors.
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8. Remove the paper left in the printer.

10.

11. Restart the printer by holding down the power button for a few seconds, or by turning the power switch
at the rear off and then on.

12. Reload theroll, or load a new sheet see Paper handling on page 50.

i.“—“‘ NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the
procedure and carefully remove all pieces of paper.

The paper has jammed in the stacker

When a paper jam is detected in the stacker, printing is paused, and the front panel asks you to open the
stacker cover and clear the jam by pulling out the paper.
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When the stacker cover is closed and the printer detects no jammed paper, the front panel requests
confirmation to continue printing.

The printer reports unexpectedly that the stacker is full

The printer may report that the stacker is full in the following circumstances:
e  When thereis a paper jam in the stacker
e  When you are using very thin or very stiff paper, such as heavyweight coated paper

e  When you are sending small paper sizes to the stacker, such as A3 portrait or A2 landscape

The printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If
possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

e  Ensure that the network and power cables are not getting in the way.
e  Ensure that the basket is correctly installed.

e  Ensure that the basket is open.

e  Ensure that the basket is not full.

e  Ensure that the paper is not jammed.

e  Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or
remove prints manually as they are completed.

If you see the message Please remove the print from the basket and press OK to continue, empty the
basket, check that there is no paper in the path to the basket, then press OK. The printer checks that the
problem has been fixed.

The print remains in the printer after printing has completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 64. If a
sheet of paper is only partially ejected after the drying time, gently pull it out of the printer.

The cutter does not cut well

By default, the printer is set to cut the paper automatically after each job.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any
obstacles.

The rollis loose on the spindle

The roll may need to be replaced or reloaded.
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21 Troubleshooting print-quality issues

° General advice

° Print-quality troubleshooting wizard

° Recalibrate the paper advance

e  Horizontal lines across the image (banding)

° Lines are too thick, too thin or missing

e Lines appear stepped or jagged

° Lines print double or in the wrong colors

° Lines are discontinuous

° Lines are blurred

° Line lengths are inaccurate

° The whole image is blurry or grainy

e  The paperis not flat

e  The printis scuffed or scratched

° Ink marks on the paper

° Black ink comes off when you touch the print

° Edges of objects are stepped or not sharp

° Edges of objects are darker than expected

° Horizontal lines at the end of a cut sheet print

e  \Vertical bands of different colors

° White spots on the print

° Colors are inaccurate

e  (olors are fading

° The image is incomplete (clipped at the bottom)

e Theimageis clipped

e  Some objects are missing from the printed image

e APDFfileis clipped or objects are missing

° The Image Diagnostics Print
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° If you still have a problem
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General advice

When you have any print-quality problem:

e  Toachieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper on page 167.

e  Make sure that the paper type selected in the front panel is the same as the paper type loaded into the
printer (see View information about the paper on page 62). At the same time, check that the paper type
has been calibrated. Also make sure that the paper type selected in your software is the same as the
paper type loaded into the printer.

A CAUTION: If you have the wrong paper type selected, you could experience poor print quality and
incorrect colors, and perhaps even damage to the printhead.

e  Check that you are using the most appropriate print-quality settings for your purposes (see Printing
on page 68). You are likely to see lower print quality if you have moved the print-quality slider to the
'Speed' end of the scale, or set the custom quality level to Fast.

e  Check that your environmental conditions (temperature, humidity) are in the recommended range. See
Environmental specifications on page 246.

e  Check that your ink cartridges and printhead have not passed their expiration dates: see Maintain the
ink cartridges on page 152.

For the latest information, please visit http://www.hp.com/go/T2500/support.

Print-quality troubleshooting wizard

The print-quality troubleshooting wizard can help with the following problems:

e  Horizontal lines across the image (banding)

e  Thewholeimageis blurry or grainy

e Lines are too thick, too thin or missing

e  (Colors areinaccurate

To start the wizard:

e  From the HP Designjet Utility for Windows: Go to the Support tab, and select Print Quality Toolbox.
e  From the HP Utility for Mac 0S X: Select Print quality troubleshooting in the Support group.

e  Fromthe Embedded Web Server: Go to the Support tab, then select Print quality troubleshooting.
®  From the front panel: Press . then - then Image quality maintenance.

Alternatively, or if you have other print-quality problems, you can continue reading this chapter.

Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement
of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark
bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing.
However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the

184 Chapter 21 Troubleshooting print-quality issues ENWW


http://www.hp.com/go/T2500/support

rate at which the paper advances. See Troubleshooting print-quality issues on page 182 for steps to
determine if paper advance calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper at any time from the front
panel. Press [g2Fal then n then Image quality maintenance > Calibration status. The status may be
one of the following.

e  DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers in the
Front Panel have been optimized by default and unless you experience image quality problems in your
printed image such as banding or graininess it is not recommended to recalibrate the paper advance.

e  OK: This status indicates that the loaded paper has been calibrated before. However you may need to
repeat the calibration if you experience image quality problems such as banding or graininess in your
printed image.

=7 NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are reset to
factory default, see Update the firmware on page 153.

A CAUTION: Transparent papers and films must be calibrated by pressing , then n then Image

quality maintenance > Paper advance calibration > Adjust paper advance, from step four in Recalibrating
the paper advance procedure.

Recalibrating the paper advance procedure

1. From the front panel, press kel then n then Image quality maintenance > Paper advance

calibration > Calibrate paper advance. The printer automatically recalibrates the paper advance and
prints a paper advance calibration image, which you can send to stacker or basket.

2.  Wait until the front panel displays the status screen, then reprint your print.

?‘ NOTE: Therecalibration procedure takes a few minutes. Do not worry about the paper advance
calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return
to the default calibration, see Return to default calibration on page 186.

3. If you would like to fine-tune the calibration or are using a transparent paper, press kel then n
then Image quality maintenance > Paper advance calibration > Adjust paper advance.
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4. Select the percentage of change from —100% to +100%. To correct light banding, decrease the
percentage.

To correct dark banding, increase the percentage.

5. Press OK on the front panel, to save the value.

6.  Wait until the front panel displays the status screen and reprint your print.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To
return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, press . then - then Image quality maintenance > Paper advance
calibration > Reset paper advance.

2.  Wait until the front panel displays the operation has completed successfully.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary):
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1.  Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 62.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 68).
In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality
level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you
change the print-quality settings, you may wish to reprint your job at this point in case the problem has
been solved.

3.  Print the Image Diagnostics Print. See The Image Diagnostics Print on page 196.

4. If the printhead is working correctly, go to the front panel and press . then - then Image

quality maintenance > Calibration status to see the paper advance calibration status. If the status is
DEFAULT, try performing paper advance calibration: see Recalibrate the paper advance on page 184.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines are too thick, too thin or missing

— & - ——
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1.  Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 62.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 68).
If printing on photo paper, select the custom print-quality options in the driver dialog, and try turning
on the Maximum detail option (if available). You may wish to reprint your job at this point in case the
problem has been solved.

3. Iftheresolution of your image is greater than the printing resolution, you may notice a loss of line
quality. If you are using the PCL3GUI or the HP-GL/2 driver for Windows, you can find the Max.
Application Resolution option in the driver dialog's Advanced tab, under Document Options > Printer
Features. If you change this option, you may wish to reprint your job at this point in case the problem
has been solved.

4. When printing on uncoated paper in Fast mode, try loading the paper as Bright Bond.
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5. If the problem remains, go to the front panel and press . then - then Image quality

maintenance > Calibration status to see the printhead alignment status. If the status is PENDING, you
should align the printhead. See Align the printhead on page 228. After alignment, you may wish to
reprint your job in case the problem has been solved.

6. Go to the front panel and press . then - then Image quality maintenance > Calibration

status to see the paper advance calibration status. If the status is DEFAULT, you should perform paper
advance calibration: see Recalibrate the paper advance on page 184.

7. Iflines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics Print
on page 196.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are using
to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 68.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if
available).

Lines print double or in the wrong colors

This problem can have various visible symptoms:

e  C(olored lines are printed double, in different colors.

/s

N\

e  The borders of colored blocks are wrongly colored.

To correct this kind of problem:
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1. Align the printhead. See Align the printhead on page 228.

2. Reseat the printhead by removing and then reinserting it. See Remove the printhead on page 145 and
Insert the printhead on page 148.

Lines are discontinuous

If your lines are broken in the following way:

1.  Check that you are using appropriate print-quality settings. See Printing on page 68.

2.  When printing on uncoated paper in Fast mode, try loading the paper as Bright Bond.

3. Align the printhead. See Align the printhead on page 228.

4. Reseat the printhead by removing and then reinserting it. See Remove the printhead on page 145 and
Insert the printhead on page 148.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1.  Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing.
See Environmental specifications on page 246.

2. Check that the paper type selected in the front panel is the same as the paper type you are using. See
View information about the paper on page 62.

3. Trychanging to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight
Plus Matte Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated
Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

5. Ifyou are using photo paper, try changing to a different type of photo paper.

6. Align the printhead. See Align the printhead on page 228.
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Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your
purposes, you can try to improve line length accuracy in the following ways.

1.

Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 244.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is
thinner or thicker than HP Matte Film will reduce line length accuracy.

Set the Print Quality slider to Quality.
Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
Load the roll of film and let it rest for five minutes before printing.

If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance
on page 184.

The whole image is blurry or grainy

,_ A

Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 62.

Check that you are printing on the correct side of the paper.

Check that you are using appropriate print-quality settings (see Printing on page 68). In some cases,
you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance,
if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality
settings, you may wish to reprint your job at this point in case the problem has been solved.

Go to the front panel and press . then - then Image quality maintenance > Calibration

status to see the printhead alignment status. If the status is PENDING, you should align the printhead.
See Align the printhead on page 228. After alignment, you may wish to reprint your job in case the
problem has been solved.

Go to the front panel and press . then - then Image quality maintenance > Calibration

status to see the paper advance calibration status. If the status is DEFAULT, you should perform paper
advance calibration: see Recalibrate the paper advance on page 184.

If the problem persists despite all the above actions, contact your customer service representative for
further support.
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The paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes
saturated with ink.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 62.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight
Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated
Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

4. If you see horizontal stripes, try printing the same job rotated; this sometimes reduces the visibility of
the stripes.

The print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This
is particularly noticeable on coated paper.

Photo paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing,
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:
e  Handle prints carefully.

e  Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively,
leave a sheet of paper in the basket so that freshly printed sheets do not make direct contact with the
basket.

Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of the paper

ENWW

When a lot of ink is used on a paper-based material, the paper absorbs the ink quickly and expands. If the
paper is stiff and curled, near the end of the roll the leading edge of the paper may rise slightly in the print
area. As the printhead moves over the paper, it may come into contact with the paper and smear the printed
image.
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Whenever you notice this problem, cancel the printing job immediately. Press . on the front panel and also
cancel the job from your computer application. Soaked paper can damage the printhead.

Try the following suggestions to avoid this problem:

1.

Increase the margins by relocating the image to the center of the page, either with your software or
with the front panel’s Move Paper option (see Move the paper on page 63). To prevent such smears
most effectively, the distance from the image to the leading edge of the paper should be at least 20 mm
(0.8in).

Select a faster print mode: change from Best to Normal, or from Normal to Fast mode.

Other smears on the paper

The following suggestions may be used for all kinds of smears, including those on the front of the paper:

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 62.

Use a recommended paper type (see Order paper on page 167) and the correct print settings.

If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect
performance.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight
Plus Matte Paper.

Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated
Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on photo paper. The printer will not use matte
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select
Photo Gloss Paper as the paper type (in the Photo Paper category).

192 Chapter 21 Troubleshooting print-quality issues ENWW



Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the
print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the
quality level to Normal. See Printing on page 68.

Edges of objects are darker than expected

If edges of objects seem darker than expected, and you have already set the print-quality slider to Quality in
the driver dialog, select the custom print-quality options, and try setting the quality level to Normal. See
Printing on page 68.

Horizontal lines at the end of a cut sheet print

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the
paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1.  Print the Image Diagnostics Print. See The Image Diagnostics Print on page 196.

2.  Consider printing with roll paper.

3. Consider using larger margins around your image.

Vertical bands of different colors

If your print has vertical bands of different colors along it:

1.  Try using higher print-quality settings (see Printing on page 68). For instance, if you have set the Print
Quality slider to Speed, try setting it to Quality.

2. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated
Paper and HP Super Heavyweight Paper. See Order paper on page 167.

ENWW Edges of objects are stepped or not sharp 193



White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material.
To avoid this problem:

1.
2.

3.

Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
Always keep the cover of your printer closed.

Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 62. Also, press . then -
then Image quality maintenance > Calibration status to check the color calibration status. If the status

is PENDING or OBSOLETE, you should perform color calibration: see Color calibration on page 111. If you
have made any changes, you may wish to reprint your job in case the problem has been solved.

Check that you are printing on the correct side of the paper.

Check that you are using appropriate print-quality settings (see Printing on page 68). If you have
selected the Speed or Fast options, you may not get the most accurate colors. If you change the print-
quality settings, you may wish to reprint your job at this point in case the problem has been solved.

If you are using Application Color Management, check that the color profile you are using corresponds
to the selected paper type and print-quality settings. If you have doubts about which color settings to
use, see Color management on page 110.

If the problem consists of color differences between your print and your monitor, please follow the
instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you may
wish to reprint your job in case the problem has been solved.

Print the Image Diagnostics Print. See The Image Diagnostics Print on page 196.

Try using the color adjustment options to produce the colors you want. See Color adjustment options
on page 114.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Color accuracy using EPS or PDF images in page layout applications

Page layout applications such as Adobe InDesign and QuarkXPress do not support color management of EPS,
PDF or grayscale files.
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If you have to use such files, try to ensure that the EPS, PDF or grayscale images are already in the same
color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if your final goal
is to print the job in a press that follows the SWOP standard, convert the image into SWOP when you create it.

Colors are fading

If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more
than two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of
prints (depending on the type of lamination) with all paper types. For more information, consult your
laminate provider.

The image is incomplete (clipped at the bottom)

®  Didyou press . before all the data were received by the printer? If so, you have ended the data
transmission and will have to print the page again.

e  There may be a communications problem between your computer and the printer. Check your network
cable.

e Check to make sure that your software settings are correct for your current page size (for example,
long-axis prints).

e If youare using network software, make sure it has not timed out.

The imageiis clipped
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Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the
printable area as understood by your software. You can often identify this kind of problem before printing by
previewing your print (see Preview a print on page 76).

e  (Check the actual printable area for the paper size you have loaded.
printable area = paper size —margins

e  Check what your software understands to be the printable area (which it may call "printing area" or
"imageable area"). For example, some software applications assume standard printable areas that are
larger than those used in this printer.

e If you have defined a custom page size with very narrow margins, the printer may impose its own
minimal margins, clipping your image slightly. You may want to consider using a larger paper size, or
borderless printing (see Select margins options on page 74).

e |f yourimage contains its own margins, you may be able to print it successfully by using the Clip
Contents by Margins option (see Select margins options on page 74).

e Ifyouare trying to print a very long image on a roll, check that your software is capable of printing an
image of that size.

e  You may have asked to rotate the page from portrait to landscape on a paper size that is not wide
enough.

e If necessary, reduce the size of the image or document in your software application, so it fits between
the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe Photoshop,
Adobe Illustrator and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot
handle an image of more than 32,768 pixels.
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@’NOTE: Animage 32,768 pixels long would print at a length of 1.39 m (54.61 in) if you select Best or Quality
in the driver, 2.78 m (109.23 in) if you select Fast, Normal or Speed in the driver.

If you try to print an image larger than this from these applications, the bottom of the image may be clipped.
To print the whole image, try these suggestions:

Try using the PostScript printer driver to print your job, if you have not already tried it.

The Windows HP-GL/2 driver dialog includes an option called Max. application resolution, which
enables you to print successfully in this situation. You will not normally need to change the default
setting, which is Aute. However, you can find the option in the Advanced tab, under Document Options
> Printer Features.

Save the file in another format, such as TIFF or EPS, and open it with another application.

Use a RIP to print the file.

Some objects are missing from the printed image

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific
workflows there may be issues that can lead to some objects missing from the output. Here are some
suggestions to help you to avoid this problem.

Try using the PostScript printer driver to print your job, if you have not already tried it.

Select a smaller page size and scale to the desired final page size in the driver or in the front panel.
Save the file in another format, such as TIFF or EPS, and open it with another application.

Use a RIP to print the file.

Reduce the resolution of bitmap images in your application software.

Select a lower print quality in order to reduce the resolution of the printed image.

= NOTE:  If you are working under Mac 0S X, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality
or the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to
solve the problem.

A PDF file is clipped or objects are missing

In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some objects
when printing with the HP-GL/2 driver at high resolution. In order to avoid such problems, update your Adobe
Acrobat or Adobe Reader software to the latest version. From version 7 onwards, these problems should be
solved.

The Image Diagnostics Print

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps
you to check the performance of the printhead, and whether it suffers from clogging or other problems.

To print the Image Diagnostics Print:
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1. Use the same paper type that you were using when you detected a problem.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See View

information about the paper on page 62.

3. Atthe printer's front panel, press . then - then select Image Quality Maintenance > Print

diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

e  Part 1 (top) consists of rectangles of pure colors, one for each ink. This part represents the print quality

that you will get from each color.

e  Part 2 (bottom) consists of small dashes, one for each printhead nozzle. This part complements the
first, and aims more specifically to detect how many faulty nozzles each printhead has.

Please look carefully at the print. The names of the colors are shown above the rectangles and to the left of

the patterns of dashes.
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First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any

horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the

dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, you should clean the
printhead, selecting the relevant color group. However, if the rectangles look solid, do not worry about just a
few missing dashes in part 2; these are acceptable because the printer can compensate for a few clogged

nozzles.

Here is an example of a gray printhead in a good state:
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And here is an example of the same printhead in a bad state:

G

Corrective action

1.

Clean the printhead if necessary (see Clean the printhead on page 228). Then reprint the Image
Diagnostics Print to see whether the problem has been solved.

If the problem remains, clean the printhead again, and reprint the Image Diagnostics Print to see
whether the problem has been solved.

If the problem still remains, replace the printhead (see Handling ink cartridges and printhead
on page 140), or contact HP Support (see Contact HP Support on page 242).

If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some further
things that you can do:

Try using a higher print-quality option. See Printing on page 68.

Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be
downloaded from http://www.hp.com/go/T2500/drivers.

If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with the
RIP.
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e  Check that your printer's firmware is up to date. See Update the firmware on page 153.

e  (Check that you have the right settings in your software application.
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22 Troubleshooting scanner issues

Cannot access the network folder

If you have set up a network folder (see Configure a scan-to-network or scan-to-FTP folder on page 24), but
the printer cannot access it, try the following suggestions.

Check that you have filled in each field correctly.

Check that the printer is connected to the network.

Check that the remote computer is switched on, working normally and connected to the network.
Check that the folder is shared.

Check that you can put files into the same folder from a different computer on the network, using the
printer's logon credentials.

Check that the printer and the remote computer are in the same network subnet; if they are not, check
that the network routers are configured to forward the CIFS protocol traffic (also known as Samba).

Scanning to file is slow

Scanning large formats creates large files. This means that scanning to file can take time even under optimal
system configurations and conditions. This is especially true when scanning across a network. However, if
you think scanning to file with your system is unreasonably slow, the following steps may help you to locate
and solve the problem.

1.

Use the front panel to check the status of your scan job. If it is taking an intolerably long time, you can
select the job and then cancel it.

Check that the Resolution setting is right for the job. Not all scanning tasks require high resolutions. If
you lower the resolution, you will speed up the scanning process. For JPEG and PDF scan jobs, you can
also change the Quality setting. Lower quality values produce smaller files.

Check your network configuration. Your network should be a Gigabit Ethernet or one of a higher transfer
rate in order to achieve optimal scanning speeds. If your network is a 10/100 Ethernet configuration,
you can expect slower transfer of the scan data and thus slower scanning speeds.

Contact your network administrator for information about your network configuration, transfer rates,
scan-to-file destinations on the network and possible solutions for increasing the speeds.

If scanning to files on the network is too slow and the network configuration cannot be amended to
correct this, improved speeds can be achieved by scanning to a USB flash drive.

If scanning to a USB flash drive seems slow, check your USB flash drive interface compatibility. Your
system supports a Hi-Speed USB interface. Your USB flash drive should be compatible with Hi-Speed
USB (sometimes known as USB 2). Also check that your USB flash drive contains enough storage space
for scanned large-format images.
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23 Troubleshooting scan-quality issues

° Random vertical lines

e  Wrinkles or folds

° Line discontinuities

° Grain in area fills when scanning plain paper

° Small color differences between adjacent CIS modules

° Vertical light lines at the intersection between CIS modules

° Variable line thickness or missing lines

° Inaccurately reproduced colors

° Color fringing

° Clipping in dark or light areas

° Flare in the image when scanning glossy originals

° Vertical red and green bands over white or black background

e  The stop-start effect

° Vibration

° Horizontal periodical banding

° Defocus, blurring and fading colors

° Incorrect paper advance, skew during scanning, or horizontal wrinkles

° Vertical black band 20 cm wide

° The scanner damages some originals

° Completely wrong colors

° Vertical distortion

e  Obiject replication (ghosting)

° Clipping or incorrect scale factor when down-scaling in copies and prints

° Incorrect edge detection, mostly when scanning tracing paper

° A copied or scanned image is very skewed

In this chapter the most common defects and failure modes are shown, sorted by relevance and frequency of
appearance. A defect is a common image artifact that usually appears when using any CIS scanner. These are
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due to incorrect settings, product limitations, or easily solvable mistakes. A failure mode is due to
malfunctions of some of the scanner components.

Some of the corrective actions proposed here require the use of the Scanner Diagnostic Plot, which you can
print and scan as indicated in The scanner diagnostic plot on page 220. Please do not use any printed version
of this guide to test the scanner, as the resolution of the images included here is insufficient. Use the
diagnostic plot when recommended in response to any of the errors described in this chapter.

Random vertical lines

This is one of the most common issues in sheet-fed scanners. Usually, the vertical streaks are caused by dust
particles inside the scanner, or miscalibration of the scanner (in these cases, the problem can be solved).
Here are some examples of images suffering from vertical lines or streaks. Please note the black arrow
indicating the scanning direction in these examples.

" I
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Actions

1. Clean the scanner’s glass plate and the original to be scanned as described in Clean the scanner’s glass
plate on page 157. Re-scan your original afterwards.

2. If the streaks remain, recalibrate the scanner as indicated in Calibrate the scanner on page 165. Make
sure you clean the maintenance sheet before calibrating the scanner, and check that the maintenance
sheet is not damaged (if so, call HP support and ask for a new maintenance sheet). Re-scan your
original after the calibration is completed.

3.  If the streaks still remain, check the scanner’s glass plate visually. If it is damaged (scratched or
broken), call HP support.

4. If the streaks remain, there may be dust particles inside the glass plate. Carefully take out the glass
plate and clean it as described in Replace the scanner’s glass plate on page 160.

@NOTE: The problem of vertical streaks cannot always be solved, due to the technological limitations of CIS
technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the streaks
remain after the corrective actions explained above, then no further action can be taken to improve the
image quality, except to buy a more expensive CCD scanner.

Wrinkles or folds

Scanners based on CIS technology have a high optical resolution within their focus plane, at the price of a
very limited depth of field. Hence, the images are sharp and detailed when the scanned original is perfectly
flat against the glass plate. However, whenever the original contains wrinkles or folds, these defects are
clearly visible in the scanned image (as shown in the following example).
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Actions

1. Re-scan the original, setting the content type to Image, and contrast and background cleaning to zero.

2. Ifthe problem persists, re-scan the original at a lower scanner resolution (Standard quality if scanning,
Fast or Normal if copying). It may also help to flatten the original manually as much as possible before
scanning it again.

E’%NOTE: The problem of wrinkles cannot always be solved, due to the technological limitations of CIS

technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the wrinkles
remain after the corrective actions explained above, then no further action can be taken to improve the
image quality, except to buy a more expensive CCD scanner.

Line discontinuities

Actions

ENWW

When scanning or copying large originals, you may sometimes find issues such as that shown in the following
image, where a straight line (it does not necessarily have to be horizontal) appears with discontinuities or
small steps. Please note the black arrow indicating the scanning direction in this example.

1. Repeat the scan, and this time make sure that the product is correctly positioned (it is flat on the floor
and it does not move), and that the printer is not printing while you scan. Turning the original 90 or 180
degrees and scanning it again may also solve the problem.

2. If the problem persists, check that the original to be scanned is not skewed, and that it does not become
skewed during the scan. If so, please refer to Incorrect paper advance, skew during scanning, or
horizontal wrinkles on page 214. You might also want to deactivate the automatic de-skew algorithm
as indicated in A copied or scanned image is very skewed on page 219.

3. Ifthereis no skew but the problem persists, clean and calibrate the scanner as indicated in Scanner
maintenance on page 156. Take care not to move the printer during the calibration (the printer should
not be printing during scanner calibration), and check that the maintenance sheet is correctly positioned
before starting the calibration. Also check that the maintenance sheet is not damaged before
calibrating the scanner (an old or damaged maintenance sheet may cause this problem); if it is
damaged, call HP support and ask for a new maintenance sheet.

4. If the problem persists, proceed to analyze the following areas of the diagnostic plot:
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a. 4 (from module A to E).
b. 10, at the intersection between modules.
¢. 13 inmodules AandE, and 14 in modules B, C, and D.

If you see any of these defects in the studied areas, call HP support and report a “line discontinuities”
error after calibration.

The four vertical thin black lines at the beginning and the end of the diagnostic plot show, approximately, the
position of the intersection between CIS modules, where this kind of error usually appears. If the error
appears outside these areas, call HP support and report “line discontinuities within a CIS module”.

Grain in area fills when scanning plain paper

When making copies of an original containing area fills, if the paper used in the printer is plain paper (for
instance, HP Universal Bond or HP Bright White Inkjet Bond), some grain may appear in the image. This error
may also appear in scanned files of originals that were printed on textured paper. The example below shows
the original image on the left and the scanned, grainy image on the right.

Actions

1. Please look at the original and check if it is dirty, has fingerprints on it or if the grain is already present
in the print. If not, then proceed to step 2.

2. Repeat the scan/copy, setting the content type to Image.
3. If the problem persists:

e If the problem appears when copying, use Best quality. We also recommend using coated or glossy
paper in order to avoid grain in copies.

e If the problem appears in a scanned file, scan at a lower resolution (Standard quality).
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4. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance
on page 156. Check that the maintenance sheet is also clean, and that it is not damaged before
calibrating the scanner (an old or damaged maintenance sheet may cause this problem); if it is
damaged, call HP support and ask for a new maintenance sheet.

5. If the problem persists, proceed to analyze areas 11 and 12 of the diagnostic plot across modules A to
E. In the three examples below, the top example is ideal, the middle example can be regarded as
acceptable; but, if you see something similar to the bottom example (or worse), call HP support and
report “grain in area fills”.

Small color differences between adjacent CIS modules

When scanning wide plots, sometimes slightly different colors can be seen at both sides of the junction
between two CIS modules. This issue, if present, can be easily seen by analyzing patterns 9 of the diagnostic
plot at the intersection between CIS modules. Here are some examples. Please note the black arrow
indicating the scanning direction in these examples.

Sometimes the color mismatch between adjacent modules can be enormous, showing a serious scanner
malfunction, as in the following example. If this occurs, see Completely wrong colors on page 216.
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Actions

1.

Repeat the scan or copy, setting the content type to Image, reducing the background cleaning to 0 or
turning the original 90 degrees before scanning it again.

N

If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance
on page 156. If calibration ended without errors, proceed to analyze again pattern number 9 and
modules A through E of the diagnostic plot.

3.  After analyzing pattern 9, if you see some color differences between left and right sides of the bars for
neutral and vivid colors, call HP support and report “small color differences between adjacent CIS
modules”. Otherwise, if you see color differences for vivid colors but not for neutral colors, see Clipping
in dark or light areas on page 208. If necessary, see also Grain in area fills when scanning plain paper

on page 204.

Vertical light lines at the intersection between CIS modules

This problem can be found when scanning large uniform area fills which are made of some light color. You
sometimes find light vertical bands (around 0.5 cm wide) at the intersection between two CIS modules, as in
this example. Please note the black arrow indicating the scanning direction in this example.

—

Actions

1. Repeat the scan or copy, setting the content type to Image, reducing the background cleaning to 0 or
turning the original 90 degrees before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance
on page 156. Then proceed to analyze pattern number 2 of the diagnostic plot at the intersections
between CIS modules. The example below shows a good result on the left and a bad result on the right:
the latter has light vertical banding 0.5 cm wide at the intersection between two CIS modules.

If you see the kind of result shown on the right, call HP support and report “vertical light bands in area
fills at the intersection between CIS modules, after calibrating the scanner”.
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Variable line thickness or missing lines

When scanning some CAD plots at Standard resolution, mostly when working with grayscale or black-and-
white prints that contain very thin lines, you may see a variation in line thickness, or even some missing lines,
in some places:

e e e A ——— —-
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Actions

1. Repeat the scan or copy using a higher resolution (High or Max if scanning, Normal or Best if copying).
You should also set background cleaning to 0, or set the content type to Mixed. You might also
deactivate the automatic de-skew as explained in A copied or scanned image is very skewed
on page 219. In case you were working in black-and-white mode, we recommend using grayscale
instead.

2. If the problem persists, turn the original plot 90 degrees before scanning it again.

3. Ifthe problem persists, clean and calibrate the scanner as indicated in Scanner maintenance
on page 156.

4. If the problem persists, see Defocus, blurring and fading colors on page 212.

Inaccurately reproduced colors

You have to deal with several variables if you want perfect color matching between the original you are
scanning and the copy or scanned file you obtain as a result. If you find undesired colors in cases like the
example shown below (original on the left, scanned image on the right), you can follow these guidelines.

Actions

1.  Make sure that you choose the correct paper type in the scan settings before scanning.

2. When dealing with copies, you must take into account that good color matching between a given
original and its copy can be achieved only if both are printed on the same type of paper. In the case of
scanned files, good color matching can be achieved only if your monitor is color-calibrated or compliant
with SRGB or AdobeRGB standards.

3. Ifthe above conditions are met, you should also take into account that various scanner settings can
affect the final color result, such as contrast, background cleaning, content type and paper type. To
obtain the best possible colors, set contrast and background cleaning to 0, set the content type to
Image, and select the most appropriate type of paper according to the original you are scanning (if in
doubt, use photo paper).
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4. Note that the image enhancement settings are automatically reset to default values after a certain
time, so you may get a different result from copying the same original if you have not checked the
settings before starting the job.

5. If youscanned to a PDF file, try opening the PDF file in Adobe Acrobat and saving it as a PDF/A file. For
more information, see http://www.adobe.com/products/acrobat/standards.html (English only).

6. For optimum color results, clean and calibrate the scanner as indicated in Scanner maintenance
on page 156.

7. Avoid placing the scanner in direct sunlight or near sources of heat or cold.

Color fringing

The problem called “color fringing” occurs when the scanner is affected by incorrect paper advance and/or
miscalibration. Nevertheless, some amount of color fringing is unavoidable, especially at high scanning
speeds. It can be seen at the borders of sharp black text over a white background, as in the example below
(original on the left, scanned image on the right). Please note the black arrow indicating the scanning
direction.

e ry

1. Repeat the scan after increasing the scanner’s resolution (choose Max quality if scanning, Best if
copying). Turn your original 90 degrees, if possible, before scanning it again.

Actions

2. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance
on page 156. Repeat the scan at a high resolution (Max if scanning, Best if copying) and check whether
the problem disappears.

3. If the problem still persists, you can diagnose this issue by analyzing the patterns 6 and 8 (A to E) of the
diagnostic plot. The black horizontal lines appear slightly colored at the top and bottom of each end (in
the example on the right, below). Normally, they look red at the top and blue or green at the bottom,
but it could be the other way around.

If you see this effect, call HP support and report “color fringing problem after calibration”.

Clipping in dark or light areas

Sometimes you may see that the scanned file or copy of one of your plots has lost detail in light or dark areas
(or both), as in the example below: original on the left, scanned image on the right.
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Image © www.convincingblack.com, reproduced with permission.

Actions

1. If you are making copies, and the original is printed on photographic paper, while you are copying it
onto matte paper, this problem is to be expected. However, you can try to improve the result by running
a color calibration of the printer (see Using your printer), and by reducing contrast and background
cleaning; this also applies if you see this problem in scanned files.

2. Ifthe problem persists, repeat the scan or copy using a higher resolution (High or Max if scanning,
Normal or Best if copying). Set the content type to Image, and make sure that the type of original
selected in the front panel really corresponds to the paper type of your original (white, photo, recycled
or translucent). If you are not sure, select photo.

3. Ifthe problem persists, recalibrate the scanner as indicated in Scanner maintenance on page 156. Make
sure you clean the maintenance sheet before calibrating the scanner, and check that the maintenance
sheet is not damaged (if so, call HP support and ask for a new maintenance sheet). Re-scan your
original after the calibration is completed.

4. If the problem persists, analyze patterns 16 (A to E) of the diagnostic plot. If you can distinguish
lightness steps beyond the upper and lower specified thresholds, then the scanner is fine. Here you can
see some examples of correct and incorrect functioning.

If your scanned pattern looks like the incorrect one on the right, whether the clipping is in dark and/or
light areas, call HP support and report “Clipping in dark/light areas”.
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Flare in the image when scanning glossy originals

If the scanner is miscalibrated, or if the original plot you are trying to scan is very glossy or reflective, you can
sometimes find flare in the scanned image, as in the following example: original on the left, scanned image
on theright.

Image © www.convincingblack.com, reproduced with permission.

Actions
1. Clean the original and the scanner’s glass plate, then scan again.

2. If the problem persists, recalibrate the scanner as indicated in Scanner maintenance on page 156. Make
sure you clean the maintenance sheet before calibrating the scanner, and check that the maintenance
sheet is not damaged (if so, call HP support and ask for a new maintenance sheet). Re-scan your
original after the calibration is completed.

3. Ifthe problem persists, see Clipping in dark or light areas on page 208.

Vertical red and green bands over white or black background

If the scanner has not been calibrated for a long period of time, or if the last calibration failed, you can
sometimes see defects like the following. Please note the black arrow indicating the scanning direction in this
example: original on the left, scanned image on the right.

‘__

1. Clean and calibrate the scanner as indicated in Scanner maintenance on page 156. If the calibration
failed, proceed as stated in Calibrate the scanner on page 165. However, if the calibration ended
correctly, scan your original again and check that the colored vertical bands have disappeared.

Actions

2. If the problem persists, call HP support and report “vertical red/green bands after calibration”.

The stop-start effect

Your printer is a complex machine, which may be working on several tasks at the same time. If you are trying
to scan while printing or processing a job in the printer queue, you may find that the scanner stops for a while
and then restarts. Although this is normal behavior, in some cases the scanned image may have defects as a
result of this stop-start operation.

To illustrate this effect, here is an example of an original image.
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The two images below are examples of the stop-start effect when the above image is scanned. Please note
the black arrow indicating the scanning direction in these examples.

Actions

1. Clean and calibrate your scanner as indicated in Scanner maintenance on page 156. Scan your original
again and make sure that the printer is not working while you are scanning. Reduce scanning resolution
(choose Standard if scanning, Fast if copying) if necessary.

2. If the problem persists, proceed to analyze patterns 4, 13, and 14 of the diagnostic plot. If you find a
problem similar to that shown below, call HP support and report a “stop-start effect” error.

Vibration

If your printer is not properly placed on a flat surface, or if the scanner lid does not close correctly, you may
sometimes find that the scanned image suffers from vibration, as in the following example: original on the
left, scanned image on the right.

v
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1.  Make sure that the scanner is placed on a flat surface, the scanner lid is correctly closed, and the printer
is not working while you are scanning. Scan your original again.

2. If the problem persists, change (increase or decrease) the scanning resolution and re-scan your original.
We also recommend turning the original 90 degrees before scanning it again.
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3. Ifthe problem persists, analyze pattern 4 of the diagnostic plot. If you see the problem shown on the
right, call HP support and report a “vibration problem”.

Horizontal periodical banding

This problem can be found in scanners with a defective pressure roll in some CIS modules. In this case, you
may sometimes find horizontal periodical bands in your scanned images, separated by around 5 cm (2 in), in
the area covered by one CIS module, as in this example: original on the left, scanned image on the right.
Please note the black arrow indicating the scanning direction in this example.

L L

1. Open the scanner lid. Clean the motor wheels (small black rubber) and the pressure rolls (wide white
plastic). Check that all the pressure rolls can move freely. If you find dust particles or objects that
obstruct the movement of the rollers, try to remove them, then close the scanner lid and repeat your
scan.

Actions

2. Ifthe problem persists, clean and calibrate the scanner as indicated in Scanner maintenance
on page 156, and analyze pattern 1 of the diagnostic plot. If you can find horizontal periodical banding
inside this pattern, as shown on the right below, call HP support and report “horizontal periodical
banding”. Please note the black arrow indicating the scanning direction in this example.

H E

Original Pattern 1 affected by horizontal periodical banding

Defocus, blurring and fading colors

CIS technology scanners are tuned to work at a fixed focal distance, and they are very sensitive to small
variations in the position of the original with respect to the scanner glass plate. If the scanner lid is not
properly closed, or if the original has deep wrinkles or texture, you may sometimes find problems as in the
following example (on the right), where the scanned image is blurred and colors are faded.
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Actions

1.  Check the scanner lid sensor by opening the scanner lid and checking that the five CIS modules show
blinking red, green and blue lights alternately. If not, reboot the machine and call HP support reporting
the error appearing at the front panel. If no error is given in the front panel then report “scanner lid
sensor failure”.

2. If all the modules lit up correctly in the previous step, close the scanner lid by pushing it down until you
hear a click. Then calibrate the scanner as indicated in Scanner maintenance on page 156 and repeat
your scan.

3. Ifthe problem persists, repeat the scan or copy using a higher resolution (High or Max if scanning,
Normal or Best if copying). You should also set background cleaning to 0, or set the content type to
Mixed.
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4. If the problem persists, analyze pattern number 7 in modules A through E of the diagnostic plot. A
correct example is given below, followed by two incorrect examples. Note that there is a black ring near
the center of pattern 7. In this step, you must look at the region near the black ring. If you can see
discontinuities in the black and white lines, call HP support and report a “defocus or blurring” error.

Incorrect paper advance, skew during scanning, or horizontal
wrinkles

You may encounter problems with some thick glossy originals being moved through the scanner’s paper
path. In some cases, the original may become skewed during the scanning process.

If some of the paper rollers are not working correctly, you may find small horizontal wrinkles in the scanned
image, due to the paper being stuck in some regions while not in others.

214 Chapter 23 Troubleshooting scan-quality issues ENWW



Actions

1.  Turnyour original 90 degrees and repeat your scan.

2. If the problem persists, open the scanner lid. Clean the motor wheels (small black rubber) and the
pressure rolls (wide white plastic). Check that all the pressure rolls can move freely. If you find dust
particles or objects that obstruct the movement of the rollers, try to remove them, then close the
scanner lid and repeat your scan.

3. Ifthe problem persists, restart the scanner by turning it off and on again. If you find an error message
on the front panel during this operation, call HP support and report the error message. If no error
message appears, try repeating your scan.

4. If the problem persists, analyze patterns 4, 13 and 14 of the diagnostic plot. The plot should look like
this:

If you see an image resembling the incorrect examples below, call HP support and report an “incorrect
paper advance” problem.
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Vertical black band 20 cm wide

Actions
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Your scanner contains various different CIS modules, each of which covers an area 20 cm (7.9 in) wide. If one
of the modules fails, and the scanner hardware check does not detect the failure, you may see a black
vertical band, corresponding to the area covered by a single CIS module, in your scanned image or copy. Here
is an example (on the right). Please note the black arrow indicating the scanning direction in this example.

1. Open the lid of the scanner and check that the five CIS modules show blinking red, green and blue lights
alternately. If a module is failing, call HP support and report a “CIS module illumination” error.

2. If all the modules lit up correctly in the previous step, restart the scanner by turning it off and on again.
If you find an error message on the front panel during this operation, call HP support and report the
error message. If no error message appears, try repeating your scan.
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3. If the problem persists, try to calibrate the scanner as indicated in Scanner maintenance on page 156. If
this operation fails, call HP support with the error code given on the front panel. If no error code
appears, try to repeat your scan.

4. If the problem persists, call HP support and report a “vertical black band 20 cm wide”.

The scanner damages some originals

HP is aware that this scanner may cause vertical scratches on inkjet originals on thick glossy paper. Very thin
tracing paper or old originals may also be damaged. This is because CIS technology requires the original to be
held down with high pressure to obtain accurate results and avoid blurring and defocus problems.

If the original you intend to scan is valuable, and if it belongs to one of the types described above (inkjet-
printed, thick, glossy original or old/thin/tracing paper original), HP recommends using a CCD scanner such as
the HP Designjet T1200 HD MFP.

Completely wrong colors

If some of the LEDs used for illumination in the CIS modules are failing, or the last calibration did not work
correctly, although no error message was given on the front panel, you may experience some completely

wrong colors in your scanned images, as in the example below: original on the left, scanned image on the

right.

1.  Open the lid of the scanner and check that the five CIS modules show blinking red, green and blue lights
alternately. If some module is failing, call HP support and report a “CIS module illumination” error.

2. If all the modules lit up correctly in the previous step, restart the scanner by turning it off and on again.
If you find an error message on the front panel during this operation, call HP support and report the
error message.

3. If noerror message appears on the front panel during the restart process, try to calibrate your scanner,
as indicated in Scanner maintenance on page 156, once it is fully functional. If some error message
appears on the front panel, call HP support and report the error, adding that you found it after seeing
“completely wrong colors in the scanned image”.

4. If calibration succeeded, repeat your scan and check the colors.

5. If the colors are still wrong, analyze the whole diagnostic sheet. Check that you find completely wrong
colors in the area corresponding to just one of the CIS modules, as in the following figure. If so, call HP
support and report “completely wrong colors after calibration”, and report the letter of the CIS module
that is failing (module A at the example).

If all the modules are failing, call HP support and report that.
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Vertical distortion

If the lid sensor of the scanner fails, the scanner cannot detect when the lid is open. Hence, you can start a
scan, and at some point find that the pressure rolls do not move the original through the scanner paper path.
You may see images like the following when this happens (original on the left, scanned image on the right).
Please note the black arrow indicating the scanning direction in these examples.

tion (o1

Actions

1.  Check that the scanner lid sensor is working by opening the scanner lid and checking that the five CIS
modules show blinking red, green and blue lights alternately. If not, call HP support and report “scanner
lid sensor failure”.

2. If all the modules lit up correctly in the previous step, close the scanner lid by pushing it down until you
hear a click. Then repeat your scan and visually check that the original advances correctly through the
scanner path. If not, call HP support and report an “incorrect paper advance” error. Remember that your
scanner is not intended to work with originals thicker than 0.75 mm (29 mil).

Object replication (ghosting)

This error very rarely appears in CIS scanners. However, you can occasionally find image defects like the
following: original on the left, scanned image on the right.

Image © www.convincingblack.com, reproduced with permission.
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Actions

1.  Restart your printer. Then calibrate the scanner, as indicated in Scanner maintenance on page 156, and
repeat your scan. Turn the original 90 degrees if possible before rescanning.

2. If the problem persists, analyze pattern 3, modules A through E, of the diagnostic plot. Call HP support
and report an “object replication” issue if you see the kind of error shown on the right.

Clipping or incorrect scale factor when down-scaling in copies
and prints

When doing copies or prints (from USB, Embedded Web Server, or printer driver), the scaling setting is
available with various possible options. If you are experiencing problems related to border clipping, or it
seems that your print has lost the scale-factor adjustment, please read this section carefully in order to
select the best value for the scaling setting in future jobs.

e  Precisescaling: In this case, the content of the original image is scaled by the percentage factor that
you have selected. For example, in an original CAD image with a 1:100 scale, if user selects scale to
50%, the printed plot will have an accurate scale of 1:200. Nevertheless, in the case of down-scalings
when selecting a fixed percentage, some clipping of the marginal content of the plot may occur, asitis
impossible for the printer to print up to the borders of the paper.

e Scale to fit into page size: In this case, the content of the original image is scaled by the percentage
necessary to make sure that all the content is correctly printed and no clipping occurs. Nevertheless, in
the case of down-scalings when selecting fit to page, the scale-factor adjustment may not be an integer
divisor of the original. For example, in an original CAD plot with a 1:100 scale on A2 paper size, if user
selects scale to fit on A3 paper size, the scaling factor will not be exactly 50% and the scale of the
printed plot will not be 1:200 exactly. However, the plot will be printed completely without clipping any
content.

Incorrect edge detection, mostly when scanning tracing paper

Tracing or translucent papers can be scanned with good results, although totally transparent papers are not
supported. Nevertheless, the resulting image may have extra margins or some clipping of the content in
some situations when detection of the edge of the paper is not accurate, which may also happen when
scanning plain paper if the glass plate is dirty. In order to avoid these undesired effects, please follow these
recommendations.

Actions

1. Carefully clean the scanner’s glass plate and the original to be scanned with a cloth. Turn the original 90
degrees if possible and re-scan it afterwards. Remember to select Translucent as the paper type at the
scanner if your original is translucent.

2. If the problem persists, please calibrate your scanner, and re-scan your original again afterwards.

3. Ifthe problem persists in the case of translucent paper, attach a sheet of white paper to the back of the
original to be scanned. Remember to select White paper as the paper type for the scanner in this case.
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A copied or scanned image is very skewed

Originals are often loaded into the scanner with some degree of skew. In order to correct for this unavoidable
problem, the scanner has a built-in automatic de-skew algorithm, which measures the skew in the original
and rotates the scanned image so that the result is perfectly straight. However, in some cases the de-skew
algorithm may increase the skew rather than correcting it. In other cases, the skew is so bad that it cannot be
automatically corrected.

To load the original with minimum skew, grasp the original with the image facing up and your hands at left
and right edges. You are recommended to avoid resting your hands or the original on the scanner's input tray.
Push the original into the scanner insertion slot until you feel the whole top border of the original pressing
against the scanner rubber rolls, which will load the original after a delay of 0.5 seconds. Now you can take
your hands off the original. If you are not happy with the way the scanner has grabbed your original, you can

press E and try again.

The action of the automatic de-skew algorithm can be deactivated by pressing [f&¥g¥, then n then Scan

preferences or Copy preferences (you might want to deactivate it in one case but not in the other). You can
also deactivate the automatic de-skew from the Settings button at every new scanner job.

ENWW A copied or scanned image is very skewed 219



24 The scanner diagnostic plot

° Prepare the printer and the paper to print the diagnostic sheet

e \Visual check for errors while printing the diagnostic sheet

° Scan or copy the diagnostic plot

e  Monitor calibration

e  Save the diagnostic plot for future use
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Prepare the printer and the paper to print the diagnostic sheet

Turn on your printer and wait until it is functioning. Then select the paper on which the diagnostic plot is
going to be printed (you can reuse the diagnostic plot any time in the future, if it is saved carefully). Ideally,
the diagnostic plot should be printed on glossy paper, and you are highly recommended to do that if you use
your printer mostly for scanning or copying photo originals (posters, pictures printed on glossy paper, etc). If
you use your printer mostly to scan or copy matte originals, then you can use any matte white paper to print
the diagnostic plot. Please do not use recycled or tracing paper to print this plot. The size of the diagnostic
plotis 610 x 914 mm (24 x 36 in). It can be printed on any 914 mm (36 in) landscape or 610 mm (24 in)
portrait paper roll. You can also use a single sheet that is at least 610 x 914 mm (24 x 36 in).

Once the correct paper is loaded, if this paper permits color calibration then we recommend color-calibrating
the printer (see Using your printer).

You can print the diagnostic plot from the front panel: press . then - then Internal prints >
Scanner 1Q plot or Image Quality Maintenance > Scanner 1Q plot.

Visual check for errors while printing the diagnostic sheet

Once the diagnostic plot is printed, the first step is to check that all the patterns included in it are correctly
printed. The diagnostic plot, if printed correctly, should look like this:

r + + t t
. ®

Some of the most common defects that may appear in a printed diagnostic plot are described below. If you
find any of these problems, you should follow the recommended recovery procedure, all of which are
available by pressing . then - then Image Quality Maintenance at the front panel. Once the

printer has been diagnosed and it is working correctly, you can reprint the diagnostic sheet as described in
Prepare the printer and the paper to print the diagnostic sheet on page 221.

Resolution

By looking at pattern 7 you may find problems with the printer’s resolution for the loaded paper. Usually, this
test does not reveal a printer problem, but a defect in the paper, which may not be suitable for printing the
diagnostic sheet with the required quality.

Here is what you should see if all is well, followed by two defective examples.
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Alignment

Looking at patterns 4, 13, and 14, you may find problems with the printer’s printhead alignment, which can
cause defects such as the following.

-
I
-
_ -
-

Additionally, misalignment problems can be seen in patterns 4 and 9 in the form of color fringing (which is
exaggerated below, on the right). That is, the limits between two strong colors are not well defined or a third
color appears between them.

Finally, a special pattern for checking the printer’s printhead alignment can be found at the top left of the
diagnostic sheet. This pattern has no number as it is not used for scanner checking. It is made of three
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colored crosses that may be used to identify the problem in question. The correct pattern is shown on the
left, an example of misalignment on the right.

Loss of shadow or highlight details

Looking at pattern 16, you may find a problem with the color calibration of the printer (CLC process). If you
can distinguish lightness steps beyond the upper and lower specified thresholds, then the printer is fine. Here
you can see examples of correct functioning on the left, incorrect on the right.

If the printer does not pass this test, you should run a color calibration if the paper loaded in the printer can
be calibrated (coated or glossy paper, for instance). The color calibration can be launched from the front

panel by pressing . then - then Image Quality Maintenance > Color calibration.

Printer banding

Looking at patterns 1, 2, and 3, you can see vertical banding problems due to a miscalibrated paper advance
in the printer.

You can also see some banding in patterns 4, 9, 10, and 11, indicating that the printheads need to be cleaned.
You can launch printhead cleaning from the front panel by pressing . then - then Image Quality
Maintenance > Clean printheads.

ENWwW Visual check for errors while printing the diagnostic sheet 223



Streaks

Looking at patterns 1, 2, 3, 9 and 16, you may find vertical streaks as in the examples shown below, if the
printer’s printheads are not working correctly. Replacing the printhead for the color showing the streaks may
solve the problem.

Grain

Looking at patterns 1, 2, and 3, you may find problems in the printer’s paper advance or the printheads that
cause visible grain in area fills. The following examples show this defect: original on the left, printed image
on theright.

Scan or copy the diagnostic plot

There are two options for evaluating the diagnostic plot: scanning into a JPEG file, or copying onto paper. We
recommend using the scan option, so that the generated file can be analyzed more easily by a remote
support engineer if necessary. If you decide to scan the plot, first adjust your computer’s monitor as
described in Monitor calibration on page 225. Once you have scanned the diagnostic plot, please remember
to open the scanned file in any image viewer software and select a zoom of 100% for correct visual
evaluation of patterns.

If you decide to copy, make sure that a paper roll at least 36 in (914 mm) wide is loaded in the printer. Ideally,
the same type of paper used to print the diagnostic plot should be used for copying it.

These are the settings that you should select:

Scan
e  Quality: Max

e  Filetype: JPG
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Copy

e  (ontent type: Image
e  Compression: medium

e  Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photo if in
doubt.

e  Quality: Best
e  (ontent type: Image

e  Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photoif in
doubt.

Load the diagnostic plot into the scanner input tray, making sure that the printed side of the plot is facing up.
The black arrows on the diagnostic plot indicate the direction of loading. Make sure that the diagnostic plot is
loaded without skew, and it is centered (that is, it covers the whole scanner area).

Once you have scanned the diagnostic plot (in case you selected the scan option), please remember to open
the scanned file in any image viewer software and select a zoom of 100% for correct visual evaluation of
patterns.

Monitor calibration

The monitor on which the plot is going to be evaluated should ideally be calibrated. As this is not always
feasible, we propose here to follow an easy procedure for adjusting the brightness and contrast of the
monitor in order to see the patterns correctly.

Adjust the brightness and contrast of your monitor until you can see a difference in lightness between these
two squares:

Now you are ready to check each pattern individually.

Save the diagnostic plot for future use

ENWW

We recommend saving the diagnostic plot with the maintenance sheet, in the solid tube provided.
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25 Troubleshooting ink cartridge and
printhead issues

° Cannot insert anink cartridge

° Ink cartridge status messages

° Cannot insert the printhead

e The front-panel display recommends reseating or replacing the printhead

° Clean the printhead

e  Align the printhead

° Printhead status messages
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Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-
side up and readable.

A CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

e  OK: The cartridge is working normally, with no known problems.

e  Missing: Thereis no cartridge present, or it is not correctly connected to the printer.
e  Low: Theink levelis low.

e Verylow: Theink levelis very low.

e  Empty: The cartridge is empty.

e  Reseat: You are recommended to remove the cartridge and then reinsert it.

e Replace: You are recommended to replace the cartridge with a new cartridge.

e  Expired: Itis past the cartridge's expiration date.

e Incorrect: The cartridge is not compatible with this printer. The message includes a list of compatible
cartridges.

e  Non-HP: The cartridge is used, refilled, or counterfeit.

Cannot insert the printhead

1.  Check that you have the correct type of printhead (model number).
2. Check that the printhead is correctly oriented.

3. Check that you have correctly closed and latched the printhead cover, see Insert the printhead
on page 148.

The front-panel display recommends reseating or replacing the
printhead

1. Remove the printhead, see Remove the printhead on page 145.
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2. Cleanthe electrical connections on the backside of the printhead with a lint-free cloth. You can carefully
use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

A CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles on the
bottom side of the printhead, especially not with any alcohol.

3. Reinsert the printhead, see Insert the printhead on page 148.

4. Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printhead

As long as the printer is kept turned on, automatic cleaning is performed periodically. This ensures there is
fresh ink in the nozzles and prevents nozzle clogs, thus preserving print quality. If you have print quality
problems, please see The Image Diagnostics Print on page 196 before proceeding.

To clean the printhead, go to the front panel and press . then - then Image Quality Maintenance

> Clean printhead, and select the color group including the color that needs cleaning (Clean all, Clean MK-Y,
Clean C-M-PK-G).

Align the printhead

Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges in
graphical elements. Your printer has an automatic printhead alignment process which runs whenever the
printhead has been accessed or replaced.

You may need to align the printhead after a paper jam or if you are experiencing print-quality problems.

1. Load the paper you wish to use, see Paper handling on page 50. You can use a roll or a cut sheet; plain
white paper is recommended.

A CAUTION: Do not use transparent or semi-transparent paper to align the printhead.

2. Ensure that the scanner is lowered, as a strong light source near the printer during printhead
realignment can affect alignment.

3. From the front panel, press - then Image Quality Maintenance > Align printhead.

E’%NOTE: Printhead alignment can also be started from the Embedded Web Server (Support > Print
Quality Troubleshooting), or from the HP Utility (Windows: Support > Print Quality Troubleshooting;
Mac 0S X: Information and Print Quality > Align).

4. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.

5. The process takes about five minutes. Wait until the front-panel display shows the process complete
before using the printer.
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If the printer cannot complete the printhead alignment successfully, you may be asked to clean the printhead
and try again.

Printhead status messages

These are the possible printhead status messages:
e  OK: The printhead is working normally, with no known problems
e  Missing: Thereis no printhead present, or it is not correctly installed in the printer.

e Reseat: You are recommended to remove the printhead and then reinsert it. If that fails, clean the
electrical connections, see The front-panel display recommends reseating or replacing the printhead
on page 227. If that fails, replace the printhead with a new printhead, see Remove the printhead
on page 145 and Insert the printhead on page 148.

e  Replace: The printhead is failing. Replace the printhead with a working printhead, see Remove the
printhead on page 145 and Insert the printhead on page 148.

e Replacement incomplete: The printhead replacement process has not completed successfully; re-
launch the replacement process and let it finish completely.

e  Remove: The printhead is not a suitable type for use in printing.

e Non-HPink: Ink from a used, refilled, or counterfeit ink cartridge has passed through the printhead. See
the limited warranty document provided with your printer for details of the warranty implications.
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26 Troubleshooting general printer issues

° The printer will not start

e  The printer does not print

° The printer seems slow

e  The printer behaves strangely

° Communication failures between computer and printer

e  (Cannot access the HP Utility

° Cannot access the Embedded Web Server

e  (Cannot connect to the Internet

° Web Services issues

e  Automatic file system check

° Alerts
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The printer will not start

If the printer will not start, you are recommended to replace the firmware, in the following way.

1.  Go to the HP Support Center (see HP Support Center on page 240) and download the firmware.

2. Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with
the FAT filesystem.

3. Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port in the
front panel, then turn the printer on.

/

4. The printer takes about a minute to read the firmware file, then asks you to remove the USB flash drive.

5. The printer automatically installs the new firmware and restarts.

The printer does not print

If allis in order (paper loaded, all ink components installed and no file errors), there are still reasons why a
file you have sent from your computer may not start printing when expected:

e  You may have an electrical power problem. If there is no activity at all from the printer, and the front
panel does not respond, check that the power cable is connected correctly and that there is power
available at the socket.

e Nesting may be on and the printer is waiting for the specified nest wait time before calculating the
appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

e  You may have the wrong graphic language setting, see Change the graphic language setting on page 48.

e  You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

e Ifyouare printing on a sheet, you must specify Manual Feed as the paper source in your printer driver.

e  The printer may be holding the job for paper or accounting information, see Job status messages
on page 108.

e  You may have requested a print preview from your printer driver. This is a function you can use to check
that the image is the one you want. In this case, the preview is displayed on your screen, and you must
click the Print button to start printing.

e  Make sure that you have closed the stacker, unless you are using manual mode.
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e If you selected manual mode for the job, you must open the job queue, select the job, and print it in
manual mode.

e  You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In
this case, turn off the printer using the Power key on the front panel and unplug the power cord, wait
until the electromagnetic environment has returned to normal, then turn it on again. If you still
experience problems, please contact your customer service representative.

The printer seems slow

Here are some possible explanations.
e  Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take longer.

e Didyou specify the correct paper type when loading the paper? Some paper types require more time for
printing. To find out the printer's current paper type setting, see View information about the paper

on page 62.

e  Check that all components used in your network (network interface cards, hubs, routers, switches,
cables) are capable of high-speed operation. Is there a lot of traffic from other devices on the network?

e Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

The printer behaves strangely

If you are experiencing unexpected behavior from your printer, you can restore most of your printer’s
settings to their factory default values from the front panel. Press . then - then Setup > Resets >
Restore factory settings.

This will not reset basic networking settings or network security settings.

®  Basic networking settings can be reset by pressing . then - then Connectivity > Network
connectivity > Advanced > Restore factory settings.

®  Network security settings can be reset by pressing . then - then Connectivity > Network
connectivity > Gigabit Ethernet > Modify configuration > Reset Security.

Communication failures between computer and printer

Some symptoms are:

e  The front-panel display does not show the Receiving message when you have sent an image to the
printer.

e  Your computer displays an error message when you are trying to print.

e  Your computer or printer hangs (stays idle), while communication is taking place.

e  Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)
To solve a communication problem:

e  Ensure that you have selected the correct printer in your application, see Printing on page 68.

e  Ensure that the printer works correctly when printing from other applications.

e  Remember that very large prints may take some time to receive, process and print.
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e If your printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to your
computer.

e  Tryanother interface cable.

e  Ensure that the graphic language setting is correct, see Change the graphic language setting
on page 48.

Cannot access the HP Utility

If you have not done so already, please read Access the HP Utility on page 45.

Make sure your printer driver is available and working correctly for the HP Designjet Utility in Windows.

From the front panel, press . then - then Connectivity > Network Connectivity > Advanced >

Web Services > Printer utility software, and make sure that it is enabled. If it is disabled, some parts of the
HP Utility may not work properly.

Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 45.

From the front panel, press . then - then Connectivity > Network connectivity > Advanced >
Embedded Web Server > Allow EWS > On.

If you are using a proxy server, try bypassing the server and accessing the Web server directly.

e InInternet Explorer for Windows, go to Tools > Internet Options > Connections > LAN Settings, and
check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click
the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy
server is not used.

e InSafari for Mac 0S X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings
button. Add the printer's IP address or its domain name to the list of exceptions, for which the proxy
server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Cannot connect to the Internet

ENWW

If your printer has difficulty in connecting to the Internet, it may start the Connectivity Wizard automatically.
You can also start the wizard manually at any time.

®  From the front panel: Press . then - then Connectivity > Connectivity wizard.

®  From the front panel: Press . then - then Internal prints > Service information prints >
Print connectivity config. In this case, the results are printed out.

=7 NOTE: The results printed out are from the last run of the Connectivity wizard, so you must already
have run the Connectivity wizard in order to get any results.

The Connectivity Wizard performs a series of tests automatically. You can also choose to perform individual
tests. From the front panel, press . then - then Connectivity > Diagnostics & troubleshooting.
The following options are available.
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e  Alltests

e  Network connectivity test: Check the printer's connection to the local area network.

e Internet connectivity test: Check the printer's connection to the Internet.

o  HP Designjet ePrint & Share test: Check the printer's connection to HP Designjet ePrint & Share.
e  HP ePrint Center connectivity test: Check the printer's connection to the HP ePrint Center.

e  Firmware update test: Check the printer's connection to HP's firmware update servers.

e  Email server test: Check the printer’s connection to the configured email server.

e  Customer Involvement Program test: Check the printer’s connection to the CIP.

Alternatively, these tests can be launched from the Embedded Web Server: select Support > Connectivity
troubleshooting.

If any test fails, the printer describes the problem and recommends how to solve it.

Web Services issues

For any issues with HP ePrint, please refer to the HP ePrint Center: http://www.hp.com/go/eprintcenter.

For any issues with HP Designjet ePrint & Share, please refer to the HP Designjet ePrint & Share website:
http://www.hp.com/go/eprintandshare.

Automatic file system check

When you turn on the printer, you will occasionally see a front panel display similar to the one shown below.

FSCK

17%

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

A CAUTION: If you turn the printer off before the file system check has finished, the file system could be
seriously damaged, making the printer's hard disk unusable. In any case, the file system check will restart
from the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk’s file system integrity.

;“—“‘ NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and
prepare the printhead. However, it can take up to 40 under some conditions, for example, when the printer
has not been used for a long period of time and requires more time to prepare the printhead.

Alerts

Your printer can communicate two types of alerts:
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e  Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the
printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if
the printer is able to print.

e  Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or
for a possible unprintable situation, such as a preventive maintenance or low ink.

There are various ways in which you can receive alerts.

e  Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a
warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink",
that reappear when the printer becomes idle and there is not another more severe alert.

_‘{}: TIP: From the front panel display you can configure paper mismatch alerts, see Paper suitability
° options on page 29.

e Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer
status. If there is an alert in the printer, the status shows the alert text.

e  HP Designjet Utility for Windows: Select Alert settings from the HP Designjet Utility taskbar icon to
control the kinds of alerts that will be displayed by default.

e  HP Printer Monitor for Mac 0S X: The HP Printer Monitor shows you alerts directly in the Dock if you
installed the HP Utility. If you have not done so already, please read Turn alerts on and off on page 31.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a problem that
prevents a job from completing, you see a pop-up window, which explains the reason for the problem. Follow
the instructions to achieve your required result.

E”%’NOTE: There are environments that do not support bidirectional communication. In those cases, alerts do
not reach the job owner.
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27 Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so, please

follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if
the recommended action does not seem to solve the problem, first try restarting the printer. If the problem
remains, contact HP Support; see Contact HP Support on page 242.

Table 27-1 Text messages

Recommendation

[Color] cartridge altered

Check the cartridge.

[Color] cartridge has expired

Replace the cartridge. See Handling ink cartridges and printhead
on page 140.

[Color] cartridge is low on ink

Ensure that you have a new cartridge of the same color ready.

[Color] cartridge is missing

Insert a cartridge of the correct color. See Handling ink cartridges
and printhead on page 140.

[Color] cartridge is non-HP ink

You are recommended to install an HP original ink system for
optimum system performance.

[Color] cartridge is out of ink

Replace the cartridge. See Handling ink cartridges and printhead
on page 140.

[Color] cartridge is very low on ink

Ensure that you have a new cartridge of the same color ready.

Printhead error: not present

Insert a printhead. See Handling ink cartridges and printhead
on page 140.

Printhead error: replace

Remove the non-functional printhead and insert a new printhead.
See Handling ink cartridges and printhead on page 140.

Printhead error: reseat

Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead. See
The front-panel display recommends reseating or replacing the
printhead on page 227.

Printhead out of warranty

The printhead's warranty has ended, because of the length of
time it has been in operation, because of the volume of ink used,
or because non-HP ink has been used in the system. See the
limited warranty document.

Printhead replacement incomplete. Restart it.

Restart the printhead replacement process.

Replace [color] cartridge

Replace the cartridge. See Handling ink cartridges and printhead
on page 140.

Replace incorrect [color] cartridge

Replace the cartridge. Check the supported ink cartridges and see
Handling ink cartridges and printhead on page 140.

Reseat [color] cartridge

Remove and reinsert the same cartridge. See Handling ink
cartridges and printhead on page 140.
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Table 27-2 Numerical error codes

Error code Recommendation

05.5:10 Update the printer's BIOS.

08:04 Restart the printer. If the problem persists, update the printer's firmware. See Update the firmware
on page 153.

08:08 Retry the operation that you were attempting. If it fails again, restart the printer. If the problem
persists, update the printer's firmware. See Update the firmware on page 153.

09:01 Paper jam in the scanner. Remove all paper from the scanner and try again.

09:02 Calibrate the scanner. See Calibrate the scanner on page 165.

09:04 Restart the printer. If the problem persists, update the printer's firmware. See Update the firmware
on page 153.

39.1:01 Roll 1 has been unexpectedly unloaded. Reload the roll.

39.2:01 Roll 2 has been unexpectedly unloaded. Reload the roll.

61:01 The file format is wrong and the printer cannot process the job.

e  Turn off the printer using the Power button at the front.
e  Turn off the power switch at the rear.

e  Disconnect the power cord.

e  Reconnect the power cord and turn on the printer.

° Send the same job to the printer again.

° Ensure that the printer’s firmware is up to date. See Update the firmware on page 153.

61:04.1,61:04.2

Update your printer's firmware. See Update the firmware on page 153.

61:08 Resend the job.
61:08.1 The job cannot be printed because it is password-protected.
61:08.2 The job cannot be printed because it contains errors. Resend the job from the Embedded Web
Server.
61:09 Resend the job.
63:10 e  Turn off the printer using the Power button at the front.
e  Turn off the power switch at the rear.
e  Disconnect the power cord.
e  Reconnect the power cord and turn on the printer.
° Check that the network cable is correctly connected.
° Ensure that the printer’s firmware is up to date. See Update the firmware on page 153.
63:20 A potential problem has been detected in the network interface.

e Turn off the printer using the Power button at the front.
e  Turn off the power switch at the rear.

e  Disconnect the power cord.

° Reconnect the power cord and turn on the printer.

° Send the same job to the printer again.

° Ensure that the printer’s firmware is up to date. See Update the firmware on page 153.
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Table 27-2 Numerical error codes (continued)

Error code Recommendation

71.03,71.08 Out of memory. To avoid this, in the HP-GL/2 driver select the Advanced tab and then Send jobas a
bitmap.

74.01 An error occurred when loading the firmware update file.

e Turn off the printer using the Power button at the front.
e  Turn off the power switch at the rear.

e  Disconnect the power cord.

e  Reconnect the power cord and turn on the printer.

e  Reload the firmware update file into the printer. See Update the firmware on page 153.

74.1:04 Try the firmware update again. Do not try to use your computer while the update is in progress.

74.8:04 The firmware update has failed. Your firmware file may be incorrect; try to download it again. See
Update the firmware on page 153.

75.11:10 Preventive maintenance 1 is recommended. See Contact HP Support on page 242.

75.21:10 Preventive maintenance 2 is recommended. See Contact HP Support on page 242.

76:03 The printer’s hard disk is full. You may want to use Disk Wipe to free some space; see Disk Wipe
on page 155.

78:08 Borderless printing not possible; setting ignored. Ensure that the loaded paper supports borderless
printing.

79:03, 79:04 Update the printer's firmware. See Update the firmware on page 153.

81:01 Open the scanner and make sure that there are no obstacles restricting the movement of the drive
roller. If the paper has jammed, clear the obstruction by following the instructions in the front
panel.

86:01 Open the scanner and make sure that there are no obstacles restricting the movement of the

printhead’s carriage. If the paper has jammed, clear the obstruction by following the instructions in
the front panel.

94,94.1 Restart color calibration. See Color calibration on page 111.

The system error log

The printer saves a log of system errors that you can access in the following ways.

Using a USB flash drive
1.  Create an empty file named pdipu_enable.log in a USB flash drive.

2. Insert the USB flash drive into the Hi-Speed USB host port in the front panel. The log will be
automatically copied into the drive.

Using the Embedded Web Server
1.  Inyour Web browser, go to http://printer IP address/hp/device/webAccess/log.html.
2. The Embedded Web Server will send you a file with the extension .trb containing the system error log.

Alternatively, select the Support tab, then Service Support > Download Diagnostic Package.
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° HP Professional Services
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Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet,
providing comprehensive, proven support expertise and new technologies to give you unique end-to-end
support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and
exchange services, phone and Web support, software updates, and self-maintenance services. To find out
more about HP Customer Care, please visit us at http://www.hp.com/go/graphic-arts or call us on the
telephone (see Contact HP Support on page 242).

:@'_ TIP: By taking just a few minutes to register, you can improve your experience with HP and enjoy more
"= efficient support. Click http://register.hp.com/ to start. Also click http://www.hp.com/go/alerts to get
connected with HP Designjet updates, including product fixes and enhancements.

HP Professional Services

HP Support Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your
HP Designjet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24x7 access to:
e  Multimedia tutorials

e  Step-by-step how-to guides

° Downloads: the latest printer firmware, drivers, software, paper presets, etc.

e  Technical support: online troubleshooting, customer care contacts and more

e  Workflows and detailed advice for completing various printing tasks from particular software
applications

e  Forums for direct contact with the experts, both HP and your colleagues
e  Warranty tracking online, for your peace of mind

e Latest product information: printers, supplies, accessories, software, etc.
e  Supplies Center for all you need to know about ink and paper

The HP Support Center can be found at http://www.hp.com/go/T2500/support.

By customizing your registration for the products you have purchased and your type of business, and by
setting your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and
documentation.

HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard
period.

They include remote support. On-site service is also provided if necessary, with two alternative response-
time options.
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e  Next business day
e  Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/printservices.

HP Installation
The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
printservices.

HP Proactive Support

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and
resolving printer issues before they become problems for you. HP's Proactive Support tool is designed to
help businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of
your printing environment—with a clear focus on maximizing the value of your investment, increasing
printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before
they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and
firmware updates.

You can enable Proactive Support in the HP Designjet Utility for Windows or the HP Printer Monitor for Mac 0S
X, where you can specify the frequency of connections between your computer and HP's Web server, and the
frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change
these settings:

e Inthe HP Designjet Utility for Windows, select the Tools menu, then HP Proactive Support (not
available in HP Designjet Utility 1.0).

e  Inthe HP Printer Monitor for Mac OS X, select Preferences > Monitoring > Enable HP Proactive
Support.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem
and recommend a solution. In some cases, the solution may be applied automatically; in other cases, you
may be asked to perform some procedure to solve the problem.

Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them.
Using this program, you can replace parts at your own convenience.

Convenient, easy to use

e  AnHP Support Specialist will diagnose and assess whether a replacement part is required to address a
defective hardware component.

e  Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact
HP.

e  Available for most HP products currently under warranty or contract.
e  Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.
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Contact HP Support

HP Support is available to you by telephone or instant messaging. What to do before you call:
e  Review the troubleshooting suggestions in this guide.

e  Review the relevant driver documentation.

e If you have installed third-party software drivers and RIPs, see their documentation.

e If you call one of the Hewlett-Packard offices, please have the following information available to help
us answer your questions more quickly:

° The product you are using (the product number and the serial number, found on the label at the
back of the product)

° If there is an error code on the front panel, note it down; see Front-panel error messages
on page 236

The product's Service ID: at the front panel, press ., then -, then .

° The computer you are using

° Any special equipment or software you are using (for example, spoolers, networks, switch-boxes,
modems or special software drivers)

° The cable you are using (by part number) and where you purchased it
° The software name and version you are currently using

° If possible, print out the following reports from the front panel; you may be asked to fax or email
them to the support center helping you: Configuration, Usage Report and “all pages above” from
Service Information (see The printer’s internal prints on page 13). Alternatively, in the Embedded
Web Server, go to Support > Service support > Printer information > All pages.

How to contact HP Support

You can review latest information related to your product and get chat assistance at http://www.hp.com/go/
getsupport.

You can also get chat assistance on your smartphone by using the HP Support Center Mobile App:
http://www8.hp.com/us/en/products/smart-phones-handhelds-calculators/mobile-apps/app_details.html?
app=tcm:245-1163163&platform=tcm:245-1163164.

Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/country/us/
en/wwcontact_us.html.
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Functional specifications

Table 29-1 HP 727 ink supplies

Printhead

One printhead, with doubled nozzles for matte black

Ink cartridges

Cartridges containing 40 ml of ink: gray, photo black, matte black, yellow, magenta, and

cyan

Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow, magenta,

and cyan
Table 29-2 Paper sizes
Minimum Maximum
Roll width 279 mm (11in) 914 mm (36 in)
Roll length 91 m (300 ft)

Roll diameter

140 mm (5.51in)

Roll weight 11.9kg (26.3 Ib)
Sheet width 210 mm (8.26in) 914 mm (36 in)
Sheet length 279 mm (11in) 1676 mm (66 in)

Sheet width (scanner)

914 mm (36 in)

Sheet length (scanner)

15 m (49.21 ft) at 200dpi, TIFF file format and

24 in width

Roll paper thickness

0.5 mm (19.7 mil)*

Sheet paper thickness

0.8 mm (19.7 mil)*

Paper weight

60 g/m2

328 g/m?

* up to 0.6 mm printed to the output stacking tray with manual mode

Table 29-3 Printing resolutions

Print quality Maximum detail Graphic language Rendering Printing resolution
resolution (ppi) (dpi)

Best (photo paper*) On HP-GL/2, HP 1200 x 1200 2400 x 1200
PCL3GUI
PostScript 600 x 600 2400 x 1200

Off any 600 x 600 1200 x 1200

Best (other papers) off any 600 x 600 1200 x 1200

Normal Off HP-GL/2 600 x 600 1200 x 1200
HP PCL3GUI, 300 x 300 1200 x 1200
PostScript

Fast (heavyweight coated, photo) off HP-GL/2 600 x 600 1200 x 1200
HP PCL3GUI, 300 x 300 1200 x 1200
PostScript

244 Chapter 29 Printer specifications ENWW



Table 29-3 Printing resolutions (continued)

Print quality Maximum detail Graphic language Rendering Printing resolution
resolution (ppi) (dpi)
Fast (plain, coated, natural tracing paper)  Off HP-GL/2 600 x 600 600 x 1200
HP PCL3GUI, 300 = 300 600 x 1200
PostScript
Economode Off any 300 x 300 600 x 1200

* For a list of supported papers, see Order paper on page 167.

Scanner resolutions: 200, 300, 600 ppi.

Table 29-4 Margins

Top, right and left margins 5mm (0.2 in)

Bottom margin (trailing edge) 5mm (0.2in) (roll)

22 mm (0.87 in) (sheet)

Table 29-5 Mechanical accuracy

+0.1% of the specified vector length or 0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AQ printing

material in Best or Normal mode with HP Matte Film roll feed.

Table 29-6 Graphic languages supported

HP Designjet Languages

T2500 HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, URF

T2500 PS HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, URF, Adobe PDF 1.7, Adobe PostScript 3
Scanner TIFF, JPEG, PDF

Physical specifications

Table 29-7 Printer physical specifications

Weight 109 kg (240 lb)
Width 1399 mm (55.08 in)
Depth 916 mm (36.1 in) (stacker and basket open)

693 mm (27.3 in) (stacker and basket closed)

Height 1110 mm (43.7 in) (stacker and front panel deployed)

950 mm (37.4 in) (stacker and front panel folded)

ENWw

Physical specifications 245



Memory specifications

Table 29-8 Memory specifications

HP Designjet Physical DRAM Virtual file-processing Hard disk
memory
T2500 series 1.5GB 128 GB 320GB

Power specifications

Table 29-9 Printer power specifications

Source 100-240V ac +10%, auto-ranging
Frequency 50-60 Hz

Current <4.2A

Consumption <330W

Environmental specifications

Table 29-10 Printer environmental specifications

Operating temperature

5 t0 40°C (41 to 104°F)

Recommended operating temperature

15 to 35°C (59 to 95°F), depending on paper type

Storage temperature

—-25t055°C(-13t0 131°F)

Recommended operating humidity

20 to 80% RH, depending on paper type

Storage humidity

0t095%RH

Acoustic specifications

Printer acoustic specifications (declared according to ISO 9296).

Table 29-11 Printer acoustic specifications

The printer is... Sound power level B(A) Sound pressure level dB(A)
Sleeping <1.9 16

Ready 5.8 39.2

Printing 6.5 46.9
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Glossary

AirPrint
A technology used by iPod, iPhone, iPad, and (optionally) Mac 0S X 10.7 onwards, which allows immediate printing to a
printer in the same network without the need for a printer-specific driver.

AppleTalk
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP
and Bonjour networking instead. HP Designjet printers no longer support AppleTalk.

Bonjour

Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network
technology used in Apple's Mac 0S X from version 10.2 onwards. It is used to discover services available on a local area
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a
limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space

A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the
same color model: for instance, monitors generally use the RGB color model, but they have different color spaces,
because a particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD

ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling
of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are
one of the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when
setting up the printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the
device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed
grounded part of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printhead or ink
cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted
area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low
humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Fast Ethernet
An Ethernet network capable of transferring data at up to 100,000,000 bits/second. Fast Ethernet interfaces are capable
of negotiating slower speeds when required for compatibility with older Ethernet devices.
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Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

Gigabit Ethernet
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are
capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible
with original USB. Most personal computers today use Hi-Speed USB.

HP RTL
Hewlett-Packard Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2
Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.

1/0
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec

A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between
nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually
unaware whether IPSec is being used or not.

IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers
separated by full stops. Most networks in the world use IPv4 addresses.

IPv6 address

A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in
the world use IPv6 addresses.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level
identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Network

A network is a set of connections that pass data between computers and devices. Every device is able to communicate
with every other device in the same network. This allows data to be moved between computers and devices, and allows
devices such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.
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Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped,
dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and
deposits it on the paper, through a cluster of nozzles.

Spindle
Arod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

usB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed
USB (sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to
your printer using a USB connection, the computer must be connected to the printer's USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.
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